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HIGHLIGHTS
Here are just some of the things you can do with the X701 mobile phone.

• Send colour pictures and video clips 
to friends and family via Multimedia 
messaging and email messaging.

• Send pictures, video, electronic 
business cards, and more using 
Bluetooth, Infrared, or USB 
connections to other phones or devices.

• Swap content between appropriate 
devices with the included miniSD Card 
and adapter.

• Surf the Internet using your wireless 
Internet browser.

• Add frames, text, and pop art to VGA 
size images.

• Capture video clips.

• Play 40-tone polyphonic ringtones.

• No more wired headset! Use a 
Bluetooth® wireless headset.

• Synchronise your Contacts and 
Calendar with your other networked 
devices.

• See who is calling with picture Caller 
Line ID on the X701 external display.

• Download games, pictures, themes, 
sounds, videos, and Java™ and 
Series 60 applications.

• View all your media files in one place, 
in My Items.

• Search for your files; including games, 
pictures, install packages, and video 
and sound clips.

• Receive, edit, and view Microsoft® 
Word, Excel, and PowerPoint® files. 
Beam documents to printers and 
projectors (with appropriate accessory).

• Speak a name or number to dial the 
number using Voice Commands.

• Say “open Messages” or “open 
Camera” and your phone will go directly 
to the menu using Voice Commands.
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IMPORTANT INFORMATION
Thank you for purchasing this Panasonic digital cellular phone. This phone is designed to operate on GSM networks – 
GSM900, GSM1800 and GSM1900. It also supports GPRS for packet data connections. Please ensure the battery is fully 
charged before use. 
We, Panasonic Mobile Communications Development of Europe Ltd., declare that the EB-X701 conforms with the essential 
and other relevant requirements of the directive 1999/5/EC. A declaration of conformity to this effect can be found at 
http://www.panasonicmobile.com
This Panasonic mobile phone is designed, manufactured and tested to ensure that it complies with the specifications 
covering RF exposure guidelines applicable at the time of manufacture, in accordance with EU, USA FCC and Australian 
ACA regulations. 
Please refer to our website for latest information/standards and compliance in your country/region of use http://
www.panasonicmobile.com.
The following information should be read and understood as it provides details which will enable you to operate your phone 
in a manner which is both safe to you and your environment, and conforms to legal requirements regarding the use of cellular 
phones.

This equipment should only be charged with approved charging equipment to ensure optimum performance 
and avoid damage to your phone. Other usage will invalidate any approval given to this apparatus and may 
be dangerous. Ensure the voltage rating of the Fast Travel Charger is compatible with the area of use when 
travelling abroad. A Fast Travel Charger (EB-CAX70xx*) is supplied with the Main Kit. (Note xx identifies the 
Charger region, e.g. CN, EU, UK.) Other recommended equipment for charging is the Car Charger (EB-
CDX70) 
Use of another battery pack than that recommended by the manufacturer may result in a safety hazard. If you 
use a feature which keeps the key backlight on continuously for a long time, such as a game or the browser, 
battery life will become extremely short. To maintain longer battery life, set the key backlight to off. Do not use 
this phone without the battery cover attached.

Switch off your cellular phone when in an aircraft. The use of cellular phones in an aircraft may be dangerous 
to the operation of the aircraft, disrupt the cellular network and may be illegal. Failure to observe this 
instruction may lead to the suspension or denial of cellular phone services to the offender, or legal action or 
both.

Do not incinerate or dispose of the battery as ordinary rubbish. The battery must be disposed of in 
accordance with local regulations and may be recycled.

It is advised not to use the equipment at a refuelling point. Users are reminded to observe restrictions on the 
use of radio equipment in fuel depots, chemical plants or where blasting operations are in progress. Never 
expose the battery to extreme temperatures (in excess of 60°C).

It is imperative that the driver exercises proper control of the vehicle at all times. Do not hold a phone while 
you are driving; find a safe place to stop first. Do not speak into a handsfree microphone if it will take your 
mind off the road. Always acquaint yourself thoroughly with restrictions concerning the use of cellular phones 
within the area where you are driving and observe them at all times.

Care must be taken when using the phone in close proximity to personal medical devices, such as 
pacemakers and hearing aids.

Remember to disable the alarm function when in an aircraft or a medical facility to prevent the phone 
automatically switching itself on.

For most efficient use hold the phone as you would any normal phone. To avoid deterioration of signal quality 
or antenna performance, do not touch or “cup” the antenna area while the phone is switched on.Do not leave 
the camera facing direct sunlight to avoid impairing camera performance. Unauthorised modifications or 
attachments may damage the phone and violate applicable regulations. The use of an unapproved 
modification or attachment may result in the invalidation of your guarantee – this does not affect your 
statutory rights.
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When your handset, the accompanying battery or charging accessories are wet, do not put those in any type 
of heating equipment, such as a microwave oven, a high pressure container, or a drier or similar. It may 
cause the battery, handset and/or charging equipment to leak, heat up, expand, explode and/or catch fire. 
Moreover, the product or accessories may emit smoke and their electrical circuits may become damaged and 
cause the products to malfunction. Panasonic is not responsible for any and all damages, whether direct or 
indirect, howsoever caused by any misuse.

It is recommended that you create a copy or backup, as appropriate, for any important information and data 
which you store in your phone’s memory. In order to avoid accidental loss of data, please follow all 
instructions relating to the care and maintenance of your phone and its battery. Panasonic accepts no liability 
for any and all losses howsoever arising from any loss of data, including but not limited to direct and indirect 
losses (to include, but not limited to consequential loss, anticipated savings, loss of revenue).

Your phone may have the capability of storing and communicating personal information. It is recommended 
that you take care to ensure that any personal or financial information is stored separately from your phone. 
You should use the security features, such as Phone Lock and/or Sim Lock, provided in the handset as a 
measure of protection for information held.   Panasonic accepts no liability for any and all losses howsoever 
arising from any loss of data including but not limited to direct and indirect losses (to include, but not limited to 
consequential loss, anticipated savings, loss of revenue).
Your phone may have the capability of downloading and storing information and data from external sources. 
It is your responsibility to ensure that in doing this you are not infringing any copyright laws or other 
applicable legislation. Panasonic accepts no liability for any and all losses howsoever arising from any loss of 
data or any such infringement of copyright or IPR, including but not limited to direct and indirect losses (to 
include, but not limited to consequential loss, anticipated savings, loss of revenues).

If your phone has an integral or add-on camera, you are advised to take appropriate care over the use of it. It 
is your responsibility to ensure that you have permission to take photographs of people and objects and that 
you do not infringe any personal or third party rights when using the camera. You must comply with any 
applicable international or national law or other special restrictions governing camera use in specific 
applications and environments. This includes not using the camera in places where the use of photographic 
and video equipment may be prohibited. Panasonic accepts no liability for any and all losses howsoever 
arising from any infringement of copyright or intellectual property rights, including but not limited to direct and 
indirect losses.
This equipment should only be used with Panasonic approved accessories to ensure optimum performance 
and avoid damage to your phone.Panasonic is not responsible for damage caused by using non-Panasonic 
approved accessories.
This phone must be used in compliance with any applicable international or national law or any special 
restrictions governing its use in specified applications and environments. This includes but is not limited to 
use in hospitals, aircraft, whilst driving and any other restricted uses.
The display layouts and screenshots within this document are for illustrative purposes and may differ from the 
actual displays on your phone. Panasonic reserves the right to change the information in this document 
without prior notice.
The liquid crystal display (LCD) uses high-precision production technology, and in certain circumstances 
pixels may appear brighter or darker. This is due to characteristics of the LCD and is not a manufacturing 
defect.
Pressing any of the keys may produce a loud tone. Avoid holding the phone close to the ear while pressing 
the keys.

Extreme temperatures may have a temporary effect on the operation of your phone. This is normal and does 
not indicate a fault. The display quality may deteriorate if the phone is used in environments over 40°C for a 
long time.

Do not modify or disassemble the equipment. There are no user serviceable parts inside.

Do not subject the equipment to excessive vibration or shocks. Do not drop the battery. 
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Avoid contact with liquids. If the equipment becomes wet, immediately remove the battery and contact your 
dealer.

Do not leave the equipment in direct sunlight or a humid, dusty or hot area.Never throw a battery into a fire. It 
may explode.

Keep metallic items that may accidentally touch the terminals away from the equipment/battery. Batteries can 
cause property damage, injury, or burns if terminals are touched with a conductive material (i.e. metal 
jewellery, keys, etc.).

Always charge the battery in a well ventilated area, not in direct sunlight, between +5°C and +35°C. It is not 
possible to recharge the battery if it is outside this temperature range.

When connecting the phone to an external source, read the operating instructions of the equipment for the 
correct connection and safety precautions. Ensure the phone is compatible with the product it is being 
connected to.

When disposing of any packing materials or old equipment check with your local authorities for information 
on recycling.



   5

SAR
European Union – RTTE
THIS PANASONIC PHONE (MODEL EB-X701) MEETS THE EU 
REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.
Your mobile phone is a radio transmitter and receiver. It is designed and manufactured not to exceed the 
limits for exposure to radio frequency (RF) energy recommended by The Council of the European Union. 
These limits are part of comprehensive guidelines and establish permitted levels of RF energy for the 
general population. The guidelines were developed by independent scientific organisations through 
periodic and thorough evaluation of scientific studies. The limits include a substantial safety margin 
designed to assure the safety of all persons, regardless of age and health.

The exposure standard for mobile phones employs a unit of measurement known as the Specific 
Absorption Rate or SAR. The SAR limit recommended by The Council of the European Union is                  
*2.0 W/kg. Tests for SAR have been conducted using standard operating positions with the phone 
transmitting at its highest certified power level in all tested frequency bands. Although the SAR is 
determined at the highest certified power level, the actual SAR level of the phone while operating can be 
well below the maximum value. This is because the phone is designed to operate at multiple power levels 
so as to use only the power required to reach the network. In general, the closer you are to a base station 
antenna, the lower the power output of the phone.

Before a phone model is available for sale to the public, compliance with the European R&TTE directive 
must be shown. This directive includes as one essential requirement the protection of the health and the 
safety for the user and any other person. The SAR value for this model phone, when tested for use at the 
ear** for compliance against the standard, was **0.484 W/kg, and when worn on the body, measured with 
1.5 cm air gap, was 0.697 W/kg. While there may be differences between the SAR levels of various phones 
and at various positions, they all meet the EU requirements for RF exposure.

This device was tested for typical body-worn operations using the carry case model EB-YKX700, which 
provides 1.6 cm separation distance from the body, and also tested with the back of the phone kept           
1.5 cm from the body. To maintain compliance with RF exposure requirements, use only belt-clips, holsters 
or similar accessories that maintain a 1.5 cm separation distance between the user’s body and the back 
of the phone, including the antenna. The use of belt-clips, holsters and similar accessories should not 
contain metallic components in its assembly. The use of accessories that do not satisfy these requirements 
may not comply with RF exposure requirements, and should be avoided.

*The SAR limit for mobile phones used by the public is 2.0 watts/kilogram (W/kg) averaged over ten grams 
of tissue. The limit incorporates a substantial margin of safety to give additional protection for the public 
and to account for any variations in measurements. SAR values may vary depending on national reporting 
requirements and the network band. 

**Right side of Head (Test Position: Cheek) Measurement results for GSM900.

For SAR information in other regions please look under product information at 
http://www.panasonicmobile.com/health.html
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GETTING STARTED
The Panasonic X701 GSMTM/GPRS mobile phone operates on Global System for 
Mobile Communications (GSM) networks around the world, which provide integrated 
voice mail, text short message service (SMS), multimedia messaging service (MMS), 
fraud protection and superior voice quality. 

Feature Availability
Some features are network dependent or are available only if you subscribe to the 
feature. Some functions are SIM card dependent. Note that before you can use or 
activate many of the network features, you must subscribe to the desired services. For 
more information, contact Vodafone.

Before Using Your Phone
The SIM card must be installed in your phone for it to operate on the cellular network. 
Insert SIM card, then attach battery and fully charge it.

INSTALLING AND REMOVING SIM CARD

Installing SIM Card
1. Place thumbs at outer edges of battery cover, 

press down, then slide off battery cover towards 
bottom of phone. Remove battery (see page 7).

2. Position SIM card as shown, with gold contacts 
facing phone and notched corner entering phone first. 
Carefully slide the SIM card into the SIM card pocket until 
it clicks.
• If SIM card is inserted incorrectly or damaged, Insert 

SIM card may display. Remove SIM, card then install 
again.

• If SIM card rejected message appears, contact 
Vodafone.

Caution: This product contains small parts. Keep out of reach of small children.
Take care not to scratch or bend SIM card and gold contacts.

Note: Refer to the label in the battery compartment for location of SIM card pocket and notched 
corner area.

SIM Card
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Removing SIM Card
1. Place thumbs at outer edges of battery cover, 

press down, then slide off battery cover towards 
bottom of phone. Remove battery (see page 7).

2. Gently push bottom edge of SIM card forward 
into SIM card pocket to release SIM card. 

3. After SIM card is ejected, gently remove it.

INSTALLING AND REMOVING BATTERY

Installing Battery
1. Hold battery at a 45º angle; insert tabs on top 

edge of battery into slots along top edge of 
battery area.

2. Push bottom of battery down until it clicks.
3. Replace battery cover by sliding cover 

toward the bottom of the phone. Cover 
should fit snugly with no gaps.

Removing Battery

1. Place thumbs at outer edges of battery cover, 
press down, then slide off battery cover 
towards bottom of phone.

2. Use tabs at bottom of battery to lift and 
remove battery.

3. Replace battery cover.

CHARGING BATTERY

1. Open connector cover.

Note: If you are upgrading your phone and your previous phone did not support new services, 
such as MMS (Multimedia Messaging Service), you may need to insert a new SIM card. 
Contact Vodafone. 

Caution: Using non-Panasonic accessories or accessories not recommended by Vodafone may 
result in poor performance of your phone, or even cause an electrical hazard.

Note: Before you remove the battery, switch off the phone and disconnect the phone from the 
charger or any other device.

Note: First verify that battery is installed. 

SIM Card
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2. Insert connector into left side (2 gold contacts) of connector area at bottom end of 
the phone. Connect Travel Charger into mains power socket.

3. When charging is complete, remove from 
mains power socket and press release 
button to disconnect the charger from the 
phone.

• DO NOT force connector: it may damage 
phone or Travel Charger.

Charging Icons on Main and External Display
 bars scroll when charging

bars stop scrolling when charging is complete

• If the phone is switched on, Battery full message appears when charging is 
complete.

Low Battery Warning
When the battery power is low, Battery low displays and a warning tone sounds; phone will 
automatically switch off. Fully recharge the battery. If you receive the low battery warning 
during a conversation, finish your call immediately.

INSTALLING AND REMOVING miniSD CARD
The miniSD Card is a memory card used to expand phone memory and a way to 
transfer files to other devices.

Installing miniSD Card
1. On top of phone, lift up miniSD Card cover. 
2. Slide miniSD Card with notched corner entering phone 

first and gold contacts facing up into the miniSD Card 
pocket until it clicks. Push down miniSD Card cover 
until it clicks.

Note: Do not insert any object except a miniSD Card into the miniSD Card pocket.
Do not place labels, etc., onto the miniSD Card. A fine difference in card thickness may 
result in insertion or removal difficulty, loss of contact or loss of data.
Take care not to scratch or bend miniSD Card and gold contacts.

MiniSD Card
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Removing miniSD Card
1. Press , scroll to Eject miniSD Card and press OK. Before removing miniSD 

Card, wait for file saving or copying process to finish.
2. On top of phone, lift up miniSD Card cover.
3. To release miniSD Card, gently push bottom edge of 

miniSD Card forward into pocket. 
4. After miniSD Card is ejected, gently remove it. Push 

down miniSD Card cover until it clicks.

 

MiniSD Card
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PHONE OVERVIEW
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Main Display

Right Softkey 
& shortcut to 
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Navigation
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Silent Mode Key

Power Key
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Clear Key

Left
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Send Key
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PhotoLight Key

Menu Key

Edit Key

Camera Key

Personal Handsfree 
(headset) 
Connector
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PhotoLight

External Display 
and Viewfinder

Accessory Connector

Camera Lens
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Infrared Port

miniSD Card Pocket
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KEY FUNCTIONS
Key Function

Power Key
Press and hold to switch phone on or off.
Press briefly to choose different profiles, lock the keypad, lock the phone, or eject 

miniSD Card.

Navigation Key
Press outside edges to scroll up , down , left  or right  to move through 

menus and text. 
Press centre  to select option or from standby mode to open Main menu.
Take a picture in Camera mode by pressing .

Send Key
Make a call.
Press in standby mode to recall recently dialled numbers. Scroll  to see received 

and missed calls lists.
Press and hold in standby mode to activate voice commands.

End Key
Ends a call.
Return to standby mode.

Menu Key
Enter the main menu area.
Press and hold to view currently open menu items.

Left Softkey
Perform action named in lower left of display.
Shortcut to open Messages in standby mode.
To lock the keypad, in standby mode press , then press . To unlock the keypad, 

press , then press .

Right Softkey
Perform action named in lower right of display.
Shortcut to open Vodafone live! in standby mode.

Edit Key
Select Dictionary for predictive text including insert and edit words, or alpha mode 

or number mode.
Insert numbers or symbols. 
Change writing language. 
Mark multiple items in a list by holding down , then scroll  or .

Clear Key
Erase character in edit mode.
Delete highlighted entered item.
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Symbols used in this manual   

Camera Key
Opens Camera.

Asterisk Key
In standby mode, press and hold to switch PhotoLight or flashlight on or off.
In numeric and standby modes, press repeatedly for *, +, p, and w characters.
In Dictionary mode, scroll to other word choices when word is underlined.
In edit mode, press to open special character table.

Zero Key
In standby mode, press and hold to enter + character for dialling.
In edit mode, enter space.

Silent Mode Key
In standby mode, press and hold to switch Silent mode on/off.
In edit mode, shift to upper and lower case letters, or press twice briefly to turn on/

off Dictionary for predictive text.

Multibutton (on side of phone)
For external display, press once to switch on backlight, then press as needed to 

toggle between clock and icon views.
Turns off ringer during incoming call.
Takes a picture in Camera mode when flip is closed.

Press Power Key. Press Menu key.

   Press outside edges of navigation 
key to scroll up, down, left or right 
to move through menus and text.

Press Navigation key centre.

Press Send key. Press End key.

Press Left Softkey. Press Right Softkey.

Press Edit key. Press Clear key.

 - Press number keys. Press Camera key.

Press Asterisk key. Press Silent Mode key.

Press Multibutton key (on side of 
phone).

Key Function
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ICONS
Different icons appear depending on the features you are using and the options you 
have selected.   

Icon Indicates Icon Indicates

Seven levels indicate battery charge 
level. Bars scroll when battery is 
charging.

Alarm is set.

Seven levels indicate signal strength 
from network on which phone is 
currently registered.

New voice mail message received (if 
you have 2 lines, left circle is 
darkened for line 1, right circle is 
darkened for line 2).

GPRS service is available. New message received.

GPRS service is on hold during 
voice call.

Message in Outbox waiting to be 
sent.

GPRS connection is active. Bluetooth® is enabled.

Multiple GPRS connections are 
active. Bluetooth® is active.

Missed call. Infrared is enabled (flashes when 
active).

Call divert is active (if you have 2 
lines, 1 or 2 also appears). USB connection enabled.

Line selection 2 
(SIM card dependent, if you have 2 
phone lines).

Navigation key - scroll and move up 
or down options.

Data call. Navigation key - scroll left or right.
Move left or right to view tabs.

Keypad is locked. All ringing tones/ring volume are off 
(Silent ringtone).

Earpiece sound on. Private handsfree headset attached.

Loudspeaker sound on.
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STANDBY MODE DISPLAYS AND SHORTCUTS
MAIN DISPLAY

 

EXTERNAL DISPLAY

Press Multibutton once to switch on backlight, 
then press as needed to toggle between clock 
and icon views.

NAVIGATION KEY SHORTCUTS
in standby mode

Time
Network that phone is 
currently using

Battery charge 
level icon

Date

Vodafone live!

Signal strength icon

Wallpaper

Messages

Phone Status 
icon area

Time 
and 
date 
area

Battery 
charge 
level 
icon

Network
that

phone is
currently

using

Signal
strength

icon

Network Status 
icon area

Vodafone live!

Calendar 
view

Top of 
Contacts list

Inbox

Open
Main

Menu
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PHONE BASICS AND MANAGING CALLS
SWITCHING THE PHONE ON AND OFF
Press and hold .

MAKING CALLS
Check that phone is switched on, signal strength icon displays at least one bar , and 
Vodafone logo displays before dialling a call.

Type in the Phone Number to Dial
1. From standby mode, enter the area code and phone number, and press .
2. To end the call, press .    

Use a Contact Card to Dial
From Contacts menu: 
1. Open Contacts List.
2. Scroll to desired name card, press .

• If the card has several phone numbers stored, select the one you wish to dial.
To add information to your Contacts List, see page 30.

Use a SIM Directory Entry to Dial
From Contacts menu:
1. Open Contacts List.
2. Scroll  to SIM directory view.
3. Scroll to desired name, press .

To add names and numbers to your SIM directory, see page 34.

Speak the Name to Dial
To dial by saying the name of the person you wish to call: 
1. Press and hold . 

Note: If your SIM card is PIN protected, your PIN code will be requested. Enter the PIN code 
and press OK. See Security Settings on page 111.

Note: To erase a digit, press .
During a call, scroll  or  to adjust earpiece volume.

Warning: Closing the flip during a call will end the call, when set to default. To set the phone to 
keep the call connected when you close the flip, see Open to answer/end in Call 
Settings on page 108.
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2. After the prompt to “Say a command”, say “Voice Dial”.
3. After the prompt to “Say the name or number”, say the full name of a person in 

your Contact List, including first name and last name.
4. The name is repeated, and the phone will begin dialling.

See page 98 for more Voice Command options.

Speed Dialling
If you assigned speed dialling keys (see page 39) to your frequently called numbers, 
you can dial them with 2 key presses.
1. From standby mode, press the preset speed dial digit key  - , then press 

.
• If Speed dialling is set to On (see Call Settings on page 108), just press and 

hold the preset speed dial digit key to dial the assigned number.

Dialled Numbers, Received, or Missed Calls List
You can quickly dial previously dialled numbers, received call numbers, or numbers of 
calls you missed.
1. From standby mode, press .
2. From the list of Dialled numbers, scroll to desired entry and press  to dial.

• Scroll  to move to Received calls tab and Missed calls tab to select a number 
from either of those lists.

Automatic Redial
If you set Automatic redial to On in the Call Settings menu (see page 108), your 
phone will automatically redial the number up to 10 times under certain conditions, 
such as no answer, destination number is busy, network busy, or some connection 
errors.
Press Quit or  to stop automatic redialling.

Dial from Messages
If a received message contains a phone number, you can dial it from the Inbox 
message. You can also call the sender of an SMS text message.
From Messages menu:
1. Open Inbox.
2. Scroll to desired message and open. 
3. To find the phone number within a message, press Options and select Find > 

Phone number, Email address, or Web address. When found, text and numbers 
will be underlined.

Note: Speed dial key 1 may be reserved for voice mailbox number.
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• To call the sender of SMS text message from the open message, press  to 
dial the sender’s phone number.

International Calling
From standby mode, press and hold  to enter +, the international prefix, which is a 
shortcut for international dialling access. Then type in the country code, area code, 
and phone number. Press . 

Emergency Calls
Dial the local emergency number used in your current location.
1. Switch on the phone if it is off.
2. Verify that the antenna icon is displayed.
3. Enter the local emergency number (such as 112) and press . 

Send Service Command to Network
Ask Vodafone to activate a particular service by sending a service command. These 
commands, which may be called USSD commands, can activate services such as 
mobile prepay and chat.
1. First, contact Vodafone for the proper service command code.
2. Type in the supplied service command code. If the phone recognises it as a 

supplementary service or USSD request, press Send service comm..

ANSWERING CALLS
When there is an incoming call, the phone rings and flashes green.

1. Open flip to answer a call.
• If flip is open, press  to answer a call.

Mute Ringing Tone
To mute ringing tone, press  if flip is closed. If flip is open, press Silence . Then 
answer the call by pressing .

Note: Many countries/regions include an initial 0 in the area code. In most cases, you should 
omit this when dialling international numbers. For further help, contact Vodafone.

Note: You can call the local emergency number even if the keys are locked.
Making emergency calls without SIM is country or network operator dependent.

Note: If the phone is set to a ringtone with vibrating alert on, the phone flashes green and 
vibrates instead of ringing.
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Change Answer Settings
To change the setting so a call will not be answered by opening the flip, see Open to 
answer/end in Call Settings on page 108.
To answer by pressing any key except , , or , see Anykey answer in Call 
Settings on page 108.

Divert Incoming Calls
To divert calls to your voice mailbox or another number, see Call Divert on page 114.
Then you can press  or Reject softkey and incoming calls will be diverted.
If you ignore the call by not pressing any keys, the call details appear on the Missed 
calls list.

ACTIVE CALL OPTIONS
When on a call, you can put the call on hold, mute the microphone, send touch tones 
for passwords, etc., and create multi-party calls, depending on network support.

Place Calls on Hold
To put a call on hold or release the call from hold, press Options and select Hold or 
Unhold.

If you are connected to 2 calls (an active call and a call on hold), press Options and 
select:   

HANDSFREE TALKING
To hear the caller’s voice from the handsfree loudspeaker, press Loudsp.. Set the 
phone down nearby so you and several others can have a conversation without 
holding the phone. 
To go back to the earpiece, select Handset.

Swap Put active call on hold and activate held call.

Transfer Connect an active call and held call, or incoming call to active or held call, 
and disconnect yourself from both calls, leaving the two callers to talk to 
each other.

Shortcuts: You can also press  to switch between Hold and Unhold on one call, or switch 
between one active and one held call (Swap). 
To end a held call and continue with the active call, press  and .
To end the active call and continue with the held call, press  and .

Loudspeaker icon - handsfree is active.
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If you have activated a Bluetooth® handsfree headset, press Options and select BT 
Accessory to hear the caller's voice in the Bluetooth® headset.

Volume Control
Scroll  or  to increase or decrease volume of phone earpiece , phone 
loudspeaker , or if a headset is attached. Note the volume step bars change as you 
adjust volume.
To mute or unmute the microphone, press Options and select Mute or Unmute. Mute 
switches off microphone of phone and any accessory microphones if attached. 
Unmute switches microphone back on.

CALL WAITING
If you activated Call waiting network service in Call Settings (see page 108), you can 
answer an incoming call when on an active call.
1. During an active call, press  to answer an incoming call. The active call is put 

on hold.
• To switch between the calls, press Swap or .
• To end the currently active call and answer the incoming call, press Replace.

2. To end the currently active call, press . The held call becomes active.
• Or to end both calls at once, press Options and select End all calls.
• If you press and hold , all calls and data connections are ended.

To reject the incoming call, press Reject. The caller receives a busy message or goes 
to voice mail.

Send DTMF Touch Tones
DTMF touch tones can be transmitted during a call just by pressing the keys (0 to 9, #, 
*) on your phone. Touch tones are often used to access services such as voice 
mailboxes, calling card calls, and banking. 

During a call, press Options and select Send DTMF if you stored a DTMF touch tone 
sequence in a Contacts card. Press Find, scroll to desired entry and select. 

To dial or store touch tone sequences:
1. Type in access phone number.
2. Before entering touch tone digits, press  repeatedly to scroll through *, +, p, 

and w characters to insert:
• a short pause before the digits are transmitted (p character).
• a manual wait period (w character) that requires you to press Send  during 

the call to transmit the digits.

Earpiece icon - handsfree is not active.



20      

• + character to send a touch tone sequence stored in a speed dial location (see 
page 39).

3. Enter the touch tone digits, for example, the access codes for your voice mailbox.
4. Press  to immediately dial call, or press Options and select Add to Contacts 

to store sequence in your Contacts (see page 30).

Open Menus During a Call
During a call, open the main menu by pressing , then open the desired menu, for 
example, check your Calendar for an upcoming meeting time. The active call remains 
connected and is indicated by a small pop-up window. To return to the active call 
window, exit the menu.

If you press , an active call will always disconnect.

Play/Record Sound Clips During a Call
To play a sound clip during a call, open the sound clip from its current location and 
play. 
The other person hears the sound clip.
To record the current call, see page 87.

Multi-Party Calls
In a multi-party call, you can have a conversation with up to 5 different parties at the 
same time if supported by the network.
1. Call the first party.
2. After the call is connected, press Options and select New call to enter a number 

or press Find to go to the Contacts List to dial a number and press . The first 
call is put on hold.

3. After the new call is answered, press Options and select Conference to join the 
held call and the active call together. From then on, there is only one active call, 
which is the multi-party call.

4. To add another party to the call, repeat step 2, then press Options and select 
Conference > Add to conference.

5. To have a private conversation with one of the parties, press Options and select 
Conference > Private. Scroll to desired party and press Private. The separated 
party becomes the active call on your phone, the multi-party call is put on hold; 
however, the remaining callers can continue with the multi-party call. To return to 
multi-call, press Swap. To return Private call to multi-call, press Options and 
select Add to Conference.

Note: You can enter multiple instances of pause, wait, and speed dial characters and touch 
tone sequences.
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6. To drop a party from the multi-party call, press Options and select Conference > 
Drop participant.  Scroll to desired party and press Drop. 

7. To end the multi-party call, press . 

ENDING CALLS
There are several ways to end a call:

• Close the flip.
• Press .
• Press End call softkey.
• Press Options and select End active call.

To end all calls if there are more than one:
• Press Options and select End all calls.

If you press and hold , all calls and data connections are ended.

For ending held calls, waiting calls, and multi-party calls, see Active Call Options 
starting on page 18.

CLOSE THE PHONE DURING A CALL
Closing the flip ends the call. This is the default setting for Open to answer/end in Call 
settings. If you want to close the phone and speak handsfree during a call, change the 
Open to answer/end setting to Off. This setting switches the caller’s voice to the back 
loudspeaker so you can speak handsfree.

To keep calls connected when you close the flip and prevent calls from being 
answered while the flip is opened, see Open to answer/end in Call Settings on 
page 108.

Note: If you are on an active call and already have a held call, start at step 3.
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PERSONAL HANDSFREE HEADSET
If you are using a Personal Handsfree Headset, plug it into the phone to have a phone 
conversation without holding the phone to your ear. 

Connecting the Personal Handsfree Headset
1. Pull out the cap from the jack on the side of the 

phone and securely plug in the Personal Handsfree 
Headset connector. The speaker and microphone in 
the phone are automatically disabled.

2. Attach the Personal Handsfree Headset clip to your 
clothing.

3. Insert the earpiece into your ear. 

Using the Personal Handsfree Headset
• To make a call, dial as normal, then press the Send/

End button on the headset.
• To answer and to end a call, press and hold the Send/End button on the headset.
• To dial a call by speaking a name, press and hold  on the phone. See Voice 

Commands on page 98.
• During a call, adjust volume by scrolling  or  on navigation key on the phone. 

On the phone, a light indicates that a call is connected.
Warnings:Check ring volume before using handsfree device to ensure volume is not 

uncomfortably loud.
Some countries do not allow the use of an ear insert device when driving. Be sure to 
check local laws before using this device.
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ENTERING TEXT
There are two main ways to enter text: using the predictive text dictionary to quickly 
enter words, or alpha mode in which each key is tapped until the planned letter 
appears.

DICTIONARY FOR PREDICTIVE TEXT ENTRY
Dictionary uses a predictive text system to enter words by pressing one key per letter 
to display the planned word, instead of pressing keys multiple times until each planned 
letter appears. 

For example, to enter “Call me.” in a message, press:

                
C a l l m e .

When you press the 6 key and the 3 key, the word “of” appears on screen, because 
the English dictionary ranks “of” as the most common word associated with the key 
presses 6 and 3. To change the word “of” to “me”, press  once, and the word 
changes.
DISPLAY PLANNED WORD MATCHES
If the correct word does not display, press  repeatedly to scroll through an 
alternate word list. To choose from all the word matches, press  and select 
Dictionary > Matches.

ADD WORDS TO PREDICTIVE TEXT DICTIONARY
To add a word that is not already in the dictionary, press  and select Dictionary > 
Insert word. You can also add the word to the dictionary when Spell softkey appears.

GENERAL TEXT ENTRY
Enter text and numbers in one of three ways: 

Alpha mode - press each key repeatedly until planned letter appears.

Dictionary mode - press one key per letter for dictionary to display planned 
word.

 Numeric mode - enter numbers.

In both alpha mode and dictionary mode, choose from:
First letter capital All capitals
Lower case

Shortcut: To enter numbers while in alpha or dictionary mode, press and hold desired number 
key  - .



24      

To enter symbols, press  and select Insert symbol, or press .

To enter text at a flashing cursor:
1. Press the number keys associated with the planned letters repeatedly until the 

planned letters appear on screen. 
• To enter text using the predictive text dictionary, press  and select 

Dictionary on, if it is not already active.
2. Editing actions for each key and shortcuts:

Cut, Copy, and Paste Text
1. To cut, copy, and paste text, move cursor to left of text you wish to copy. 
2. While holding down , press and hold  to highlight text.
3. Release keys to stop highlighting. 
4. Press  and select Cut or Copy. 
5. In message field, move cursor to new desired location, press  and select 

Paste.

Enter space.

Enter punctuation by pressing repeatedly.
In dictionary mode, press , then press  repeatedly to scroll to other punctu-

ation.

Erase a character.

Press and hold to switch between text and number modes.
Press to scroll through upper case, lower case, and first letter capital mode.
Press twice briefly to turn Dictionary on or off.

Turn Dictionary on or off.
Switch to number mode.
Insert symbols.
Change writing language.

Scroll to other word choices in Dictionary mode.

Press outer edges to scroll up, down, left, and right through text.



   25

NAVIGATING THE MENUS
To view the main menu window, press .

Navigation Key
Press the left, right, top and bottom edges of the navigation key to move around 
the display. 

Press  to:
• Open a menu item;
• Select a highlighted item;
• Confirm a selection;
• Take a picture with the camera.

If an up or down arrow appears at the bottom of the display, scroll  or  to go to 
additional items.   

Tabs
There may be more files, folders, or pages associated with a 
menu item, which can be viewed by moving right and left across 
the screen. This is indicated by tabs , arrows , 
or numbers near the top of the screen.  For example, if you are 
viewing page 5 of 12 pages associated with a file, 5/12 and 
arrows are displayed.
• Scroll  and  to move through the tabs and pages. 

Condensed Instructions in this guide
In this guide, to condense wording, statements are used such as "Press Options and select 
Open." This means to press Options, highlight Open, and press Select. You may need to 
scroll within the menu to reach Open. Many menu items are available within Options menus 
and other menus, thus these shortcut statements will be used throughout the guide to 
indicate the same type of process.
In this guide, a statement such as 'Select Create message > Via MMS', means to scroll to 
Create message, then scroll  to view the pop-up menu containing Via MMS, then press 

 or Select softkey to select Via MMS. Within the pop-up menu, you may need to scroll to 
highlight Via MMS.

Shortcut: To jump to and open one of the first 9 menu items (if you 
have not yet scrolled), simply press the number key 
corresponding to the desired item’s location on the grid 
view. The grid view numbering system is: 

1 2 3

4 5 6

7 8 9



26      

Options Softkey
At the first level of each menu item, Options  appears as a way to organise or 
customise the menu system. The options change depending on the menu level you 
are viewing.

To open the Options menu:
• Press Options, scroll to highlight the desired action, then press  or press Select. 

These additional actions may be available in the Options menu:

Mark/Unmark
In menu items containing many files, you can mark specific files in which to perform an 
action. For example, you may wish to delete 5 pictures from your Pictures folder 
containing 29 pictures.

To mark an item or items:
1. Press Options and select Mark/Unmark > Mark to place a checkmark next to the 

desired file. Scroll to mark more items as needed, or select Mark all to mark all 
files.

2. Press Options, then select desired action such as Delete, Send, Move.

To unmark an item or items:

Open Open the item.

List view View the menu items in a list form. If you select this, the option changes 
to Grid view to view the menu items in a grid form.

Move Move the item to another place within the menu system.

Move to folder Move the menu item into a folder.

New folder Create and name a new folder.

Memory 
details >

View information about items stored in the phone memory and memory 
card (also referred to as miniSD Card).

Exit Exit the menu item.

Remove or 
Delete

Remove or delete an item or a marked item (see Mark/Unmark on 
page 26) on a list or grid, or press .

Rename Give a new name to the item.

Edit Change information you have already entered.
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1. Press Options and select Mark/Unmark > Unmark on a marked file to remove the 
checkmark. To unmark all files, select Unmark all. 

Menus within a Menu
A pop-up menu appears when more than one choice is available. 
For example, you can create a message to send a Contacts entry 
several ways: via SMS message, via MMS, via Email, via 
Bluetooth®, and via Infrared. 

To enter a pop-up menu:
• Scroll , or press , or Select softkey.

To close a pop-up menu:
• Scroll , or press Cancel softkey.

Save Changes
In many cases when editing text or numbers, or changing a setting, press the Back 
softkey to automatically save changes.

MULTITASKING
You can work with more than one menu item simultaneously. For example, you can 
start creating a new message, rename a picture, and begin creating a Contacts entry, 
all without losing the data you have already entered.

To keep a menu item open:
Press  to go to the standby screen. Pressing  does not close the open menu 
item. 

Opening and closing menu items
There are several ways to open menu items:
• Press .
• Press Options and select Open.

There are several ways to close menu items:
• Press Options and select Exit.
• Press Back until Exit softkey appears, then press Exit.

Shortcuts: To mark or unmark an item, hold down , then press .

To mark or unmark multiple items, hold down , then press and hold  or  of 
navigation key to scroll through desired items. Release  or  to stop marking.

Note: During a phone call,  terminates the call instead of acting as a shortcut to the 
standby screen.
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• Press Close.

Shortcut to swapping among open items
If you have several menu items open, you can press and hold 

 to view a pop-up window and scroll to locate the desired 
open item. When you open the item, you will begin at the point 
where you were previously.
To close an open item from the pop-up window, scroll to desired 
item, press  and select Yes.

SEARCH OPTION
In certain menu items, a magnifying glass icon  
appears which allows you to search for a name, file or item.
To search, enter the first letter of the desired name or file. The phone finds and 
displays matching entries. To refine the search, enter two or more letters.

SHARED PHONE MEMORY
The phone's memory capacity is shared by all pictures; SMS, MMS and email 
messages; Contacts cards; video and sound clips; ringtones; Calendar notes; Notes 
and downloaded applications stored on your phone. If you keep more files on the 
phone, then there is less memory available to store new files or run certain 
applications.
To decrease the amount of phone memory used: (1) store data on your miniSD Card; 
(2) delete data that is old, copied elsewhere or not being used; (3) delete messages 
with attachments from your Inbox after saving attachments to a menu item; (4) use the 
portrait format to take pictures with the Camera whenever possible. The portrait format 
file size is much smaller than standard format.
To view details of the phone memory and miniSD Card use, and amount of free 
memory: 
1. Press .
2. Press Options. 
3. Scroll to Memory details.
4. Then scroll  to choose phone memory or memory card (also referred to as 

miniSD Card), press Select. 
Also see File Manager on page 89.
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MENU MAP
The phone's main menu items are listed below. The names listed represent the names 
in list view. The names may be slightly different in grid view. 

Note: The menus may not appear in the order or with the same icons as listed here. The order 
and icons vary according to your network operator, or if you have customised your 
settings.

  Games   Vodafone live!   Applications
More Games Vodafone live!

Enter URL
Bookmarks
What's New
Games
Ringtones
Pictures
Themes
News
Sports
Media Album

SIM Tool Application 
(optional)

MMS Postcards
Application Mgr
Calculator
Converter
Recorder
File Manager
Quickoffice
PhotoBase
Voice Command
RealOne Player
Shortcuts

  Messages   Camera   My Items
Create message
Inbox
Drafts
Sent
Email Inbox
Messenger
Voicemail
My folders
Media Album
Outbox
Reports

Take Picture
Record Video
PhotoLight

Documents
Pictures
Sounds
Videos

 Organiser   Contacts   Settings
Calendar
Alarm Clock
To-Do
Notes

Contacts List
Create Contact
Call Log
Speed Dial

Profiles
Themes
General
Connectivity
miniSD
Voice Command
PrintBoy Setup
About
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CONTACTS
Store names, phone numbers, email, web and street addresses, even a picture in a 
Contact card. Call and send messages directly from Contacts. Numbers can also be 
stored on your SIM card. See Entering Text on page 23 to learn how to enter text. 
Check your recent missed calls, received calls, and dialled numbers in the Call Log.

Contacts menu contains these main options:  

CREATE NEW CONTACT CARDS
From Contacts menu:
1. Open Create New.
2. Select PhoneBook to store the entry in phone memory or SIM 

to store the entry on your SIM card. 
• Unlike an entry saved to phone memory, a SIM directory entry 

consists of only one name and one phone number. If you select 
SIM, enter the Name and No., then press Done.

3. Enter information in main fields:
First name Telephone
Last name Mobile
Company Fax
Job title Email

4. From main fields, press Options to: 

5. Press Done to save entry.

Contacts Create New Call Log

SpeedDial

Add picture Place picture from your Pictures folder into the card.

Add or Delete 
detail

Choose desired fields and icons from list including Job title, Telephone, 
Tel. (home), Tel. (business), 3 mobile, 3 fax, pager numbers, 3 Email 
fields, 3 Web addresses, 3 street address fields, DTMF tones, Birthday, 
and Note.

Edit label Change the field name.

Note: See SIM Directory on page 34 to create and copy entries into your SIM directory.
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CONTACTS LIST
Your Contacts List contains all the contact information in one place that you have 
stored for your business associates, family and friends.

FIND A CONTACT CARD
From Contacts menu:
1. Open Contacts.
2. Scroll to desired entry, or enter the first letter of desired entry in . 

Entries beginning with that letter will display.
3. Press  to open entry.

MAKE A CALL
From Contacts menu:
1. Open Contacts.
2. Scroll to desired Contacts entry and press .

Or, press Options and select Call.
• If entry contains more than one number, choose desired number to dial before 

pressing . 

SEND A MESSAGE
From Contacts menu:
1. Open Contacts. Highlight desired Contacts card.
2. Press Options and select Send message > SMS, MMS, or Email.
3. To complete SMS messages, see page 49; or MMS messages on page 49; or 

Email messages on page 50.

EDIT CONTACT CARDS
From Contacts menu:
1. Open Contacts. Highlight desired Contacts card.
2. Press Options and select Edit.
3. Scroll to desired field to edit, begin entering data. If the field already has 

information, scroll  to move to editing point, press  to clear a letter or digit.
4. Press Options to:

Note: To make a call from the SIM directory, scroll  in Contacts List to view your SIM 
directory.  Scroll to the desired entry and press .

Note: Email option will appear once you set up an Email Inbox in Messages menu.

Add picture Place picture from Pictures folder in phone memory or miniSD Card.



32      

5. Press Done to save entry.

Assign Default Number to Dial
For a Contact card, set a particular phone number or address that the phone will use 
each time you wish to call or write messages to that person.
From Contacts menu:
1. Open Contacts. Scroll to desired Contact card and open.
2. Press Options and select Defaults.
3. Highlight a field:

Phone number
Text msg. number
MMS number/address
Email address

4. Press Assign.
5. Scroll to the desired entry and press Select.

• Repeat steps 4 to 6 to assign default numbers to the other fields.

Assign a Ringing Tone
From Contacts menu:
1. Open Contacts. Scroll to desired Contact card and open.
2. Press Options and select Ringing tone.
3. Scroll to desired tone (after a brief pause, tone will play). You can use tones 

already supplied, sent in messages (see page 52), downloaded (see page 77), or 
recorded (see page 87).   

To assign a ringing tone to a group, scroll  to move to Groups tab, scroll to desired 
group, and continue with step 3.

Assign Speed Dial
From Contacts menu:
1. Open Contacts. Scroll to desired Contact card and open.

Add or Delete 
detail

Choose desired fields and icons from list including Job title, Telephone, 
Tel. (home), Tel. (business), 3 mobile, 3 fax, pager numbers, 3 Email 
fields, 3 Web addresses, 3 street address fields, DTMF tones, Birthday, 
and Note.

Edit label Change the field name.

Note: To remove a default assignment, select (no default).

Note: If tones do not play, change the phone's profile to General or Outdoor to hear the tones.
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2. Scroll to desired phone number field in which to assign the speed dial key, press 
Options and select Assign speed dial.

3. Press or scroll to desired number key and press Assign. The icon  denotes that 
a speed dial key has been assigned to this number field.

To make a call using speed dial, press the associated number key, then press .

To remove an existing speed dial key, from Contacts menu:
1. Open Contacts. Scroll to desired Contact card and open.
2. Scroll to speed dial phone number field, then press Options and select Remove 

speed dial.
See page 39 for speed dial options.

Go to Web Address
If a Contact card contains a web address, you can launch the Browser and go directly 
to the web address.
From Contacts menu:
1. Open Contacts. Scroll to desired Contact card and open.
2. Press Options and select Go to web address. 

MANAGE CONTACTS LIST
From Contacts menu:
1. Open Contacts. Scroll to desired Contact card.
2. Press Options and select Edit, Delete, or Duplicate.

Memory Used in Contacts
To view number of cards, groups used and amount of memory used, from Contacts 
menu:
1. Open Contacts. Press Options and select Contacts info > Memory.

Sort Contacts List by Last Name or by First Name
From Contacts menu:
1. Open Contacts. Press Options and select Settings.
2. Open the Sort contacts by field to sort the list either by Last name first or First 

name first.

SEND A CONTACT CARD
Before a Contact card can be sent by Messaging or to another device, it is converted 
to an electronic business card format known as vCard.
From Contacts menu:

Note: See Mark/Unmark on page 26 to select more than one entry. 
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1. Open Contacts. Scroll to desired Contact entry.
2. Press Options, scroll to Create message > Via SMS, Via MMS, Via Email, Via 

Bluetooth, or Via Infrared.
3. To complete SMS messages, see page 49; or MMS messages on page 49; or 

Email messages on page 50; or Bluetooth® on page 120; or Infrared on page 118.

SIM DIRECTORY
The SIM directory shows you the names and numbers stored on your SIM card. 
Vodafone can program their service numbers, your mobile phone number and other 
numbers into your SIM card. Personal numbers can be stored on your SIM card as 
well. 

Unlike an entry saved to phone memory, a SIM directory entry consists of only one 
name and one phone number.

Copy Numbers to SIM Directory
1. From the Contacts List, highlight the desired card.
2. Press Options and select Copy to SIM direct.
3. Choose one of the phone number fields to copy, and press OK.

• If you select All, the phone creates a separate SIM directory entry for each 
phone number stored with that Contact’s entry name.

Create and Manage SIM Directory Entries
1. From the Contacts List, scroll  to view your SIM directory.
2. Press Options and select from:    

Note: Email option will appear once you set up an Email Inbox in Messages menu.

Note: To copy SIM entries to your Contacts, highlight the desired SIM entry, then press 
Options and select Copy to Contacts.
The first time Contacts is opened after a different SIM card is placed in the phone, press 
OK if you wish to copy SIM contacts into the Contacts memory.

Call Call the highlighted entry.

Create SIM contact Create a new SIM contact entry. Open and enter Name, then 
enter No. and press Done.

Edit Edit the highlighted SIM entry. Numbers stored by Vodafone 
cannot be edited.

Delete Delete the highlighted SIM entry. Numbers stored by Vodafone 
cannot be deleted.

Copy to Contacts Copy the highlighted SIM entry to your Contacts List.
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SERVICE NUMBERS
If Vodafone has stored service numbers on your SIM card, you can view and call the 
service numbers.
From Contacts menu:
1. Open Contacts. Press Options and select Service numbers.

CREATE AND MANAGE GROUPS
Place Contact cards into one group. Select the group name when addressing a new 
message, and your message is sent to each member of the group. For example, set 
up Business or Family group. See Messages starting on page 47 to learn how to send 
messages.

Create New Group
From Contacts menu:
1. Open Contacts. Scroll  to Groups tab.
2. Press Options and select Create group.
3. Enter a name for the group and press OK.
4. Open the group name, press Options and select Add members.
5. Select desired Contact cards to add.

• To remove a member from a group, scroll to desired name, then press Options 
and select Remove from group.

Manage Groups
From Contacts menu:
1. Open Contacts. Scroll  to Groups tab.
2. Scroll to desired group, then press Options and select from: Open to view group, 

Delete group, Rename group, add Ringing tone for group.

To see if a person belongs to a group, or add a person to a group, from Contacts 
menu:
1. Open Contacts. Scroll to desired Contact card.
2. Press Options and select Belongs to groups or Add to group. When adding, 

select desired group and press Add.

TAKE A PICTURE AND ADD TO CONTACT CARD
From Camera menu:
1. Open Take Picture. The main display acts as a viewfinder when the flip is open. 

The external display acts as the viewfinder when the flip is closed.

My numbers View your own phone numbers.

SIM details View the number of used and free SIM entries.
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2. To snap the picture, press  if the flip is open. Or press the Multibutton  on the 
side of the phone if the flip is closed.
• The picture is saved in your Pictures folder in My Items.

3. From the Contacts menu, open Contacts.
4. Highlight desired Contacts card.
5. Press Options and select Edit.
6. Press Options and select Add picture.
7. Select Phone memory.
8. Open Pictures folder. Scroll to highlight the picture and press Select.
9. Press Done.

CALL LOG
Check your recent missed calls, received calls, and dialled numbers. View the amount 
of data sent and received via GPRS. View details for each incoming and outgoing 
communication event such as voice calls, SMS messages, and GPRS connections.
These features are SIM card dependent.

MISSED CALLS, RECEIVED CALLS, AND DIALLED NUMBERS
When you miss an incoming call, a missed call icon  and a note displays on the 
standby screen. Press Show to view the details of the missed call.
From Contacts menu:
1. Open Call Log. Open Recent calls.
2. Open Missed calls, Received calls, or Dialled numbers. 
3. List of last 20 calls appears with caller or dialled phone number (or name if entered 

in Contacts), date and time of call. Also, scroll  or  to view lists.

To clear all Recent calls lists (Missed calls, Received calls, and Dialled numbers) at 
once, open Recent calls, then press Options and select Clear recent calls.

Call or Add to Contacts
Make a call using a number from the recent calls lists, or add the number to your 
Contacts list.
From Contacts menu:
1. Open Call Log. Open Recent calls.
2. Locate desired number in Missed calls, Received calls, or Dialled nos., and 

highlight.

Shortcut: To view the Dialled numbers list from the standby screen, press .
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3. Press Options and select:

CALL DURATION
Check duration of last call and accumulated duration of dialled calls, received calls, 
and all calls. 
From Contacts menu:
1. Open Call Log. Open Call duration.
2. Scroll to view duration of Last call, Dialled numbers, Received calls, and All 

calls (since last counter reset).
• Times indicated in hours:minutes:seconds.

To clear all Call duration lists (Last calls, Dialled numbers, Received calls and All calls) 
at once, press Options and select Clear timers.

To separate Call duration lists into summaries for each of both lines, Line 1 or Line 2, 
press Options and select Filter timers.

GPRS DATA COUNTER
View the amount of data in kilobytes sent and received by the phone via GPRS data 
packets, for example, WAP pages, email messages, downloaded ringtones and 
applications.

From Contacts menu:
1. Open Call Log. Open GPRS counter.
2. All sent data and All receiv. data amounts display in kilobytes.

To clear the GPRS counter, press Options and select Clear counters. Enter the 
phone lock code and press OK. 
See Security Settings on page 111.

Call Dial the number.

Create 
message >

Select Via SMS or Via MMS to create a new message addressed to 
the number.

Use number Use the number as a base to edit for dialling a similar number.

Delete Delete highlighted number.

Clear list Erase all numbers from selected list.

Add to 
Contacts >

Create contact card or Update existing card using the number.

Note: Actual times invoiced from Vodafone for calls and services may vary from the call timers 
depending on number of network features purchased, when billing begins and ends, 
billing rounding off, etc.
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CALL LOGS SETTINGS
From Contacts menu:
1. Open Call Log. Press Options and select Settings. 
2. Scroll to select:

GENERAL CALL LOGS
View details for each incoming and outgoing communication event such as voice calls, 
text messages, and GPRS connections.

From Contacts menu:
1. Open Call Log. Scroll  to General Logs tab .
2. A list of communication events displays. Up arrow icon  indicates outgoing or 

sent; down arrow icon  indicates incoming or received events.
3. Press Options and select:

Log duration Choose from No log, 1 day, 10 days, or 30 days to store call informa-
tion in the logs.

Show call 
duration

Select Yes to switch on a time elapsed counter to display during a call.

View details Scroll to desired event to view details such as direction (in/out), type 
(voice, data, etc.), duration (for calls).

Clear log Clear all events from the log.

Filter Separate events into a list by type such as 
Outgoing, Incoming, Voice calls, Data calls.

Add to 
Contacts >

Scroll to desired event to Create contact card or Update existing 
card using number or address.
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SPEED DIAL
Set phone to quickly dial frequently called numbers by pressing 2 keys.

ASSIGN A SPEED DIAL NUMBER
From Contacts menu:
1. Open Speed Dial.
2. A grid showing numbers 1 - 9 appears.

• If a digit is replaced by an icon, then the corresponding key 
has been reserved by Vodafone to dial a special number, for 
example, to dial the voice mailbox number.

3. Scroll to a number, press Options and select Assign.
4. Scroll to the desired Contacts card and press Select. 
5. Scroll to the desired number and press Select.

CALL A SPEED DIAL NUMBER
To call a preset speed dial number, choose a method:
• From standby mode, press the corresponding number key  -  and press .
• From the Speed Dial menu, scroll to desired number and press , or press 

Options and select Call.

CHANGE, REMOVE, OR VIEW SPEED DIAL NUMBERS
From Contacts menu:
1. Open Speed Dial.
2. Scroll to desired number on grid.
3. Press Options and select Change, Remove speed dial, or View number.
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ORGANISER
Check your Calendar before scheduling the appointment. Set the Alarm Clock to 
remind you when it is almost time for the meeting. Use To-Do menu to keep a list of 
important tasks at hand. Jot down quick notes in the Notes menu.

Organiser menu contains these main options:  

CALENDAR
Keep track of upcoming meetings, appointments and special dates. Set alarms to 
remind you of upcoming events. Calendar events can be sent and received as 
vCalendar messages and synchronised with other devices to keep track of your 
schedule.

CREATE CALENDAR NOTES
From Organiser menu:
1. Open Calendar. 
2. Press Options and select  Add note > Meeting - events with a start and end time, 

Memo - events such as trips or vacations, or Anniversary - single day events 
such as birthdays and anniversaries.

3. Enter information in most fields by entering numbers or letters:

4. Press Done to save event.

Calendar Alarm To-Do

Notes

Meeting Memo Anniversary
Subject Subject Occasion
Location Start date Date
Start time End date Alarm
End time Synchronisation Synchronisation
Start date
End date
Alarm
Repeat
Synchronisation

Shortcut: If you start typing after opening the Calendar, you are automatically entering the 
subject in a Meeting note.
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Set Calendar Alarm
When you set the alarm field to On, scroll  to set the alarm time and date.
When the alarm rings, press Stop  to stop the alarm. Press Snooze  or any 
other key to snooze the alarm. 

Set Event Repeat Cycle
When an event occurs regularly (for example, football practice or music lessons), open 
the Repeat field to set interval time periods such as Weekly or Monthly.

Set Synchronisation
If you synchronise your Calendar events with a PC, you can set the privacy level.
• Set to Private to hide notes from online viewers. 
• Set to Public to allow online viewers to see the note.
• Set to None if you do not wish to synchronise the note with your PC calendar. See 

Synchronisation on page 123.

BROWSE CALENDAR
View the calendar by day, by month, or by week.
To change view, press Options and select Month view or Week view.

CALENDAR ICONS

Day and Week views

Memo Anniversary

Month view
Scheduled note Triangle in the lower right corner of a date.

Red - private synchronisation.
Blue - public synchronisation.
Light red - none.
Purple - more than one entry for the date.

Current date Underlined. 
Selected date Boxed; date also appears in the navigation 

bar.
Far left column The year’s week number (see Week view title in Calendar 

settings).

Shortcuts: Scroll     to move around the calendar.
Press Options and select Go to date to go to a desired date.
Press  to go to today.
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Week View
Days of the week are displayed in columns. Each hour of a day is 
denoted by a cell.
Meeting notes A bar during the scheduled time periods.
Memo icons Appear between 7am and 8am.
Anniversary icons Appear between 7am and 8am.
Current weekday Underlined (if you are viewing the current 

week).
Selected date Boxed; date also appears in the navigation 

bar.
Screen title Either the week number or the week dates of the current week, 

depending on Calendar setting.

Day View
To view a certain day, scroll to the date and open.
Scheduled notes are listed.

EDIT CALENDAR EVENTS
From Organiser menu:
1. Open Calendar.
2. Scroll to desired date in any view and open.
3. Scroll to scheduled event and open. Edit desired fields.
4. Press Done when finished.

DELETE EVENTS
From Organiser menu:
1. Open Calendar.
2. Scroll to desired date in Month or Week view, and time period in Week view and 

open.
3. Press Options and select Delete or press .

To delete multiple events:
1. Open Calendar. View the calendar in Month view.
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2. Press Options and select Delete entry > Before date to delete entries before 
your specified date, or All entries.

CALENDAR SETTINGS
From Organiser menu:
1. Open Calendar.
2. Press Options and select Settings. Open each option:  

SEND CALENDAR NOTES
Before a Calendar event can be sent by Messaging or to another device, it is 
converted to an electronic scheduling exchange format known as vCalendar.
1. From an open Calendar event in Day view, press Options and select Create 

message > Via SMS, Via MMS, Via Email, Via Bluetooth or Via Infrared.
2. To complete SMS messages, see page 49; or MMS messages on page 49; or 

Email messages on page 50; or  Bluetooth® on page 120; or Infrared on page 118.

ALARM CLOCK
Choose a digital or analogue clock to appear in standby mode. Set alarm clock and 
alarm tone to remind you of events. If the phone is off when alarm time is reached, the 
phone switches on and the alarm tone sounds.

SET TIME AND DATE
From Organiser menu:
1. Open Alarm.
2. Press Options and select Settings.
3. Scroll to the desired setting and open; or press Options and select Change:  

Calendar alarm tone Scroll to select desired tone (after a brief pause tone will play).

Default view Select Month view, Week view, or Day view.

Week begins on Choose starting day of the week.

Week view title Choose Week number of the year (e.g. Week 12) or Week dates 
(e.g. 20.03.05-26.03.05). 

Note: Week view title setting is available only if Week begins on is set to Monday. Week 
numbers are shown in layouts only if Week begins on is set to Monday.

Note: Email option will appear once you set up an Email Inbox in Messages menu.

Time Either type in numbers or scroll  to enter time. Scroll  to move 
among fields.
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SET ALARMS

From Organiser menu:
1. Open Alarm.
2. Press Options and select Set alarm.
3. Enter alarm time by either typing in numbers or scrolling . Scroll  to move 

among fields. Press OK.

If an alarm is already set, you can reset or remove the alarm by pressing Options and 
selecting Reset alarm or Remove alarm.

When the Alarm Rings
When alarm time occurs, the alarm tone rings, the backlight flashes, and a message 
displays.
To turn off alarm, press Stop. 
To quiet the alarm indicators for 5 minutes, press Snooze or any key.
 
If the phone is switched off:

Date Enter date using same method as time entry.

Date format Select format where mm = month, dd = date, yyyy = year.

Date separator Choose from symbols [ .  :  /  - ].

Time format Choose 12-hour or 24-hour.

Time separator Choose symbols  :  or  ..  

Clock type Choose Analogue or Digital.

Clock alarm tone To choose a tone, scroll through list of ringing tones. To hear the 
tone, highlight the tone name and wait. To stop the tone, press any 
key. To select a tone, highlight the tone name and press Select.

Auto time update Select On to update time from the network. Available only if net-
work supported.

GMT offset Select a time zone, which is offset to GMT time (for example, 
+05:00 or -05:00). 

Daylight-saving Select On to add an offset of +01:00 to the current GMT time.

Note: GMT offset and Daylight-saving settings are available only if Auto time update is set 
to Off.

Caution: Alarms should not be set to switch on the phone when you are in an aircraft, near 
sensitive medical equipment, or at a refuelling point.
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• The phone temporarily switches on and the other alarm indicators take place. 
• If you press Snooze, the phone automatically switches off for 5 minutes, then 

the alarm rings again (maximum 5 times). 
• If you press Stop, you are asked whether you wish to switch the phone on.

The alarm is deleted when you press Stop. If you wish to have an alarm for the next 
day, you have to set the alarm again.

TO-DO LIST
Make a list of tasks, and set a deadline and priority for each.

Create a New To-do Task
From Organiser menu:
1. Open To-Do.
2. Press Options and select Add task.
3. Enter information in fields:

4. Press Done to save.

Edit and Mark To-do Tasks
From Organiser menu:
1. Open To-Do.
2. Scroll to the desired task.

• To edit, open task and edit information in fields as desired. 

• To mark the task as completed or to restore task, press Options and select 
Mark as done, or Mark as undone.

Caution: Do not press Yes to switch phone on when you are in an aircraft, near sensitive 
medical equipment, at a refuelling point or when it may cause interference or danger.

Subject Description of task or subject.

Due date Assign a due date.

Priority Open and select High, Normal or Low.

Note: In the list of tasks, ! icon means High priority task; - icon means Low priority task.

Note: A checkmark within a box means task is completed. A blank box means task is 
unfinished.
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NOTES
Jot down quick notes and save them here. Open and edit simple text documents (.txt) 
saved from text attachments sent using messaging. 
From Organiser menu:
1. Open Notes.
2. Press Options and select Add note. 

To send a note:
From Organiser menu:
1. Open Notes.
2. Press Options and select Create message > Via SMS, Via MMS, Via Email, Via 

Bluetooth or Via Infrared. 
3. To complete SMS messages, see page 49; or MMS messages on page 49; or 

Email messages on page 50; or Bluetooth® on page 120; or Infrared on page 118.

Note: Email option will appear once you set up an Email Inbox in Messages menu.
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MESSAGES
Messages menu contains these main options:

Messages Menu Main Options 

In some main Messages options, icons indicate the message type:

To view Cell Broadcast messages, see page 63.

MESSAGE BASICS
Send, receive, and store messages from text message (SMS), multimedia (MMS), 
email, service and cell broadcast. 

Create Message Inbox Drafts

Sent Email Inbox Messenger

Voicemail My folders Media Album

Outbox Reports

Create message
Create new messages.

Inbox
Stores received messages 
except email and cell 
broadcast.

Drafts
Stores unfinished messages.

Sent
Stores sent messages.

Email Inbox
Receives and stores email 
messages.

Messenger
Chat service.

Voicemail
Listen to voice messages.

My folders
Stores moved messages and 
templates.

Media Album
Stores personal pictures on 
your online photo album.

Outbox
Temporarily stores messages 
waiting to be sent.

Reports
Delivery status on SMS, MMS, 
and smart messages.

Text message Bluetooth® Cell broadcast

Multimedia Infrared Unknown

Email WAP push Attachment

Smart
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Messaging Types
SMS: Short Message Service allows you to send and receive short text messages to 
mobile phones with short text message capability on the same network or any network 
that has a roaming agreement. A small black and white picture message can be 
inserted in the message.
MMS: Multimedia Messaging Service allows you to send messages containing 
pictures, video clips, sound clips and text. Presentation templates are available to 
place media objects into prearranged layouts. Multimedia messages can be sent to 
another mobile phone with multimedia capability or to an email address.
Email: Create, send and receive email messages, which can have attachments.
Smart messages: Messages containing data such as electronic business cards, 
ringing tones, Java™ applications or configuration data such as WAP and multimedia 
settings.

These services do not work by sending messages directly to the recipient; instead they 
store and forward messages through specifically designated network servers. 

Before Using Messaging Services
Before you can use multimedia or email messaging, your connection settings must be 
configured. 
Your multimedia configuration settings may already be set by Vodafone. If settings are 
not available, contact Vodafone.
Your email configuration settings are provided by an Internet Service Provider (ISP) 
that supports POP3/IMAP4/SMTP protocols. 
Before you can send and receive email:
(1) you need a subscription for data services;
(2) contract must be set up with an ISP;
(3) you must configure an Internet Access Point (see Access Point Settings on 
page 108).
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CREATE MESSAGE
Create new SMS, MMS, and email messages to send to friends and family.

CREATE NEW SMS MESSAGES
From Messages menu:
1. Open Create message.
2. Select SMS.
3. In the To field, type in recipient’s phone number.

• To retrieve from Contacts card, press , or Options, and 
select Add recipient. Scroll to desired name and press OK. 
Select desired number if entry has several numbers. 

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to move to text entry field, enter text.
5. If desired, press Options and select Insert > 

6. To send, press  or press Options and select Send.

CREATE NEW MMS MESSAGES
From Messages menu:
1. Open Create message.
2. Select MMS.
3. In the To field, type in recipient’s phone number or email 

address.
• To retrieve from Contacts card, press , or Options, and 

select Add recipient. Scroll to desired name and press OK. 
Select desired number if entry has several numbers. Card 
must have a phone number or email address to be visible.

• To separate multiple recipients, enter a semicolon (;) by pressing . 
4. Scroll  to move to text entry field, enter text.
5. If desired, press Options and select Insert > 

Picture Picture msg. from My Items.

Template Select from a list of sentences in which you fill in the blank.

Note: Text messages have a 160 character limit. The counter keeps track of total characters 
available. If you use more than 160 characters, a new text message starts, but appears 
as one message for the recipient. You will be charged for more than one text message.

Picture Picture from your Pictures folder.

Sound Sound clip from your Sounds folder.
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6. To send, press  or press Options and select Send.

CREATE NEW EMAIL MESSAGES
Before you can write an email message, at least one mailbox must be configured. See 
page 54.
From Messages menu:
1. Open Create message.
2. Select Email.
3. In the To field, type in recipient’s email address.

• To retrieve from Contacts card, press , or Options, and 
select Add recipient. Scroll to desired name and press OK. 
Card must have an email address to be visible.

• To separate multiple recipients, enter a semicolon (;) by 
pressing .

4. Scroll  to enter recipients in Cc (courtesy copy) field and type subject in subject 
field (both fields optional).

5. Scroll  to move to text entry field, enter text. 
6. If desired, press Options and select Insert > 

7. To send, press , or press Options and select Send.
• To view, add, or remove attachments before sending, press Options and select 

Attachments.

• If phone is set to send email during next connection to mailbox, then pending 
email will be stored in Outbox.  Change setting by pressing Options and 
selecting Sending options.

Video clip Video clip from your Videos folder.

New picture New picture from Camera.

New sound New sound clip from Voice Recorder.

Slide Add new slide to message.

Note: If MMS messages are sent to devices without multimedia or email capabilities, the 
recipient may receive a message containing a link to a web page.

Picture Picture from your Pictures folder.

Sound clip Sound clip from your Sounds folder.

Video clip Video clip from your Videos folder.

Note Note from Notes.

Template Select from a list of sentences in which you fill in the blank.
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COMMON WRITING TASKS
• To cut, copy and paste text, see page 24.
• To save before sending, press Close. Message is automatically stored in Drafts 

folder.
• To match names in To and Cc fields to names in Contacts, press Options and 

select Check contacts.

INBOX
Inbox stores received SMS, MMS, and smart messages. Incoming Bluetooth®, 
Infrared, WAP push, SIM, voicemail and email waiting messages are also placed here.

Receive New Messages
When you receive a new message, the standby screen displays a new message icon 

 and a note indicating the number of new messages. Press Show to read the 
message. If there is more than one message, press Show to open the Inbox, then 
scroll to the desired message header and open.

The messages remain in the Inbox until you move them to My folders or delete them.
Unread messages have incoming arrow appearing with icon that identifies type of 
message.
Read messages have no arrow with icon.

Read or Play Inbox Messages
From Messages menu:
1. Scroll to Inbox and open.
2. A list of message headers displays, indicating type of message sender (MMS, 

Bluetooth®, etc.) and icon. Scroll to desired message header and open.
• The message may first need to be retrieved from the network server depending on 

the message type, or if it contains large files.
• Press Play if needed for video clips, sound clips or presentations.
• If the message contains a picture, it opens automatically.

Reply to and Forward Inbox Messages
From Messages menu:
1. Open Inbox.
2. Scroll to desired message and open, press Options and select Reply > To sender 

or To all or Forward. 
3. To reply, enter text in text field.

To forward, enter recipient(s) phone numbers or email addresses.

Note: Scroll  to decrease or increase audio volume.
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4. Press .

Store Inbox Messages
From Messages menu:
1. Open Inbox.
2. Highlight desired message.
3. Press Options and select Move to folder.
4. Choose a folder and press OK.

Save Attachment or Data
You can save pictures and media clips from messages. Attachments to email, links to 
streaming media, Contacts cards, Calendar notes, ringtones, and configuration data 
can also be saved.
1. Open desired message.
2. Press Options and select Save. 

• If needed, the data is directed to the appropriate menu item.
3. If needed, select to save either in phone memory or miniSD Card, press OK.
4. If needed, scroll to desired folder to place object or attachment, press Open or 

Save. If desired, rename the file. Press Save.

Find Phone Number, Email or Web Address in Message
Within received messages, you can find a phone number, email or web address in the 
message text and use it to call, write, access a service or create a Contacts card.
From Messages menu:
1. Open Inbox or My folders.
2. Scroll to desired message and open. 
3. Press Options and select Find > Phone number, Email address, or Web 

address.
4. Text and numbers are highlighted when found. If more than one is found, scroll to 

highlight desired item.
5. Press  to Send a message, Add to Contacts to add or update Contacts, Call a 

number, Go to web address or Add to bookmarks to add web address to 
bookmarks.

Note: The phone may not allow you to copy, modify, transfer, or forward some copyrighted 
images, ringtones and other content.

Note: Received applications or games can be installed directly from the Inbox. When you open 
the message, the phone asks if you want to install it now.
An attachment or object remains in the Inbox after it is saved to another menu item. To 
save memory space, delete message from Inbox.
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DRAFTS
Your unfinished SMS, MMS, and email messages that have not been sent are stored 
in the Drafts folder.
From Messages menu:
1. Open Drafts.
2. Scroll to desired message and open.
3. Enter the rest of the information.
4. Press , or if desired press Options and select: 

SENT
SMS, MMS, smart, and email messages that have been successfully sent are stored 
in the Sent folder, which stores the last 15 sent messages.

Move Sent Messages to My Folders
From Messages menu:
1. Open Sent.
2. Scroll to desired message, then press Options and select Move to folder.
3. Select desired folder and press OK.

View or Delete Sent Messages
To view or delete sent messages and objects or attachments, from Messages menu:
1. Open Sent.
2. Scroll to desired message and open.

Send Send message.

Add recipient Send to more than one address.

Insert > Insert items such as Picture, Sound clip, Video clip, or 
Template, depending on what type of file the message type 
supports.

Attachments (Email)
Objects (MMS)

Open, insert, or remove attachments or objects.

Edit presentation  (MMS) Edit the presentation.

Preview 
message (MMS)

Preview message before sending.

Check contacts Match names in To and Cc fields to names in Contacts.

Message details View details such as message size.

Sending options View or change sending options depending on type of mes-
sage.
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3. Press Options and select: 

EMAIL INBOX
Email is received and stored in a separate mailbox. Once you set up a mailbox, Email 
Inbox will be renamed and appear with its new name in the main Messages list. Up to 
6 mailboxes can be set up; each appears separately in the main Messages list.

After your email is set up, use the mailbox to view and send email. Files such as 
pictures, sound and video clips can be attached from phone memory or miniSD Card. 
Supported email clients include a standard POP3, IMAP4, SMTP, MIME client. Email 
messaging takes place over CSD and GPRS bearerset using standard Internet email 
protocols over TCP/IP.

Configure Mailboxes
From Messages menu:
1. Press Options and select Settings.
2. Scroll to Email and open.
3. Highlight Mailboxes and open.
4. Press Options and select New mailbox.
5. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 

have an entry. 

Attachments (Email)
Objects (MMS)

Open, save, or send attachments or objects.

Delete Delete message, object or attachment.

Message details View details such as message size.

Note: Before you can send or retrieve email, you must first set up a mailbox.

Mailbox name Use default name or enter a name for your 
mailbox and press OK.

* Access point in use Default Access Point supplied by Vodafone.

* My email address Enter your own email address and press OK. May be supplied 
by Vodafone or Internet service provider.

* Outgoing mail server Enter SMTP mail server address.

Send message Choose During next conn. or Immediately.

Send copy to self Select Yes or No.

Include 
signature

Select Yes to enter a signature for outgoing 
messages.
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Select Mailbox Name to Use to Send Email
To select which mailbox to use to send email messages, see page 61.
If you have more than one mailbox and you start to write a new message, the phone 
notifies you of the mailbox name that is currently in use. To change the mailbox, see 
page 61 to change Mailbox in use setting.

Create a New Email Message
To create a new email message, see page 50.

Retrieve Email
You can view your mailbox either online or offline. When you are online, you see your 
messages stored on the remote server. When you are offline, you see messages 
retrieved from the remote server to your phone, or message headers if not yet 
retrieved. IMAP4 protocol allows you to retrieve messages without attachments, so 
large memory files can remain in your online mailbox and not be stored in the phone.
You can mark as read or delete messages, or copy them to another folder and view 
message details when offline. Your mailbox is synchronised to the server when you go 
online.
When you receive a new email message, a new message notice appears on the 
standby screen.

To connect to your mailbox, from Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Press Options and select Connect.

User name Enter a name to log into service provider remote mailbox.

Password Enter password. 

* Incoming mail server Enter address of incoming mail server (POP or IMAP), supplied 
by service provider.

Mailbox type Select POP3 or IMAP4.

Security Select Off or TLS (Transport Layer Security). TLS ensures pri-
vacy. Determined by Internet service provider.

APOP secure login 
(POP3 only)

Select On to use authenticated POP log in, encrypts password.

Retrieve attachment 
(IMAP4 only)

Select Yes or No to automatically retrieve 
attachment when message is fetched.

Retrieve 
headers (IMAP4 only)

Select All to retrieve all message headers, or select User 
defined and type in a number to retrieve only the latest head-
ers.
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3. Once you are connected, press Options and select Retrieve email > New, 
Selected, or All.
• To select certain messages, use Mark/Unmark action.

4. Once messages are retrieved, you can read them offline. Press Options and 
select Disconnect.

Read Messages Offline
From Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Press No when phone asks to connect to mailbox.
3. Scroll to desired message and open.

Reply to Email Messages
From Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Highlight desired message.
3. Press Options and select Reply > To sender or To all. 

Copy Email Messages
From Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Highlight desired message.
3. Press Options and select Copy to folder.
4. Choose from the appropriate folders and press OK.

Sort Message List
From Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Press Options and select Sort by > Date, Sender, or Subject.

Save Attachment or Data
You can save attachments, such as Contacts cards, Calendar items, links to streaming 
media, and configuration data.
1. Open desired message.
2. Press Options and select Attachments >      

Open Open attachment in read-only mode.

Save Save attachment.

Send Send attachment via Bluetooth® or via Infrared.

Note: Attachment cannot be opened, saved, or sent if it has not been retrieved.
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Add Email Address to Contacts Card
From Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Open desired message.
3. Press Options and select Add to Contacts > Create new to create a new 

Contacts card using the sender’s email address, or Update existing to place the 
sender’s email address in an existing Contacts card.

4. Continue with Create New Contact Cards on page 30 or Edit Contact Cards on 
page 31.

Manage Mailboxes
From Messages menu:
1. Select  Email Inbox (or renamed mailbox).
2. Press Options and select Settings.
3. Scroll to Email and open.
4. Highlight Mailboxes and open.
5. Scroll to desired mailbox name and press Options and select Edit or Delete.

MESSENGER
Chat with your friends and family using Vodafone Messenger. Chat, or Instant 
Messaging, allows you to exchange messages online with another party. Contact 
Vodafone for more information on this service.

CONNECT TO MESSENGER
From Messages menu:
1. Open Messenger.
2. Follow the screen prompts.

VOICEMAIL
Voicemail service stores voice messages from callers who could not reach you. The 
messages are stored on Vodafone’s network, not on your phone. You must first 
subscribe to voice mail from Vodafone before using this service.

Listen to Voicemail Messages
When you receive a new voicemail message, an alert sounds if ringtone is not set to 
silent, and the voicemail icon  displays.
1. Press and hold  in standby mode to dial your voicemail message centre.

• You can also press  and  in standby mode.
2. Follow the prompts to listen to your voicemail messages.
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If the phone asks for the voice mailbox number, enter the voicemail message centre 
phone number given to you by Vodafone.

To change the voice mailbox number, from Messages menu:
1. Open Voice mail.
2. Press Options and select Change number.

MY FOLDERS
Store your messages in My folders. You can also create and name new folders. For 
example, create a folder for Friends and one for Family messages. Folders can also 
be created by message type or by subject.
From Messages menu:
1. Open My folders.
2. Press Options and select New folder.
3. Enter a name for your folder and press OK. 

To rename or delete a folder, from Messages menu:
1. Open My folders.
2. Scroll to desired folder, press Options and select Rename folder or Delete.

Templates
Templates are short sentences in which you fill in the blank, then send the message. 
Template sentences can also be inserted into longer messages.
From Messages menu:
1. Open My folders.
2. Select Templates.
3. Scroll to desired text. Press Options and select Create message > Via SMS, Via 

MMS, or Via Email.
4. Press  and a new message opens with template text already placed. 
5. Fill in needed information and press .

To create your own template text, from Messages menu:
1. Open My folders.
2. Select Templates.
3. Press Options and select New template.
4. Enter text, numbers, or symbols, and press Done.

Note: You cannot create folders within a folder.

Note: In longer messages, at cursor, press Options and select Insert > Template. Template 
text is placed at cursor.
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MEDIA ALBUM
Store your personal pictures on your online photo album and share them with family 
and friends. You will need to register for this service. Contact Vodafone for more 
information or look on the Vodafone website for details. 

UPLOAD PICTURES
To upload pictures to Media Album, from Messages menu:
1. Open Media Album.
2. Follow the prompts to upload your pictures.
Pictures that have been sent successfully will appear as an MMS message in your 
Sent folder in Messages menu.

OUTBOX
Outbox stores messages waiting to be sent, and messages that could not be sent; for 
example, connection to the network failed. 

It also temporarily stores Bluetooth® and Infrared messages that are waiting for 
connection to the receiving device. If the connection fails, Outbox does not keep the 
message.

The Outbox icon  appears on the standby screen when there are messages in the 
Outbox.
Status of Outbox messages:

Send, View, and Manage Outbox Messages
From Messages menu:
1. Open Messages.
2. Scroll to Outbox and open.
3. Scroll to desired message. Press Options and select: 

Sending Connecting to network. Waiting Waiting to connect.

Queued Email waiting for connection. Resend at If sending failed, resend attempt.

Deferred Suspend sending to another time. Failed Sending has not been 
successful.

Defer sending Defer sending until you manually send.

Message details View details such as message size.

Send Send message now.

Move to Drafts Move message to Drafts folder, where it can be edited and resent.
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Messages waiting in the Outbox are automatically resent (except email set to send 
during next connection), depending on network availability.
To cancel resending, from Messages menu:
1. Scroll to Outbox and open.
2. Scroll to desired message. Press Options and select Delete.

DELIVERY REPORTS
Delivery reports for text, multimedia, and smart messages can be sent by Vodafone, 
and stored in the Delivery Reports folder. Delivery reports are not available for email 
messages.
From Messages menu:
1. Open Reports.
2. Press Options and select Settings. 
3. For SMS messages, open SMS, scroll to Receive report and select Yes. 

For MMS messages, open MMS, scroll to Receive report and select Yes.

MESSAGE SETTINGS
SMS Message Settings
From Messages menu:
1. Press Options and select Settings. 
2. Open SMS. Open fields as needed: 

Message 
centres 

Choose from provided list of network and SIM message centres.

Msg. centre in use Choose which message centre is used to deliver SMS messages.

Receive report Choose Yes or No. If Yes, delivery reports 
showing status of sent SMS messages are stored in Delivery 
Reports.

Message 
validity

Choose a time period from 1 hour to maximum in which SMS 
message delivery is attempted from the message centre.

Message sent as Choose Paging or Email if you wish to convert your SMS mes-
sage to one of those forms for sending. Available only if network 
can perform the conversion.

Preferred connection Choose GSM or GPRS connection.

Reply via same ctr. Select Yes to allow your SMS message recipients to use your 
SMS message centre to reply to you without having to subscribe 
to an SMS messaging service.
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MMS Message Settings
From Messages menu:
1. Press Options and select Settings. 
2. Open MMS. Open fields as needed: 

Email Message Settings
From Messages menu:
1. Press Options and select Settings. 
2. Open Email. Open fields as needed: 

Service Message Settings
From Messages menu:
1. Press Options and select Settings. 

* Access point in use Choose from list of access points. See page 108 to create and 
edit access points. 

Reception in home 
network

Choose Allow or Always ask for incoming messages.

Reception when 
roaming

Choose Allow, Always ask or Reject message for incoming 
messages.

Allow anon. 
messages

Select Yes to receive messages from anonymous (unknown) 
senders.

Receive adverts Select Yes to receive advertisements. 

Receive report Select Yes to receive delivery reports.

Deny report 
sending

Select Yes so that your phone will not send a delivery report to 
confirm receipt of a new 
message.

Message 
validity

Choose a time period for the message centre to attempt message 
delivery.

Image size Select Small (default) for 160x120 (max) picture size, or Large 
for 640x480 (max).

Default speaker Choose to play sound clips from Loudspeaker or Handset 
speaker.

Mailboxes View list of mailboxes you have set up.

Mailbox in use Select mailbox to use to send email.
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2. Open Service message. Open fields as needed: 

Cell Broadcast Message Settings
From Messages menu:
1. Press Options and select Settings. 
2. Open Cell broadcast. Open fields as needed: 

Other Message Settings
From Messages menu:
1. Press Options and select Settings. 
2. Open Other. Open fields as needed: 

SIM MESSAGES
To view, copy, or delete text messages stored on the SIM card, from Messages menu:
1. Press Options and select SIM messages. 
2. A list of messages stored on the SIM card appears. 
3. To view the messages, first copy them to the phone memory. Before copying 

multiple messages, use Mark/Unmark > Mark or Mark all to mark any or all 
desired messages to perform copying at one time. Press Options and select 
Copy.

4. Choose the desired folder to place the copy and press OK.
5. If desired, press Options and select Delete to delete messages from the SIM 

card. 

Service 
messages

Select On to receive service messages.

Download 
messages

Select Manually to allow only authorised senders to send service 
messages.

Reception Select On to receive cell broadcast messages.

Language Select All to receive cell broadcasts in all possible languages, or 
Selected to choose from a list, or Other if your preferred lan-
guage is not listed.

Topic detection Select On to view a list of topic indexes provided by the network.

Save sent 
messages

Select Yes to save sent messages to the Sent folder.

No. of saved msgs. Type in a number to set maximum amount of messages saved to 
Sent folder.
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CELL BROADCAST MESSAGES
Cell broadcast messages are sent by Vodafone to GSM customers in a certain area. 
They provide general information about topics such as weather reports, traffic news, 
and customer services. Available topic names and numbers are supplied by Vodafone.

From Messages menu:
1. Press Options and select Cell broadcast. 
2. Press Options and select: 

SERVICE COMMAND
Ask Vodafone to activate a particular service by sending a service command. These 
commands, which may be called USSD commands, can activate services such as 
mobile prepay and chat.

Contact Vodafone for the proper service command statement.

From Messages menu:
1. Press Options and select Service command.
2. Enter the service command, then press .      

Note: Leaving Cell broadcast set to On reduces battery life.

Open Open topic.

Subscribe or 
Unsubscribe

Subscribe to selected topic to receive related messages. Select 
Unsubscribe to stop receiving related messages.

Hotmark or 
Remove 
hotmark

When topic is hotmarked, you will receive a notice when related 
messages arrive.

Topic > Choose Add manually to type in a topic name or topic number or 
Delete all.

Settings See Cell Broadcast Message Settings on page 62 to turn on or off 
Cell broadcast reception, choose Cell broadcast language, and 
turn on or off topic detection.
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CAMERA
Take pictures and record video clips to send in an MMS or email message. Pictures 
and video clips can also be sent via infrared or Bluetooth®. Add pictures to your 
Contacts cards.
Camera menu contains these main options:

TAKE PICTURE

From Camera menu:
1. Open Picture.
2. With the flip open, the main display acts as a viewfinder. 

Move the phone around to frame your subject.
3. To snap the picture, press .

• The picture is automatically saved to Pictures folder. See 
My Items on page 69.

To send the picture immediately, press . Scroll to Via MMS, 
Via Email, Via Bluetooth, or Via Infrared. To complete MMS 
messages, see page 49; or Email messages on page 50; or Bluetooth® on page 120, 
or Infrared on page 118.

If you do not want to save it, either:
•  Press  and select Yes.
•  Press Options and select Delete.

Change Capture Modes
To choose different picture capture modes, scroll  to select: 
Standard regular size landscape pictures (640x480 pixels [VGA])
Portrait smaller pictures that use much less memory and can be placed in 

Contacts cards (80X96 pixels)
• Red number in upper right corner indicates the number of pictures that can fit in 

phone memory, depending on selected picture size.

Zoom
You can zoom in on your subject before taking a picture.
1. When viewing your subject in the viewfinder, press  once for 2x zoom, press  

again for 4x zoom. Press  to step back one zoom level.
2. Press  to snap the picture.

Picture Video PhotoLight

Note: Camera mode depletes battery power more rapidly. To conserve your battery, the phone 
shifts to camera standby mode after 1 minute if no keys are pressed.
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Self-timer
Set the camera to take a picture after setting the timer to delay the shutter.
1. From the viewfinder, press Options and select Self-timer > 10 seconds, 20 

seconds, or 30 seconds.
2. Move the phone around to frame your subject.
3. Press Activate to start the timer.

• The shutter sounds when the picture is taken.
• The picture is stored in My Items Pictures folder.

TAKE A SELF-PORTRAIT
From Camera menu:
1. Open Picture.
2. Close the phone flip. The external display acts as a viewfinder. Move the phone 

around to frame your subject.
3. Press Multibutton  on side of phone to snap the picture.
4. Open the flip. The picture appears on the main display. 

• The picture is automatically saved to My Items Pictures folder. To make 
changes to the picture, press Options and select Go to My Items. See My 
Items on page 69.

To send the picture immediately, see Send Pictures on page 66. 

If you do not want to save it, press Options and select Delete.

SAVE PICTURES
Pictures are automatically saved in the Pictures folder in My Items in Phone memory. 
You can also save pictures to a folder in DCIM folder in miniSD Card as DCF-Exif 
format (JPEG). To save pictures to the miniSD Card, from Camera menu:
1. Open Picture. Press Options and select Settings. 
2. Scroll to Memory in use and open.
3. Select NO NAME or the name assigned to your miniSD Card.

• All pictures are saved to the miniSD Card until this setting is changed to Phone 
memory, or miniSD Card is removed.

VIEW PICTURES
From Camera menu:
1. Open Picture.
2. Press Options and select Go to My Items. A list of pictures stored in phone 

memory displays. Scroll to desired picture and open.

Note: To rename your miniSD Card, see miniSD Card (Memory card) on page 127
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• Or to view pictures in miniSD Card, press Back, scroll  to miniSD Card tab. 
Scroll to desired picture and open.

NAME PICTURES
To change the name that is used as the default file name for new pictures, from 
Camera menu:
1. Open Picture.
2. Press Options and select Settings. 
3. Open Default image name and enter desired text.

• For example, if you change the image name to SkiTrip, then your pictures will 
be named SkiTrip, SkiTrip(001), SkiTrip(002), etc. until the default name is 
changed.

4. To rename an individual picture when you have taken a picture:
1 With saved picture on main display, press Options and select Rename image.
2 Enter a new name for the picture.

PICTURE QUALITY
To choose the compression level (memory size) of future pictures, from Camera 
menu:
1. Open Picture.
2. Press Options and select Settings.
3. Open Image quality.
4. Select High, Normal, or Basic. The higher image quality you choose, the larger 

the file size will be.

If you plan to view pictures on a computer, use High or Normal image quality so the 
quality will be better maintained when enlarged on a computer screen.

Basic image quality is best when the pictures will be viewed on phones and other small 
screens.

SEND PICTURES
Send the picture you just took to your family and friends.
1. With saved picture on main display, press , or press Options and select 

Create message > Via MMS, Via Email, Via Bluetooth, or Via Infrared. 
2. To complete MMS messages, see page 49; or Email messages on page 50; or 

Bluetooth® on page 120; or Infrared on page 118.

Note: All three levels are 640x480 pixels resolution (sharpness). 

Note: Email option will appear once you set up an Email Inbox in Messages menu.
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Send to Media Album
Send the picture you just took to your online Media Album.
1. With saved picture on main display, press Options and select Send to Media 

Album.
2. Follow the prompts to upload your picture to your online Media Album.

Add a Picture to Contact Card
To add a picture to a Contact card, see Edit Contact Cards on page 31.

Incoming Calls when in Camera Mode
If you receive a call while in camera mode, the phone temporarily suspends camera 
mode and switches to the incoming call display. Once you answer the call, the screen 
returns to Camera mode and a small active call icon displays. If a captured picture is 
on the preview screen, it is saved in My Items Pictures folder.

RECORD VIDEO
Record video clips to send to others, or play clips on your phone.

RECORD A VIDEO CLIP
To record nearby sound with the video, see Video Recorder Settings on page 68.
From Camera menu:
1. Open Video.
2. The main display acts as a viewfinder. Move the phone around to frame your 

subject.
3. Press Options and select Record to begin recording. Watch the screen, then 

move the phone as needed to keep the scene in view.
• Scroll  to zoom in; scroll  to zoom out if zoomed in.
• Press Pause to pause recording; press Resume to resume recording.

4. The video recorder records until reaching the clip size limit (specified in File 
Duration in Settings), or until you press Stop softkey. 

5. Wait for a few seconds while the video clip is saved to My Items Videos folder, or 
the miniSD Card according to Video storage setting. The last still picture of the 
recording remains on screen.

To send the video clip immediately, see Send a Video Clip on page 68. 

Note: Video Recorder mode depletes battery power more rapidly. To conserve your battery, the 
phone shifts to standby mode after 1 minute if recording has not started. Press Options 
and select Continue to return to viewfinder mode.  
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If you do not want to save it, press  and select Yes, or press Options and select 
Delete.

SEND A VIDEO CLIP
1. With the video clip on screen, press , or press Options and select Create 

message > Via MMS, Via Email, Via Bluetooth, or Via Infrared.
2. To complete MMS messages, see page 49; or Email messages on page 50; or 

Bluetooth® on page 120; or Infrared on page 118.

Play a Video Clip
To play the video clip that was just recorded, press Options and select Play.
To play a stored video clip, from Camera menu:
1. Open Video.
2. Press Options and select Video Album.
3. Continue with step 3 in  Play Video, Sound Clips, and Streaming Media on 

page 72.

VIDEO RECORDER SETTINGS
From Camera menu:
1. Open Video.
2. Press Options and select Settings.
3. Select from: 

Note: The quality of display images may vary depending on the object or environment.
Display images may distort when shooting moving objects, especially in a fast moving 
environment. 

Note: Email option will appear once you set up an Email Inbox in Messages menu. 

Resolution Choose the size of the display on the screen to be Low or High.

Audio recording Set to On to capture nearby sound as you record. Off turns off the 
microphone.

Video name 
base

Enter desired text. For example, if you change the name to SkiTrip, 
then your video clips will be named SkiTrip, SkiTrip(01), SkiTrip(02), 
etc. until the default name is changed.

Video storage Choose whether video clips are stored in phone memory or on miniSD 
Card.

File Duration Choose a fixed size for recorded clips, or 
unlimited size.

Video quality Choose Low or High. 
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Incoming Calls when in Video Recorder Mode
If you receive a call while in video recorder mode, video recording stops and the video 
clip is saved. After the call ends, the last picture of the recorded clip displays.

PHOTOLIGHT
Light up your subject before snapping a picture or recording 
a video clip. To switch on the PhotoLight, from Camera 
menu:
1. Scroll to PhotoLight and open.
2. To take a picture, scroll to Picture and continue with 

Take a Picture on page 64. To record a video clip, scroll 
to Record Video and continue with Record a Video Clip 
on page 67.

To switch off PhotoLight from Camera menu:
1. Open PhotoLight.
Unlike a camera flash, the PhotoLight does not flash. PhotoLight remains on until you 
switch it off.  

Use PhotoLight as a Flashlight
The PhotoLight can be switched on to use as a small flashlight.
1. In standby mode, press and hold . The PhotoLight switches on.

To switch off the PhotoLight, return to standby mode, then press and hold .

• Whether or not you close the flip, the PhotoLight remains on until you switch it off. 
• The PhotoLight also switches off when the phone is switched off.

Note: Do not use the Photolight near the eyes. The PhotoLight is intended as an auxiliary light 
source for shooting photos in dim areas. It does not produce the intense light of a typical 
camera flash.

Battery note: Keeping PhotoLight switched on consumes battery power more rapidly. To 
conserve battery power, switch off PhotoLight when not in use.

Indicator 
Light and 
Photolight
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MY ITEMS
Store, play, and manage your pictures, video clips, sound clips and streaming links 
(web addresses) in the phone memory or miniSD Card. Create messages with media 
files to send to friends and family via MMS, Email, Bluetooth®, or Infrared.
See Specifications on page 137 for supported media file formats.
My Items menu contains these main options:

VIEW PICTURES, SOUNDS, OR VIDEOS FOLDER
From My Items menu:
1. Phone icon tab shows data stored in phone memory, or scroll  to view data 

stored on miniSD Card.
2. Select from: 

VIEW PICTURES, ZOOM IN, AND SET AS WALLPAPER 
When an individual picture is open, you can zoom in/out, rotate and view pictures full 
screen, and do other actions as listed below.
From My Items menu:
1. Phone icon tab shows data stored in phone memory, or scroll  to view data 

stored on miniSD Card.
2. Open Pictures. 
3. Scroll to and open desired picture.
4. Press Options and select: 

Documents Pictures Sounds

Videos

Documents See File Manager on page 89 to view your Quickoffice documents.

Pictures Scroll to desired picture, or open Wallpapers folder to view wallpaper 
files. Open More 
Pictures to download more pictures. Contact Vodafone for availability 
of Picture msg. service.

Sounds Choose Digital sounds folder or Tones folder. Open More Ringtones 
to download more ringtones.

Videos Video clips. Open More Videos to download more videos.

Create 
message >

Create a message using the media file to send via MMS, Email, 
Bluetooth® or Infrared. See page 74.

Set as wallpaper Set picture as wallpaper in standby mode.

Rotate > Rotate picture Left or Right in 90 degree steps.
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Zoom, Rotate, and Panning Shortcuts
Zoom  zooms in;  zooms out;  zooms in; press again to activate full 

screen.

Pan  and  pan up;  and  pan down;  and  pan left;  and 
 pan right.

Rotate  rotates clockwise;  rotates counter clockwise.

Original Press and hold  to go back to original size view.

Full screen  switches between full screen view and original size view.
• If picture is not zoomed, scroll  to go to next picture in the current folder.

Zoom in / Zoom out Zoom in or out in steps from 12.5% to 800%.

Full screen Removes status bar and softkey text to see more of the picture.

Normal screen When viewing full screen, press , then select Normal 
screen to view status bar and softkey text. 

Rename Rename the picture.

View details View details such as file format and size, and 
picture creation time and date.

Add to 
Shortcuts

Add a shortcut to view picture from Shortcuts.
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PLAY VIDEO, SOUND CLIPS, AND STREAMING MEDIA
Watch video clips and listen to sound clips, or play streaming media. Streaming media 
is sound and video stored and played back as it arrives from the Internet or your 
network servers; thus the file is not stored on your phone, taking up valuable memory.
From My Items menu:
1. Phone icon tab shows data stored in phone memory, or scroll  to view data 

stored on miniSD Card.
2. Open Sounds or Videos.
3. Scroll to desired sound or video clip and open.

PLAYER CONTROLS
Video controls 

Sound controls 
To select buttons on screen, scroll  or  to move box to button and press : 

Volume control
Scroll  to increase volume; scroll  to decrease volume (note bar scale near top of 
screen).
To mute the sound in a video clip, scroll  until muted speaker icon  appears. To 
turn sound back on, scroll . When playing sound clips, the lowest volume setting is 
level 1. 

PICTURES, SOUNDS, AND VIDEOS OPTIONS
From My Items menu:

Note: For streaming media, after the phone successfully connects to the link (web address of 
streaming media), there is a short loading period to prepare playback, then the streaming 
media begins playing.

Play: Press Options and select Play. 

Stop: Press Stop softkey.

Pause: Press Pause softkey or press . To resume play, press  and select 
Continue, or press Options and select Continue.

Fast forward: Press and hold  on navigation key during play.

Fast rewind: Press and hold  on navigation key during play.

Play: Pause: Rewind:

Stop: Fast forward: Record:
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1. Phone icon tab shows data stored in phone memory, or scroll  to view data 
stored on miniSD Card.

2. Open Pictures, Sounds or Videos.
3. Open respective folder, then highlight desired file.
4. Press Options and select from these additional options:

Open Open clip or streaming media link. See Player Controls on 
page 72. For streaming media, the phone begins connection pro-
cess to the Internet or to your network.

Send to Media Album Send file to online Media Album. See page 59.

Create 
message >

Create a message using the media file to send via MMS, Email, 
Bluetooth® or Infrared. See page 74.

Set as Ringtone When a sound file is highlighted, you can set it as the ringtone for 
the current profile. 

Delete Delete highlighted item.

Create new > Create a new Picture, Sound clip, or Web address.

Move to folder Move file to Menu level or to Pictures, Sounds or Videos folder.

Export to miniSD >
(pictures only)

Copy or move file to miniSD Card. The file is copied or moved to 
the DCIM folder on the miniSD Card. The DCIM folder, which has 
a sub-folder, can be accessed by other devices such as TVs and 
printers. 
This command creates Exif under SD-Picture/DCF specification 
from any image format. This enables playback of pictures 
exported from X701 on SD enabled TVs and printers.

Copy to Copy file to phone memory or miniSD Card.

New folder Create a new folder within the current folder.

Mark/Unmark Mark multiple items. See page 26.

Rename Rename clip.

Download more... Go to download link for pictures, ringtones, or videos, or enter 
your own download web address.

Receive via 
infrared

Receive a file via infrared.

View details View clip details such as file format, size, 
resolution, and duration.

Add to 
Shortcuts

Add a shortcut to view or listen to clip from 
Shortcuts.
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CREATE MESSAGES WITH PICTURES, SOUND OR VIDEO 
CLIPS
From My Items menu:
1. Phone icon tab shows data stored in phone memory, or scroll  to view data 

stored on miniSD Card.
2. Open Pictures,  Sounds, or Videos. 
3. Open respective folder, then highlight desired file.
4. Press Options and select Create message > Via MMS, Via Email, Via Bluetooth 

or Via Infrared.
5. To complete MMS messages, see page 49; or Email messages on page 50; or 

Bluetooth® on page 120; or Infrared on page 118. 

Settings Adjust multimedia settings (see RealOne Player Settings on 
page 101).

Note: Receive via infrared feature may not be available.

Note: The Create message option is not available for streaming media.
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VODAFONE LIVE!
Browse Vodafone live! to find out what's new and download lots of fun stuff for your 
X701 phone.
Vodafone live! menu contains these main options:

VODAFONE LIVE!
Your phone has an internet browser allowing you access to services such as News, 
Weather reports, Sport and travel information, latest ringtones, great pictures and 
much more.

Wireless web sites are designed to be viewed on mobile phone screens, so they 
consist mostly of text and may contain simple graphics. Wireless sites are written in 
Wireless Markup Language (WML) and XHTML (Extensible Hypertext Markup 
Language), which is different than Hypertext Markup Language (HTML) used in 
computer Internet websites and cannot be accessed by wireless phones.

Your phone browser can access WAP 2.0 sites and download games, sound, 
software, WBMP pictures, vCard and vCalendar events and more.

SETUP TO CONNECT TO VODAFONE LIVE!
Before starting: (1) You need a subscription for data services from Vodafone, and (2) 
you must configure an Internet link. 
Vodafone has already completed the Internet link connection settings, which cannot be 
modified.

CONNECT TO VODAFONE LIVE!
There are two main ways to store shortcuts to wireless Internet sites. (1) Bookmark list 

 stores web addresses that you or Vodafone saved to the list. (2) Saved Pages list 
 stores actual WAP pages that you can view online or offline.

From Vodafone live! menu:
1. Open Vodafone live!

Vodafone live! Enter URL Bookmarks

What’s New Games Ringtones

Pictures Themes News

Sports Media Album

Shortcuts: Press  to launch Vodafone live!.
Scroll  in standby mode to launch Vodafone live!
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2. A list of Internet links and bookmarks appears, and folders may appear. Vodafone 
has loaded links to their services that appear as bookmarks. Scroll to the desired 
connection or bookmark and select.
• You can also scroll  for the Saved pages list , which stores WAP pages 

that you can view offline, and launch to refresh pages.
3. The phone begins connection process.

NAVIGATE IN VODAFONE LIVE!
In general, when connected to the Internet through Vodafone live!:  

Secure Connections
A secure connection means that the connection to transmit data between the phone 
and the network server has been secured and encrypted. Vodafone is responsible for 
securing the connection between the network server and Internet sites.

Ask Vodafone for details of their secure connection capabilities. Proceed with caution 
when downloading files and content or entering sensitive information.

Online Options
During an Internet connection, you can add and refresh bookmarks, reload pages, and 
view active session details.
Press Options and select:

Scroll up , down , left  or right  by pressing outer edges of navigation key through 
the page content.
Select a highlighted item or launch an underlined web page.
Press and hold to open Bookmarks list.
Erase character.

Back - Go backward in navigation history.
Close - Go to Bookmarks or Saved pages view.
Cancel - Ends current download.
Press and hold to disconnect Vodafone live! at any time.

Indicates secure online browsing connection.

Note: If you go to a site with many graphics, it may take longer for the pictures to load. To stop 
pictures from loading, see Show images setting on page 78.

Open Open highlighted link.

Accept Accept your text entry to the current page.

Service options > Open a list of commands or actions for the page.

Bookmarks View Bookmarks list.
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When online, you may have calling options from a current page. For example, you can 
click on a link to book tickets or order gifts. The link allows you to make a phone call 
directly from the browser. 

When viewing any Directory services an ‘Add to Contacts’ link may appear. Click on 
the link, and a new Contacts entry form displays. Save the entry to return to the 
browser.

Disconnect from Vodafone live!
To disconnect from Vodafone live!, either press and hold , or press Options and 
select Disconnect.

DOWNLOAD FILES FROM VODAFONE LIVE!
You can download ringtones, games, video and sound clips, and applications to your 
phone through Vodafone live!. After downloading, the files are saved to the relevant 
menu item in the phone.
From Vodafone live! menu:
1. Scroll to Games, Ringtones, Pictures, or Themes.
2. Scroll to desired bookmark if there is more than one, then open the bookmark. The 

phone begins connection process.
3. After connecting to the site, scroll to desired link containing the file and open.

Save as bookmark Save the web address to your Bookmarks.

View image If there are images on the page, open a list of images. To view a 
specific image, scroll to the image and press OK.

Navigation options > Go to web address, History to select a previously viewed page 
during current session, Clear cache to delete content in cache 
memory, Reload to update current page.

Advanced options > Original screen to fit page into the display of your phone, Save 
page to save current page to Saved pages list, Disconnect to 
end connection.

Show images Appears if you have set the Show images setting to No in the 
Vodafone live! settings to allow the images on current page to 
load.

Send bookmark > Send current page via SMS.

Find > Find phone number, email address or web address on current 
page. Start typing for Find field to appear.  

Details View details and security of current session.

Settings See Vodafone Live! Settings on page 78.

Service msg. Appears if you have unread WAP push messages.



78      

4. After the file is downloaded, it is stored in the menu item in which the file is opened; 
for example, a video clip is stored in My Items.

VODAFONE LIVE! SETTINGS
Check your default access point, specify if you want pictures to be automatically 
loaded, and allow cookies to be stored on the phone.
From Vodafone live! menu:
1. Open Bookmarks. 
2. Press Options and select Settings to reach: 

SAVED PAGES
Saved pages are web pages and folders you have stored on the phone to view offline. 
From Vodafone live! menu:
1. Open Bookmarks.  
2. Scroll  to open the Saved pages tab .
3. Scroll to the desired page and select.

Note: Panasonic is not responsible for the performance of downloaded content or possible 
corruption of phone software.
The phone may not allow you to copy, modify, transfer, or forward some copyrighted 
images, ringtones and other content.

Default access point Change default access point for connecting to the Internet.

Show images For faster Internet surfing, select No to stop pictures from auto-
matically loading. When online, press Options and select 
Show images on a specific page to load a picture.

Font size Select a font size for web page text to appear.

Default 
encoding

For the Browser pages to display text characters correctly, 
select one from: S. Chin., West. Europ., T. Chinese, Unicode 
(UTF-8), Central Eur., Baltic, Cyrillic, Greek, Turkish, Heb. (ISO-
Logical), Hebr. (ISO-Visual), Arabic (ISO), Arabic (Windows), 
Hebr. (Windows), Cent. Eur. (Wind.), Cyrillic (Windows), Greek 
(Windows), Turkish (Wind.), Baltic (Windows) or Automatic.

Cookies Choose Allow to store cookies, which are short text files that a 
web server places on your phone for purposes such as present-
ing customised web pages to you.

Security warnings Choose Show or Hide for secure site notification.

Conf. DTMF sending Select either First time only or Always before sending DTMF 
touch tones during a call when online.
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4. Press Options and select:

ENTER URL
From Vodafone live! menu:
1. Open Enter URL.
Then just type in the URL of the site you want to visit. You can always bookmark it later 
if you want to.

BOOKMARKS
Manage your bookmarks when offline or online.
From Vodafone live! menu:
1. Open Bookmarks.
2. Press Options and select:

Open View saved page or open folder.

Back to page Return to page you visited before opening Saved pages.

Reload Download and store the latest version of the saved page.

Saved pages mngr. > Move to folder to move a saved page to a different folder, New 
folder, Rename or Delete.

Mark/Unmark > Select Mark or Mark all to perform actions to multiple items.

Navigation options > Clear cache to delete content in cache memory.

Advanced options > Add to Shortcuts to create shortcut to page from Shortcuts 
menu.

Settings See Vodafone Live! Settings on page 78.

Download Connect to selected bookmark.

Bookmark 
manager >

Move to folder, New folder, Edit bookmark, Add bookmark, 
Delete.

Mark/Unmark > Select Mark or Mark all to perform actions to multiple items.

Navigation options > Go to web address or Clear cache.

Advanced options > Add to Shortcuts to add the bookmark to your Shortcuts.

Create message > Send web address to another device.

Find bookmark Type in one or two characters to go to bookmark titles beginning 
with that character.

Settings See Vodafone Live! Settings on page 78.
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WHAT’S NEW
From Vodafone live! menu:
1. Open What’s New.

Keep up to date with all the new content and services on Vodafone live! Be the first to 
know all about exciting new offers and free trials.

GAMES
From Vodafone live! menu:
1. Open Games.

Make the most of your free time with a great selection of games from old favourites to 
exciting new challenges.

RINGTONES
From Vodafone live! menu:
1. Open Ringtones.

All the latest music sounds to download to your phone. Choose from Chart hits, 
soundtracks, and many more.

PICTURES
From Vodafone live! menu:
1. Open Pictures.

Great choice of pictures to set as background wallpaper or for sending as MMS picture 
messages.

THEMES
From Vodafone live! menu:
1. Open Themes.

Personalise your phone with a different theme to make it look unique and exciting!

NEWS
From Vodafone live! menu:
1. Open News.

All the latest in national, financial and showbiz news. Get daily alerts sent to you.
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SPORTS
From Vodafone live! menu:
1. Open Sports.

For informative news and coverage, visit the Sports category for all your favourite 
Sports.

MEDIA ALBUM
From Vodafone live! menu:
1. Open Media Album.

Your own online storage area to create your own photo albums and share them with 
friends and family. You can also create and send picture messages.
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APPLICATIONS
Take care of a variety of tasks in one place. Install Java™ MIDlet (Mobile Information 
Device) applications using App Mgr. Use the Calculator to make quick calculations. 
Use the Converter to convert currencies and measurements. Record short voice clips 
using Recorder. See your files in one place using File Mgr. 
Applications menu contains these main options:

SIM TOOL APPLICATION
The SIM Tool Application allows applications existing on the SIM card to interact and 
operate with your phone. These applications, stored in the SIM memory, are Value 
Added Services. 
Vodafone can configure your SIM card with applications that can be seen on your 
phone as additional menu items.
Contact Vodafone for further information.

POSTCARDS
Send a picture and a note via MMS, then Vodafone will have it printed into a real 
postcard and have it delivered to a postal address. Some Vodafone networks allow 
delivery to foreign countries. 

SEND A POSTCARD
From Applications menu:
1. Open Postcards.
2. To take a new picture, select Take Picture. 

• To send an existing picture, select Select Picture. Scroll to desired picture 
located in My Items in the phone memory or on the miniSD Card, press 
Options and select Select Picture.

3. If you are taking a new picture, the Camera will open. Take the picture. 
• If you want to take a different picture, press Options and select Take New 

Picture to clear the current picture and open the Camera again.

SIM Tool Application (optional) Postcards App. Mgr.

Calculator Converter Recorder

File Mgr. Quickoffice PhotoBase

Voice Cmd. RealOne Shortcuts

Note: Postcard service is not available in all Vodafone networks.
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4. To keep the picture and continue by entering your message, press Options and 
select Enter Text. 

5. Write your desired text note. 
• If you want to write a different note, press Options and select Clear Text.

6. When you are ready to address the postcard, press Options and select Enter 
Address.

7. Fill in all the fields, such as Name, Street & Number, and Postal Code.
8. To send the postcard, press Options and select Send. It is sent as an MMS 

message to Vodafone to be printed and mailed to your addressee.

POSTCARD DRAFTS
The Drafts menu item keeps your Postcards that are not yet sent.
To edit a draft, from Applications menu:
1. Open Postcards.
2. Open Drafts.
3. Highlight desired draft. Press Options and select Edit. The current details will be 

shown.
4. Press Options and select: 

SENT POSTCARDS
To view and forward previously sent postcards, from Applications menu:
1. Open Postcards.
2. Open Sent Postcards.
3. Highlight the desired postcard.
4. Press Options and select: 

5. To continue with an open postcard, press Options and select:  

Enter Text / Edit Text Change the current text.

Edit Address Change the destination address.

Replace Picture Change the current picture.

Open Open the postcard to forward it.

Move to Drafts Move the postcard to Drafts to edit it.

Forward Forward postcard to another address.

Resend Resend the postcard.

Move to Drafts Move the postcard to Drafts to edit it.
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MY CONTACTS
View and manage your Contacts List from here.
From Applications menu:
1. Open Postcards.
2. Open My Contacts. The Contacts List contained in your phone appears.
3. Contact cards containing postal addresses display with an icon.
4. Press Options and select: 

APPLICATION MANAGER
The Application Manager allows you to install and manage both Java™ MIDlet (Mobile 
Information Device) applications and device software installation files. Examples 
include games, secure information storage, and compression software. You can also 
view and manage Authority and Personal certificates (see Certificate Management on  
page 113).

View Details of Application
From Applications menu:
1. Open App. Mgr..
2. Scroll to desired application installation file.

• Files with extension .sis are device software installation files. Files with 
extensions .jad or .jar are Java™ applications.

3. Press Options and select View details.
• A list displays with details such as name, version, type, certificate and signature 

details, trust status for MIDlets, application size, application supplier.

View Certificate
From Applications menu:
1. Open App. Mgr..
2. Scroll to desired application installation file.
3. Press Options and select View certificate.

• A list displays with details such as issuer, subject, validity period, serial number, 
and fingerprint.

See Certificate Management on page 113.

Open Open the Contact card.

Create
Postcards >

Choose Take Picture to take a new picture or Select Picture to use an 
existing picture. 
Continue with Send a Postcard on page 82. 

New Create a new Contact card.
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Install Application or Software
Your phone supports installation of software and applications suitable for the 
Symbian™ operating system. Because these files are usually large and compressed, 
be sure to reserve enough time and phone memory for the entire installation 
procedure.
From Applications menu:
1. Open App. Mgr..
2. Scroll to desired application installation file.
3. Press Options and select Install.

If there is no digital signature or certificate attached to the software or application, the 
phone issues warnings of the risks of installing without verifying the source. You 
should only install software or applications from sources that you have personally 
verified and of which you are absolutely sure.

You will see messages asking if you wish to continue or cancel during different phases 
of the installation process.

If the installation process is cancelled for some reason, such as the phone runs out of 
memory, then the installation is not complete, or only partial. To complete the partial 
installation, either delete the partially installed application, or reinstall the application.

If there are problems with installation, you can view the installation log or send the 
installation log to a help desk for troubleshooting. Press Options and select View log 
or Send log.

Remove Application or Software
From Applications menu:
1. Open App. Mgr..
2. Scroll to desired application installation file.
3. Press Options and select Remove.

CALCULATOR
Perform simple mathematic calculations using the calculator.
From Applications menu:
1. Open Calculator.

Note: Panasonic is not responsible for the performance of downloaded content or possible 
corruption of phone software.

Note: Removing a software application may cause you not to be able to view documents 
created with that software, and other software may not work if it relies on the removed 
software.
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2. A virtual calculator displays. Type in first number of 
calculation, which appears in field near bottom of screen. 
• To enter a decimal, press .
• To erase digits, press .
• To change number to positive or negative, scroll to 

positive/negative button and select.
3. Scroll  or  to move box to desired mathematic action, 

press  to select.
4. Enter the next number. To get result, scroll to equal button 

and select.
• To view the last result, press Options and select Last result.

The left side of the screen serves as a ‘tape’ to record your calculations. Use the 
double up and double down arrow buttons on the screen to scroll up and down the 
‘tape’.

To save a number in calculator memory, select the MS (Memory Save) button. To 
recall the number, select the MR (Memory Recall) button.

CONVERTER
Convert a variety of measurements such as world currencies, area, length, volume, 
temperature, power, and velocity.

Set the Base Currency
From Applications menu:
1. Open Converter.
2. If the Type field is not set to Currency, open and change to Currency.
3. Press Options and select Currency rates. A list of world currencies (3 letter 

currency codes) appears with the base currency (if set) noted at the top of the 
screen.
• Most commonly used codes are listed first. They are 

USD = U.S. dollar, EUR = European Union euro, GBP = British pound sterling, 
JPY = Japanese yen.

4. Scroll to the desired currency code you wish to set as the base, press Options and 
select Set as base curr..
• Any rates entered earlier are reset to zero.

5. Scroll to desired currency codes and type in currency exchange rates, based on 
your newly set base currency = 1.

Shortcut: To automatically add, subtract, multiply, or divide, enter first number. Press  until 
you reach desired numeric operation; stop pressing , and the operation is 
inserted.
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• To enter a decimal, press .
6. Press Done.
7. Continue with step 3 in Convert Measurements on page 87.

Convert Measurements
From Applications menu:
1. Open Converter.
2. Open the Type field, scroll to desired measurement type and press OK.
3. Scroll to first Unit field, press Options and select Select unit.

• If converting Currency, press Options and select Change 
currency.

4. Scroll to the desired unit to convert FROM, and press OK.
5. Scroll to second Unit field, press Options and select Select 

unit. 
• If converting currency, press Options and select Change 

currency.
6. Scroll to the desired unit to convert TO, and press OK.
7. Scroll to the first Amount field; press  to erase zero. Type in desired unit 

amount to convert. 
• To enter a decimal, press .
• To enter + and - (for temperature) and E (exponent) symbols, press .
Converted amount automatically displays in second Amount field.

RECORDER
Record voice memos up to 1 minute in length. You can also record a two-way phone 
conversation. Recorded sound clips are stored in .amr format.

Record a Sound Clip
From Applications menu:
1. Open Recorder.
2. Press Options and select Record sound clip.
3. Begin speaking into microphone. Press Stop to stop recording.

• Seconds counter bar near bottom of screen and Length counter both keep track 
of seconds elapsed.

Note: To edit the currency rates, press Options and select Currency rates.

Note: You can also convert amounts in reverse. 
Type in amount in second field; converted amount automatically displays in first field.
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4. To rename the sound clip to find it in the list, press Options and select Rename 
sound clip.

Play Back a Sound Clip
If sound clip was just recorded, go to step 4. Or, from Applications menu:
1. Open Recorder.
2. Press Options and select Go to My Items.
3. Open desired folder, then scroll to desired sound clip and open.
4. Select on screen Play button.

• Volume control - Scroll  to adjust volume. Note speaker icon and volume 
steps in upper part of screen.

• To select buttons on screen, scroll  or  to move box to button and press : 

To play a sound clip during a call, open the sound clip from its current location and 
play. The other person hears the audio clip.

Record a Conversation

1. During a phone conversation, press  and follow steps 1 to 3 in Record a 
Sound Clip on page 87.

2. The conversation records.
3. Press Stop to stop recording.

Send a Sound Clip
If sound clip was just recorded, go to step 4. Or, from Applications menu:
1. Open Recorder.
2. Press Options and select Go to My Items.
3. Open desired folder, then scroll to desired sound clip.
4. Press Options and select Create message > Via MMS, Via Email, Via Bluetooth 

or Via Infrared.
5. To complete MMS messages, see page 49; or E-mail messages on page 50; or 

Bluetooth® on page 120; or Infrared on page 118.

Recorder Settings
From Applications menu:
1. Open Recorder.

Play: Pause: Rewind:

Stop: Fast forward: Record:

Caution:  You are responsible for the security of a recorded message. Ask for the other party’s 
consent before recording, and abide by local voice recording laws.
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2. Press Options and select Settings. Scroll to:  

Use Recording as a Ringing Tone
To use a recording as a ringing tone, record a sound clip as described in Record a 
Sound Clip on page 87.

The new sound clip automatically appears in the Ringing tone lists in the Ringtones, 
Contacts, Clock, and Calendar alarm menu items. See Profiles on page 104; Assign a 
Ringing Tone on page 32; and Set Alarms on page 44 to assign ringing tones.

FILE MANAGER
Organise and manage files stored in the phone memory and on the miniSD Card. It's 
an easy way to find files and folders.

View Folders and Files
From Applications menu:
1. Open File Mgr..
2. A list of folders and files stored in the phone memory appears. 

Some folders may have sub folders, for example, Pictures 
folder has two sub folders - Picture msgs. and Wallpapers. 
Files that have not been stored in a folder are listed after the 
folder names.
• Scroll  to view folders and files stored on the miniSD 

Card.
3. Scroll to desired folder or file and open.

Find Folders and Files
Type letters or keywords in a search box  to find a folder or file.
From Applications menu:
1. Open File Mgr..
2. Press Options and select Find.
3. Choose to look in the phone memory or miniSD Card.
4. Type in the keyword to find, or just type in a few letters, and press Find.
5. After a brief period of searching, a list of files and folders containing the keyword 

displays.
6. The list is sorted from closest match first to farthest match last. Folders and files 

with the same name appear with folder before file.

Memory in use Store recordings in phone memory or miniSD Card.

Default speaker Choose Loudspeaker or Handset.
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Manage Folders and Files
From Applications menu:
1. Open File Mgr..
2. Press Options and select:

Send Files
From Applications menu:
1. Open File Mgr..
2. Open desired folder, then open file.
3. Press Options and select Create message > Via MMS, Via Email, Via 

Bluetooth, or Via Infrared.
4. To complete MMS messages, see page 49; or email messages on page 50; or 

Bluetooth® on page 120; or Infrared on page 118.

Open Open the selected folder or file.

Delete Delete the selected folder or file.

Move to folder Move selected item to another folder.

Copy to folder Copy selected item to another folder, leaving the original in its 
current place.

New folder Create a new folder.

Mark/Unmark Mark or unmark several files at once. Not available for folders.

Rename Change name of item. Default folders cannot be renamed.

Receive via infrared To receive a file via infrared, see page 73.

View details View name, format type, date and time modified, size in bytes or 
kilobytes (if item is a folder, size is total of all files and folders 
inside the folder), whether it is a default folder, amount of sub 
folders, and amount of files.

Memory details View number of bytes stored in separate menus such as Calen-
dar or Messages. Also view total memory in use and free mem-
ory. View phone memory on phone memory tab, or scroll  for 
miniSD Card memory.

Note: The phone may not allow you to copy, modify, transfer, or forward some copyrighted 
images, ringtones and other content.
Send message is not available if a folder or playlist is highlighted.
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QUICKOFFICE
Store your Microsoft® Word, Excel, and PowerPoint® documents on your phone. Edit 
them right on the phone, then beam or send the new documents to another device, or 
save them to the miniSD Card.

VIEW DOCUMENTS
From Applications menu:
1. Open Quickoffice.
2. Scroll  to Quickword, Quicksheet, or Quickpoint documents tabs.
3. A list of documents in phone memory appears.
4. Press Options and select:

VIEW MICROSOFT® WORD DOCUMENTS
Documents open in read-only full screen view. You must press Options and select 
Edit mode to make edits to a document.

Scroll  to move one line at a time or scroll  to move one page at a time.

Go to shortcuts (percentage through the document):  Press  for  20%,  for 
30%, etc.,  to go to beginning.

Note: For customer support and more information on Quickoffice, visit www.quickoffice.com.

Open Open highlighted file.

New Create a new document.

Browse Select the memory to browse. Open folders as needed to view 
documents.

File 
management > 

Sort files to sort by name, size, date or ext., or Scan location to 
Scan default, Scan mail, or Scan all.

Refresh Refresh the list view.

Properties View details of highlighted file.

Send as Send file Via MMS, Via Email, Via Bluetooth, Via Infrared.

Delete Delete highlighted file.

About product View copyright information about the software.

EULA View software license agreement.

Note: You can also view and move your documents from File Manager (see page 89).
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Press Options and select: 

EDIT MICROSOFT® WORD DOCUMENTS
1. From an open document, press Options and select Edit mode.
2. Save the document with a new file name.
3. Scroll through the document using:

 - move down one line.   - move up one line.
 - move left one space.   - move right one space.

To highlight text to apply a format, press and hold , then scroll  or . The text 
will highlight. For more text editing options, see Entering Text on page 23.

Press Options and select:   

 

Edit mode Go to Edit mode.

Search > Choose Find, Find Next or Replace. Enter text to be located in Find field. 
In other fields, scroll  to choose a search range. Then press Find.

Goto > To go to desired place in the document, choose Top, Percent, or Bottom.

Zoom > Zoom out, Zoom 100%, or Zoom in document by desired amount.

Autoscroll Automatically scroll document line by line. Scroll  to increase speed, 
scroll  to decrease speed.

Print Print document by sending it via Multimedia, Bluetooth® or infrared.

View mode Go to View mode.

Font Choose a font name and size to apply to highlighted text.

Style > Choose bold, italic, or underline to apply to highlighted text.

Alignment > Choose left, centre, or right alignment to apply to highlighted text.

Colour Choose a colour to apply to highlighted text.

Bullet Apply bullet to highlighted text.

Search > Choose Find, Find Next or Replace. Enter text to be located in Find 
field. In other fields, scroll  to choose a search range. Then press 
Find.

Print Print document by sending it via Multimedia, Bluetooth® or infrared.

Note: Tables, pictures or embedded objects in Microsoft® Word documents cannot be 
displayed on the phone.
If a file containing tables, pictures or embedded objects is edited and saved on the 
phone, then the non-text material may not be saved.
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VIEW MICROSOFT® EXCEL DOCUMENTS
Documents open in read-only full screen view.
Scroll through the document using:

 - move down one cell.   - move up one cell.
 - move left one cell.   - move right one cell.
 - toggle between view mode and edit mode.

Press Options and select: 

EDIT MICROSOFT® EXCEL DOCUMENTS
Documents open in read-only full screen view.

 - toggle between view mode and edit mode.

In edit mode:
 - move cursor left within a cell.  - move cursor right within a cell.

To select cells, press and hold , then scroll , ,  or .

Press Options and select:   

Edit Cell Edit highlighted cell.

Worksheets > Select, insert, rename or delete worksheets.

Toggle Full Screen Toggle between full screen and reduced screen.

Zoom > Choose a size to zoom document.

Freeze > Freeze Row, Column or Both for the highlighted cell.

Adjust Column 
Width

Scroll  to adjust column width.

Clipboard > Choose Cut, Copy, Paste or Select All to apply to highlighted cells.

Search > Choose Find, Find Next or Replace. Enter text to be located in 
Find field. In other fields, scroll  to choose a search range. Then 
press Find.

Properties Set cursor movement after entry and toggle 
auto-recalculations.

Print Print document by sending it via Multimedia, Bluetooth® or infrared.

Accept Text Edit Enter the edit.

Revert Text Edit Revert to previous cell content.

Operators > Choose from list of math operators and commonly used symbols.

Functions > Choose from list of spreadsheet functions.
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VIEW MICROSOFT® POWERPOINT® DOCUMENTS
Documents open in outline view.
Scroll  to move between outline, notes, slide, and thumbnail views.

Navigation Shortcuts

Range Select Select a range of cells by highlighting.

Formatting > Choose from list of formatting.

Alignment > Choose Default, Left, Center or Right to apply to highlighted 
cells.

Font > Apply Bold or Underline font style.

Color > Apply colour to Font or Cell.

Style > Choose from list of text and number styles.

Clipboard > Choose Undo, Cut, Copy, Paste or Select All to apply to 
highlighted cells.

Clear > Clears highlighted cell formatting, formula content, or both.

Print Print document by sending it via Multimedia, Bluetooth® or 
infrared.

Note: Macros, pictures, graphs or embedded objects in Microsoft® Excel documents cannot be 
displayed on the phone.
If a file containing macros, pictures, graphs or embedded objects is edited and saved on 
the phone, then the non-text material may not be saved.

View Action Keypress

Outline, Notes, Slide Toggle between full screen and partial screen.

Slide view full screen Zoom out.
Zoom in.
Fit to screen.

Outline, Notes, Slide Previous slide.
Next slide.

 or 
 or 

Thumb
(4 slides per page)

Page up.
Page down.
Next slide.
Previous slide.
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Options Menu
The Options menu varies in an open PowerPoint® document, depending on which of 
the 4 views you are using. 
Press Options and select:   

PHOTOBASE
Take pictures, then show them to your friends in a slide show right from your phone. 
Remove red eye, crop, rotate, or change brightness and contrast of your pictures 
before sharing them. You can also add frames, clip art, and text to your pictures. 

TAKE A PICTURE USING PHOTOBASE
From Applications menu:
1. Open PhotoBase.

Outline Collapse slide.
Expand slide.
Collapse all.
Expand all.
Edit slide.

Toggle Screen Toggle screen in outline, notes, and slide view.

Edit In outline view, you can edit the entry, insert and delete slides. In notes 
view, you can edit the entry.

Outline > In outline view, expand and collapse one or all slides.

Navigate > In all views, move to next or previous page or slide.

Goto > Go to another view.

Pitch Start or stop pitch device.

Print In outline or notes view, print document by sending it via Multimedia, 
Bluetooth® or infrared.

Exit > In thumb view, choose Close and save, Close and save as, or Close 
and discard.

Note: Animation, multimedia, or embedded objects in Microsoft® PowerPoint® documents 
cannot be displayed on the phone.
If a file containing animation, multimedia, or embedded objects is edited and saved on 
the phone, then the non-text material may not be saved.

Note: For customer support and more information on PhotoBase, visit www.arcsoft.com.

View Action Keypress
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2. Open Camera. 
3. With the flip open, the main display acts as a viewfinder. Move the phone around to 

frame your subject.
4. Press , or press Options and select Snap to take a picture.
The picture appears on the display.
To keep the picture in your album, press Keep. 
To delete the picture, press Discard.

Before Taking a Picture
To change the zoom, scroll  or . To change contrast and brightness, scroll  or . 

Before taking a picture, if desired, press Options and select:

VIEW PHOTOS
From Applications menu:
1. Open PhotoBase.
2. Open Album. 
3. Scroll to desired photo and open.

• To zoom in or out, press Options and select Zoom In or Zoom Out. Scroll , 
, , or  to pan in zoomed pictures.

• Scroll  to view previous photo; scroll  to view next photo.

Slide Show
To see a slide show of the photos in your Pictures folder, from Applications menu:
1. Open PhotoBase.
2. Open Album. 
3. Press Options and select Slide show.
4. Select a time interval between slides, and select a transition effect, for example, 

Top to Bottom, to apply as each slide advances to the next.
5. Press Play. 
6. Press  to exit.

Mode > Choose Frame to add a frame to the picture. 
Horizontal Panorama and Vertical Panorama allow you to stitch 3 
pictures together.

Picture folder > Choose the memory to store your pictures. 
Customise allows you to create a new folder. 

Settings Configure camera settings.

Go to Album Go to your Album.
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EDIT PHOTOS
From Applications menu:
1. Open PhotoBase.
2. Open Album. 
3. Scroll to highlight desired photo and open.
4. Press Options and select Edit.
5. Press Options and select:

Crop Photos
1. With opened photo on screen, press Options and select Edit.
2. Press Options and select Crop.
3. A dotted cropping box appears. Press  to resize the cropping box. Scroll  to 

make the cropping box taller, scroll  to shorten the box. Scroll  to widen the 
box, scroll  to narrow the box.

4. To move the cropping box within the photo, press Options and select Move. Scroll 
as desired to move the cropping box.
• If you have moved the box, select Resize to adjust the box size again.

5. To apply the crop, press Options and select Crop it.
6. To save the cropped photo as a new photo, press Options and select Save as. 

Enter a name for the new photo.

ADD CLIP ART, FRAMES TO PHOTOS
1. With opened photo on screen, scroll  to go to Workshop screen.
2. Select Clip Art to add clip art or Frame to add frames.
3. Scroll to desired clip art or frame and select.

Save Save edited photo in place of original photo.

Save as Enter a new name for edited photo and save as a new file.

Create message > Send photo via Email, Bluetooth, Infrared, 
or MMS (multimedia).

Rotate left Rotate photo to left.

Rotate right Rotate photo to right.

Brightness &
Contrast

Scroll  or  to adjust brightness, 
scroll  or  to adjust contrast.

Remove red eye Removes red eye from the photo.

Crop See Crop Photos on page 97.

Resize Resize photo by 200% or by 50%.
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4. Once the clip art or frame appears on the photo, press Options and select:

5. Press Options and select Create message for sending options.

Warp Photos
1. With opened photo on screen, scroll  to go to Workshop screen.
2. Select Warp.
3. A black crosshair mark appears on the photo. Scroll , ,  or  to desired spot 

where the warp will start. Press  to change the mark to red, then scroll in 
direction you want the warp to go.
• To add more warp points, press  as needed to toggle the mark between black 

and red.
4. Press Options and select Save, Save as, or Create message for desired option.

Add Text to Photos
1. With opened photo on screen, scroll  twice to go to Add Text tab.
2. Press Options and select Add new line. Enter text as desired. To edit text, press 

Options and select Edit current line, Delete current line, Change text colour, 
Change text size, or Edit previous/next line.

3. Press Options and select Save, Save as, or Create message for desired option.

Community
If available, Community will link to a website to download more clip art and frames, and 
provide more information from PhotoBase.
From Applications menu:
1. Open PhotoBase.
2. Open Community. Follow the prompts.

VOICE COMMANDS
Press and hold , say “Voice Dial”, then say a name in your Contacts list and the 
phone will dial the number. Press and hold , then say “open Messages” or “open 
Camera” and your phone will go directly to the menu.

Move Scroll , ,  or .

Resize Scroll ,  to increase, ,  to decrease.

Rotate Scroll ,  to rotate left, ,  to rotate right.

Note: If your phone is set to a language that is not available in Voice Commands, you can 
record voice tags to say that will dial numbers. See Voice Tags on page 100.
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START VOICE COMMANDS
1. Press and hold . 

• Or from Applications menu, open Voice Cmd..
2. You will hear the prompt to “Say a command”.
3. Say one of the choices listed on the phone that you wish to use: Voice Dial, Name 

Lookup or Open (menu item).

VOICE DIAL
Dial by Name
To dial by saying the name of the person you wish to call: 
1. Press and hold . 
2. After the prompt to “Say a command”, say “Voice Dial”.
3. After the prompt to “Say the name or number”, say the full name of a person in 

your Contact list, including first name and last name.
4. The name is repeated, and the phone will begin dialling.

• If the name has more than one number in the Contact entry, say the title of the 
desired number.

Dial by Number
To dial by saying the phone number: 
1. After the prompt to “Say the name or number”, say the digits of the phone number 

you wish to dial, without pausing between digits.
2. If the phone recognises the number, it is repeated and the phone will begin dialling.

If the phone is not sure of the number, it displays a list of choices and prompts “did you 
say...?” and states the first choice.
• If the number is correct, say “Yes”. If the number is not correct, say “No” to hear the 

next possible match, or scroll and select the correct number on the list.

NAME LOOKUP
Look up the Contact information for a person in your Contact list, without automatically 
dialling the phone number.
1. Press and hold . 
2. After the prompt to “Say a command”, say “Name Lookup”.
3. After the prompt to “Say the name”, say the full name of a person in your Contact 

list, including first name and last name.
4. The Contact entry appears on the screen.

OPEN MENU ITEM
Open a menu item by saying “Open”, then say the name of the desired menu item.
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1. Press and hold . 
2. After the prompt to “Say a command”, say “Open”, then say the name of the menu 

item, for example, “Messages”.
3. The menu item opens.

See Voice Command Settings on page 129 to choose menus to open.

VOICE TAGS
When your phone is set to a language that is not available in Voice Commands, Voice 
Tags allows you to record names and related phone numbers and store them in 
memory. Then you can dial these numbers using Voice Commands.

Record Voice Tags
1. Press and hold . 

• If you are using this feature for the first time, the phone displays a message that 
no voice tags are recorded.

2. Select Add voice tag.
3. After the text prompt to say a name, say a name that you will say each time you 

wish to call this person.
4. The phone will repeat the name. Press Yes to confirm, or press No to record it 

again.
5. After you have confirmed, enter the number to dial by pressing  to , then 

press OK.

Dial a Number using a Voice Tag
1. Press and hold . 
2. After the text prompt asking who you would like to call, say a name of a voice tag 

you have recorded.
3. The phone will begin dialling the number assigned to the voice tag.

Add or Edit Voice Tags
You can store up to 30 voice tags, and edit or erase voice tags as needed.
To add a voice tag:
1. Press and hold . 
2. Press Settings.
3. A list of voice tag phone numbers displays.
4. Select Add voice tag.
5. Continue with step 3 in Record Voice Tags 100.

Note: Voice Tags appears only when your phone is set to a language that is not available in 
Voice Commands.
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To edit a voice tag:
1. Press and hold . 
2. Press Settings.
3. A list of voice tag phone numbers displays.
4. Highlight and select desired voice tag phone number to edit.
5. Choose from: Play, Re-record, Erase, or Erase all.

REALONE PLAYER
RealOne Player is a media player that plays your video clips, sound clips and 
streaming media links (web addresses) stored in the phone memory or miniSD Card. 
Video and sound clips attached to messages are automatically played by RealOne 
Player, without having to open the player first. Opening clips from My Items, File 
Manager, Vodafone live! and Shortcuts menus launches the RealOne Player.

See Specifications on page 137 for supported media file formats.

PLAY VIDEO CLIPS AND STREAMING MEDIA
From Applications menu:
1. Open RealOne.
2. Press Options and select Open > Most recent clips for the last several opened 

media files, or Saved clip to locate existing files and links in the phone memory or 
miniSD Card.

3. Open desired folder(s), then scroll to and open desired video or sound clip. When 
choosing a link to streaming media, the phone begins connecting to the Internet or 
to your network.
• See Player Controls on page 72.

REALONE PLAYER SETTINGS
View and adjust settings for video playback and streaming media links.
From Applications menu:
1. Open RealOne.
2. Press Options and select Settings. 
3. Highlight Video and open.
4. Select from: 

Note: For streaming media, after the phone successfully connects to the link, there is a short 
loading period to prepare playback, then the streaming media begins playing. See Player 
Controls on page 72.

Contrast Open, then scroll  or  to change the percentage.

Repeat Select On to repeat playback, or select Off to playback one time.



102      

To view and adjust streaming media settings, from Applications menu:
1. Open RealOne.
2. Press Options and select Settings. 
3. Scroll to Connection and open.
4. Select Proxy and select No or Yes.

• If you select Yes, then scroll down and enter the Proxy serv. address and the 
Proxy port number.

5. Press Back and scroll to select Network. Open Network and select from: 

Incoming Call when Playing Video
If there is an incoming call during playback of video clips or streaming video, the player 
pauses the video. It remains paused in the background during calls. To resume play, 
return to opened file and press Options and select Continue. 
The player also pauses when an alarm sounds, or a note appears, or you open 
another menu. When you return to the player, press Options and select Continue. 
If you open a menu item when streaming video is playing, the streaming video pauses, 
and stops when the auto disconnect time period is reached. See RealOnePlayer 
Settings on page 101.

SHORTCUTS
Shortcuts serves as a ‘bulletin board’ storing shortcuts to your frequently used menu 
items or documents stored in phone memory or miniSD Card.

Default access point Choose one of the access points you have set up. See Access 
Point Settings on page 108.

Online time Select Unlimited, or select User defined to specify the amount 
of time before phone will disconnect if there has been no activity.

Maximum bandwidth Select a maximum bandwidth for streaming media to use.

Connection time-out Select a maximum time period to wait from selecting a streaming 
link until it connects to the server. Scroll left and right to move the 
slider and change the time period.

Server time-out Select a maximum time period to wait for the media server to 
begin sending the streaming media. Scroll left and right to move 
the slider and change the time period.

Lowest UDP port Type in a User Datagram Protocol port number.

Highest UDP port Type in a User Datagram Protocol port number.
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OPEN A SHORTCUT
From Applications menu:
1. Open Shortcuts.
2. Scroll to the desired shortcut; press Options and select 

Open. Or, press  to open.

ADD A SHORTCUT
1. Open the item within the menu item or open the document in 

which you want to store in Shortcuts.
2. Press Options and select Add to shortcuts.

• Adding to Shortcuts is available only for certain menu items.

MANAGE SHORTCUTS
From Applications menu:
1. Open Shortcuts.
2. Scroll to the desired shortcut.
3. Press Options and select:  

To change the wallpaper of the Shortcuts screen, see Change Wallpaper or 
Screensaver on page 106.

Edit shortcut name Change the name of the shortcut.

Shortcut icon When this option appears, choose a different icon picture by 
scrolling through grid.

Move A checkmark appears on the shortcut icon. Scroll  or  to 
move to desired location, press OK.

List view/Grid view View the shortcuts in a list view or grid view.

Delete shortcut Remove shortcut from Shortcuts.

Note: The default shortcuts to Today in Calendar, Inbox in Messages, and Notes cannot be 
deleted, nor can the icon be changed.
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SETTINGS
Choose your ringtone and theme settings here. Configure your phone, call, 
connection, security, call divert, barring, network, and enhancement settings. Manage 
all your connections to other devices and network servers using Connectivity. Use the 
miniSD Card to expand the phone’s memory capacity and transfer files.

Settings menu contains these main options:

PROFILES
Profiles are unique ringing tone, alert tones, and volume settings used to alert you to 
calls and messages. Choose from General, Silent, Meeting, Outdoor, and Pager. 
Each can be modified to suit your situation. You can use ringtones sent in a message, 
sent by  Bluetooth® or infrared connections, recorded with the Recorder menu item, or 
downloaded.
The active profile name is displayed in the standby screen, except when General is 
active.

ACTIVATE A PROFILE
From Settings menu:
1. Open Profiles.
2. Scroll to the desired profile.
3. Press Options and select Activate. 

CHANGE RINGTONES, ALERT TONES AND VOLUME
You can change, or personalise, individual settings within a profile. For example, in 
General profile, change the ringing tone to a ringing tone you downloaded.
From Settings menu:
1. Open Profiles.
2. Scroll to the desired profile.
3. Press Options and select Personalise. 

Profiles Themes General

Connect. miniSD Voice Cmd.

PB Setup About
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4. Scroll to the desired setting:    

Ringing and Alert Tone Volume
Ringing and alert tones play only when the phone's current profile is General or 
Outdoor. The other profiles mute playing of ringing tones.
To change the volume of tones when scrolling through the list, go to the Ringing 
volume field and adjust volume. 

THEMES
Change the visual look of your phone screens without changing the way the phone 
works by using Themes. Themes are wallpapers, text, and icon colours and sets 
packaged in a theme. Themes, or skins, are preinstalled when you purchase your 
phone, or you can download and install them yourself. 

PREVIEW THEMES
From Settings menu:
1. Open Themes.
2. Scroll to the desired theme name.
3. Press Options and select Preview.

ACTIVATE A THEME
From Settings menu:
1. Open Themes.

Ringing tone Scroll through list of tones. To hear the tone, 
highlight the tone name and wait. To stop the tone, press any key. 
To select a tone, highlight 
the tone name and press Select. If you have 
subscribed to 2 lines, then a setting appears for each line.

Ringing type Choose Ringing, Ascending, Ring once, Beep once, or Silent.

Ringing volume Scroll  to move the volume bars.

Message alert tone Same as Line 1 ringing tone.

Vibrating alert Select On or Off.

Keypad tones Select Off, Level 1, Level 2, or Level 3.

Warning tones Select On or Off.

Alert for If you have set up Contacts groups, select the desired group 
name if you want the phone to ring only when members of that 
group call. Other incoming calls will have the silent alert.

Profile name Change the name of any ringtone except General.
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2. Scroll to the desired theme name.
3. Press Options and select Apply.

• When previewing, press Apply to activate the theme.

CHANGE WALLPAPER OR SCREENSAVER
Change the background picture of the standby screen or Shortcuts screen, the colour 
of bars and frame boxes, and the screensaver.
From Settings menu:
1. Open Themes.
2. Press Options and select Edit; or to edit a specific theme, first scroll to desired 

theme before pressing Options:    

DOWNLOAD NEW THEMES
You can download themes directly from predetermined web sites without first opening 
Vodafone live!. These links are set by agreements with content providers who offer the 
themes. 
From Settings menu:
1. Open Themes.
2. Press Options and select Theme downloads.
3. A folder displays, containing links to content provider web pages.

• You can add your own links to the folder.
4. Open the folder, scroll to and open desired link.
5. Connection to the Internet will begin.

Note: The appearance of some icons may change when you apply a different theme.

Wallpaper Standby screen picture. Choose from Default, User defined (your own 
picture from My Items or downloaded), other themes, or None.

Colour palette Choose from the default colour and other listed colours for common 
bars, icons, and frames.

Screen saver Choose Date and time(Default), 
or Text (write your own text message).

Icons Choose from a list of theme sets of icons.

Shortcuts wall-
paper

Shortcuts picture. Choose from Default, User defined (your own pic-
ture from My Items or downloaded), other themes, or None.

Note: When the copy option appears, you can copy themes from the phone memory to the 
miniSD Card or in reverse.

Note: Some links may be preset by content providers and cannot be deleted.
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GENERAL
In the General settings menu, you can configure your phone, call, connection, date 
and time, security, call divert, barring, network, and enhancement settings.

PHONE SETTINGS
Set the phone language, writing language, and welcome note or 
logo here.  
From Settings menu:
1. Open General.
2. Open Phone.

3. With General highlighted, open to select: 

Display Settings
Adjust the brightness of the display screen and set a screen saver timeout.
From Settings menu:
1. Open General.
2. Open Phone.
3. Scroll to Display and open. Select and open:

Phone 
language

Choose a language in which the texts on the displays will appear. Auto-
matic uses the language dictated by the SIM card.

Writing 
language

Choose a language in which the texts you are writing will appear, for 
example, writing a text message.

Dictionary Select On to use the predictive text dictionary to speed up text entry.

Welcome note 
or logo

Default uses the welcome note or picture supplied with the phone, dis-
played when the phone is switched on. Select Text to enter your own 
welcome note. Select Picture to place a picture from My Items.

Shutdown 
animation

Select Off to stop the animation shown after switching off the phone.

Keypad 
backlight time

To save battery life, select Always off for the keypad backlight to remain 
off.

Orig. phone 
settings

Used if a network operator used settings protection in a phone, and later 
there is a reason to change the protected settings. Requires lock code.

Brightness Scroll  to lighten the screen, or scroll  to darken the screen, then 
press OK.
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CALL SETTINGS
From Settings menu:
1. Open General.
2. Scroll to Call and open.
3. Scroll to:

CONNECTION SETTINGS
Access Point Settings
Access points are sets of configurations that connect your phone to the Internet and 
other services. Your phone uses three main sets of access points: Multimedia (MMS), 
Browser, and Internet. Access points must be set up in order to send and receive MMS 

Screen saver 
timeout

Scroll  or  to choose from 1 minute to 30 minutes of no activity until 
screen saver switches on and press OK.

Send my 
caller ID

Choose Set by network, Yes or No. Determines whether your mobile 
number is presented to the person you are calling. Network dependent.

Call waiting Press Options and select Check status. If needed, select Activate. Net-
work will send confirmation message. When activated, if you are on a call 
and there is an incoming call, you can put the first call on hold and answer 
the second call. See Call Waiting on page 19.

Automatic 
redial

Select On to redial if the call is not connecting. Press  to stop auto-
matic redialling.

Summary 
after call

Select On to display a brief summary of duration of last call.

Speed 
dialling

Select On to start dialling by a press and hold of preset number key in 
standby mode. First, set up Speed dial keys (see Speed Dial on page 39).

Anykey 
answer

Select On to answer incoming calls by pressing any key except , , 
or .

Open to 
answer/end

Select On to answer a call by opening the flip, and to disconnect phone 
calls by closing the flip. When set to Off and you close the flip during a 
call, the caller's voice switches to the back loudspeaker.

Line in use This setting appears if you have subscribed to Alternate Line Service, in 
which you can have two different phone lines with the same SIM card. 
Select Line 1 or Line 2.

Line change This setting appears if you have subscribed to Alternate Line Service (see 
Line in use setting). You can disable selection of one of the phone lines. 
The PIN2 code is required to return use of a previously blocked line.
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and email messages, use Vodafone live!, use SyncML, use Device Manager, use your 
phone as a modem, and download.

Access points use data services to connect. Your phone can support GPRS (Packet 
data) and Data call (Circuit switched data) data services.

• GPRS is General Packet Radio Service, a packet based high speed data transfer 
technology that allows continuous connection, in which many users share a 
connection and packets are transferred only as needed.

• Data call is Circuit Switched Data, or CSD, which uses a dedicated connection 
much like ordinary voice phone service.

Contact Vodafone to find out about types of data technologies offered and subscription 
rates. 

Some or all of your access points may be preset in the phone by Vodafone and cannot 
be modified. The access point configurations may be sent to you in a smart message 
by Vodafone. You may also be able to add new access points.

To view, edit, or add new access points, first you must obtain the configurations from 
both Vodafone and Internet service provider to be entered into the phone.
From Settings menu:
1. Open General.
2. Scroll to Connection and open.
3. Open Access points to view a list of existing access points.

•  icon indicates data call.  icon indicates GPRS packet data connection.
4. To add a new access point, press Options and select New access point > Use 

default settings or Use existing settings. Either build a new access point from 
preset default settings, or use an existing access point to edit as needed. 
• To edit an access point, press Options and select Edit.

5. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 
have an entry. The bearer type you choose determines which fields are presented. 

* Connection name Enter an easy-to-recall name if not assigned.

Data bearer Select GPRS or Data call.

* Dial-up number 
(Data call only)

Enter access point dial-up phone number. 

Access point name (GPRS 
only)

Enter name supplied by service provider. 

User name Type a user name, supplied by service provider, if 
required.
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6. From main fields, press Options and select Advanced settings to enter:   

GPRS Settings
From Settings menu:
1. Open General.

Prompt 
password

To have the phone ask for the password each time you log 
on, select Yes.

Password Type in password, supplied by service provider, if required.

Authentication Select Normal or Secure.

Homepage Type in Internet web address of service.

Data call type (Data call 
only)

Determined by your wireless and Internet service provid-
ers. 

Maximum data speed  (Data 
call only)

Choose a limit for your connection speed if you are 
charged more for higher speeds.

Phone IP address Enter IP address assigned to your phone, if static or 
dynamic. Service provider determines if IP address is 
static or dynamic.

Primary name server Type in primary domain name server IP address.

Second. name server Type in secondary domain name server IP address.

Proxy serv. address Enter the proxy server address for access point.

Proxy port number Type in proxy port number for access point.

Use callback (Data call only) Select Yes to use dial back servers.

Callback type (Data call 
only)

Select Use server no. for callback, or Use other no..

Callback number  (Data call 
only)

Enter the phone number the callback server should use.

Use PPP compression
(Data call only)

Select Yes to use PPP (Point-to-Point Protocol) compres-
sion. 

Use login script
(Data call only)

Select Yes to use login script defined in Login script field.

Login script (Data call only) Enter the login script to be used. 

Modem initialisation (Data 
call only)

If desired, enter a modem initialisation string (AT command 
string).

Note: If Vodafone has protected some of your settings, you may not be able to modify them.
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2. Scroll to Connection and open.
3. Scroll to GPRS and open.
4. Open to edit:  

Data Call Settings
From Settings menu:
1. Open General.
2. Scroll to Connection and open.
3. Scroll to Data call and open.
4. Open Online time. Choose a time period to disconnect from the data call if there is 

no activity.

DATE & TIME SETTINGS
Date and time settings can be made from the Alarm Clock menu. See Alarm Clock on 
page 43.

SECURITY SETTINGS
Phone and SIM
Your phone and SIM card have security codes that you can use to limit access to the 
phone. Keep a written record of your codes in a secure place.
• Enter PIN code to use phone
The PIN and PIN2 codes (4 to 8 digits), issued by Vodafone, protect your SIM card 
against unapproved use.

If you set PIN code request to On, then the PIN code must be entered each time the 
phone is turned on.

The PIN2 code is required to access certain network operator services such as Fixed 
dialling and Call costs. If the PIN2 code is blocked, use the PUK2 code to unblock.

GPRS 
connection

Choose When needed to connect to GPRS 
service only when you open a menu item that uses GPRS. After you 
close the menu item, GPRS service will disconnect.
Choose When available to stay continuously connected when you are 
in a GPRS service area, in which the GPRS icon  replaces the signal 
strength icon .

Access point Choose an access point supplied by your service provider to use the 
phone as a modem to enable GPRS connection from a computer.

Note: If you selected to attach to GPRS when available and are in an area without GPRS 
service, then the phone will attempt to connect to GPRS service periodically.
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The PIN and PIN2 codes affect only the current SIM card as they are stored in the SIM 
card, not the phone memory.
From Settings menu:
1. Open General.
2. Scroll to Security and open. Open Phone & SIM.
3. Scroll to desired setting and select:   

• Enter Lock Code to Use Phone
To prevent unapproved use, you can lock the phone. When the phone is locked, the 
lock code must be entered before the phone can be used. The phone lock icon  
indicates that the phone is locked.

To unlock the phone, enter the lock code. You may be able to dial the local emergency 
number and accept incoming calls when the phone is locked.

From Settings menu:
1. Open General.
2. Scroll to Security and open. Open Phone & SIM.
3. Scroll to desired method and select:   

Activate Phone 
PIN

Select Yes to require entry of PIN code each time the phone is 
switched on. Requires PIN code to activate.

PIN code To change PIN code, enter current PIN code, then new PIN code twice. 
Press OK.

PIN2 code To change PIN2 code, enter current PIN2 code, then new PIN2 code 
twice. Press OK.

Note: If PIN or PIN2 code is entered incorrectly 3 times, the SIM card locks. Contact Vodafone 
for PUK or PUK2 code (PIN unblock key code). If the PUK or PUK2 code is entered 
incorrectly 10 times, the phone will not operate. All information stored in the SIM card is 
lost and the SIM card must be replaced.

Shortcut: To lock the phone, press  and select Lock phone.

Autolock 
period

Set the phone to lock after a time period of no activity. Select User 
defined to type in time period in minutes. Requires lock code to set.

Lock code To change lock code, enter current lock code, then new lock code 
twice. Record the new code in a safe place. The preset lock code is 
12345.

Lock if SIM 
changed

To prevent the phone from being used if an unknown SIM card is 
inserted, select Yes.
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• Fixed Dialling and Closed User Group
Fixed dialling restricts outgoing calls to ‘fixed numbers’ contained in SIM cards that 
support this feature. When switched on, dialling any number not on the Fixed dialling 
list is not allowed. Call diverting and sending messages to any numbers not on the list 
is also not allowed. The PIN2 code is required to set up and use this feature.
Once you enter Fixed dialling, press Options and select New contact or Add from 
Contacts to add a phone number to the Fixed dialling list. You can also call, edit, and 
delete numbers in the Fixed dialling list.
Some network operators offer Closed User Group feature, which allows the phone to 
make and receive calls only from specific groups. The groups are set up with your 
network operator at time of subscription purchase. 
From Settings menu:
1. Open General.
2. Scroll to Security and open. Open Phone & SIM.
3. Scroll to desired method and select: 

• Certificate Management
Certificates are attachments to electronic messages used to verify senders and 
recipients of data over nonsecure networks, such as email servers or the Internet. Two 
types of certificates your phone stores are authority and personal.  

Authority certificates are downloaded to your phone and are used to check server 
certificate signatures and to guarantee that the certificate is issued by a certification 
authority (CA).

Personal certificates are issued to you by a certification authority.

Caution: If you change the lock code then cannot recall it, Vodafone cannot identify the code. 
The phone must then be reset at an authorised service centre.

Fixed dialling Enter PIN2 code. Press Options and select New contact or Add from 
Contacts to create the fixed dialling list. Press Options and select 
Activ. fixed dialling to activate the service.

Closed user 
group

Select Default to activate the service to the default group previously 
set up with your network operator. Select On to activate another group 
set up previously.

Confirm SIM 
services

Select Yes to view confirmation messages sent between your phone 
and the network when you are using SIM application tool kit services.

Delete server You can reset the trusted provisioning server setting if you have 
received settings in a message. Contact the service provider from 
which you wish to receive new settings.
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Certificates are valid for only a fixed time period and must be renewed periodically. To 
renew, contact the certificate issuer.

Before downloading or sending confidential information, check the digital signature 
and validity period of the browser gateway or server on the certificate.

The phone will issue a note if the browser or server identity is not authentic, or if you 
do not have the correct certificate in your phone.

• View Certificates
From Settings menu:
1. Open General.
2. Scroll to Security and open.
3. Scroll to Certif. Management and open.

• A list of authority certificates displays.
4. Press Options and select Certificate details.

• A list displays with details such as issuer, subject, validity period, certificate 
location, certificate format, algorithm, serial number and fingerprint. 

• Authority and personal certificates will show different information. If the personal 
certificate is on an outside server, it will have different details.

5. Scroll  to view personal certificates if available.

• Trust Settings
Check whether certain menu items can use a selected certificate.
From Settings menu:
1. Open General.
2. Scroll to Security and open.
3. Scroll to Certif. Management and open.
4. Scroll to an authority certificate, press Options and select Trust settings.
5. For each menu item, select Yes to enable the certificate to verify software, servers, 

or browser sites. Select No to disable the certificate from verifying software, 
servers, or browser sites.  

CALL DIVERT
Divert incoming calls (voice, data) to another number.
Network dependent service.

Check status of Call Divert
From Settings menu:
1. Open General.

Note: Before you change any trust settings, be sure that you trust the certificate owner and 
have verified that the certificate belongs to the listed owner.
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2. Scroll to Call Diverts and open.
3. Press Options and select Check status. Network will send current status 

message. 

Activate Call Divert
From Settings menu:
1. Open General.
2. Scroll to Call Diverts and open.
3. Select one or more: All voice calls, If busy, If not answered, If out of reach, If 

not available, All fax calls, or All data calls.
4. Press Options and select Activate. 
5. Select whether calls shall be diverted To voice mailbox or To other number.
6. Enter the phone number and press OK.

• Press Find to go to your Contacts to select a number.

7. Network will send confirmation message. 
To cancel call diverts, press Options and select Cancel or Cancel all diverts.

CALL BARRING
Call barring restricts certain types of incoming and/or outgoing calls, using a password 
furnished by Vodafone. Network dependent service.
Check Status of Call Barring
From Settings menu:
1. Open General.
2. Scroll to Call barring and open.
3. Press Options and select Check status. Network will send current status 

message. 

Activate Call Barring
From Settings menu:
1. Open General.
2. Scroll to Call barring and open.
3. Select Outgoing calls, International calls, International calls except to home 

ctry., Incoming calls, or Incoming calls when abroad.
4. Press Options and select Activate. 
5. Enter Barring password and press OK.
6. Network will send confirmation message. 

To cancel call barrings, press Options and select Cancel or Cancel all barrings.

Note: If either If not answered or If not available is selected in step 3, then after step 6, select 
a Delay time from the list before calls will be diverted.
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To change the call barrings password, press Options and select Edit barrings 
passw.. Enter the password furnished by Vodafone. Enter, then verify the new 
password.

NETWORK SETTINGS
When you are not in your home country or region, you may be able to use a network 
which you are not directly subscribed to. This is called roaming.

Select a Network
From Settings menu:
1. Open General.
2. Scroll to Network and open.
3. Set Operator selection to Automatic to have the phone automatically select a 

network when roaming. Set Operator selection to Manual to select a network 
yourself from the list, which are networks available in your current area that have a 
roaming agreement with your home network.

• Using a Micro Cellular Network
When the phone is using a micro cellular network (MCN), it can display an MCN 
indicator in standby mode. Set Cell info display to On to switch on this indicator if you 
enter an MCN.

ENHANCEMENT SETTINGS
When you attach a headset or Bluetooth® headset enhancement to the phone, you 
can set the profile (General, Silent, Meeting, Outdoor, Pager) that the phone will use 
when the enhancement is attached.

See Profiles on page 104 to learn about profiles.

From Settings menu:
1. Open General.
2. Scroll to Enhancement and open.
3. Scroll to Headset or BT Accessory and open.
4. Select the Default ringtones settings (Active profile, General, Silent, Meeting, 

Outdoor, or Pager).
5. Set Automatic answer to On if you want the phone to automatically answer calls 

when the enhancement is attached.

ENHANCEMENT IN USE
Select which enhancement is attached to the phone.
From Settings menu:

Note: Local laws may not permit roaming in your home region.
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1. Open General.
2. Scroll to Enhancement and open.
3. Open Enhancement in use and select Headset or BT Accessory. BT Accessory 

will display when it is detected by the phone. 

CONNECTIVITY
View and manage your phone’s connections to other devices that can be connected to 
the phone, wirelessly and by cables. View your active connections using Connection 
Manager. Synchronise your Contacts and Calendar entries with your other networked 
devices. Your network, Internet, email service providers can help you configure and 
manage your connection settings using Device Manager. 

Connectivity menu contains these main options: 
Infrared Conn Mgr                USB
Bluetooth® SyncML
Modem Dev Mgr.

INFRARED
Transfer data between your phone and other infrared enabled devices using an 
infrared wavelength connection. You can also use infrared connections for GSM data 
services, and access the Internet and email via other devices. 

Prepare for Infrared Connection
Place your phone and the other device within the effective range of the infrared 
connection, about 20 cm.
• Verify there are no obstructions between the two devices.
• Ensure that the infrared ports of the devices point at each other.
• On the receiving device, activate the Infrared port.
• If the other device is a computer, you need to set up infrared connection on the 

computer. For example, in Windows®, select Start > Settings > Control Panel > 
Options tab > Enable Infrared Communication. For specific infrared set up 

Caution: This device contains a low power level Class 1 laser product (Infrared LED), which 
will not normally harm the eyes. Though invisible to the eye, do not point the infrared 
beam at anyone’s eye. Nearby activated infrared devices may cause interference.

Note: The phone may not allow you to copy, modify, transfer, or forward some copyrighted 
images, ringtones and other content.
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instructions for your computer’s operating system, refer to the computer’s on-line 
help.

Send and Receive Data via Infrared
You can send and receive Contacts cards as business cards, Calendar notes, pictures, 
sound clips, bookmarks, configuration messages via infrared, and receive applications 
supported by the phone.
To send data via Infrared:
1. Prepare for infrared connection as described on page 117.
2. Go to the menu item that contains the data you wish to send, for example, go to 

Contacts to send a business card.
3. Highlight or open the item you wish to send.
4. Press Options and select Create message > Via Infrared.
5. The phone automatically begins infrared connection, indicated by flashing . 

While transferring, icon is steady. A confirmation message displays when 
complete.

To receive data via Infrared:
1. Prepare for infrared connection as described on page 117.
2. From Settings menu, open Connect., open Infrared.
3. Flashing icon  displays, meaning phone is ready to receive data. 
4. Sender can begin transfer of data. A tone sounds when transfer is complete.
5. Press Show to accept the incoming message containing the data. The message is 

placed in the Inbox.
6. Open the message, press Options and select Save to save data to supporting 

menu item. You can rename the file.
• If transfer does not begin within 40 seconds, the infrared connection 

automatically stops.

BLUETOOTH® WIRELESS TECHNOLOGY
Bluetooth® wireless technology uses radio waves to communicate with other 
Bluetooth® devices within a maximum range of 10 metres. You can send and receive 
business cards, pictures, Calendar events, video and sound clips, and other data 
between Bluetooth® devices such as mobile phones and computers. 

Use a Bluetooth® headset to talk wirelessly on your phone whilst the phone is in your 
pocket or purse. 

Note: For Windows® 2000 users, to enable infrared use to transfer files, go to Start > Settings > 
Control Panel > Wireless Link. In the File Transfer tab, check “Allow others to send files 
to your computer using infrared communications”. 
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This phone supports Bluetooth® v1.1 connectivity with the following profiles: Serial 
port, Dial-up networking, Object push, File transfer, Headset, and Handsfree  

Set up Bluetooth®

You must first set up Bluetooth® connections before using it for the 
first time. Thereafter, go to the Settings tab to switch Bluetooth® 
setting on or off and change your phone’s visibility to other 
Bluetooth® devices.
From Settings menu: 
1. Open Connect..
2. Open Bluetooth.
3. In the Settings tab, open fields:   

Pair with Other Device and Connect
From Settings menu: 
1. Open Connect..
2. Open Bluetooth.
3. Scroll  to Paired Devices tab.
4. Ensure that the device in which you want to pair is switched on, and its Bluetooth® 

setting is activated.

Note: Although Bluetooth® devices can connect within a 10 metre range, walls or other nearby 
barriers may cause interference.
Check with local authorities before using Bluetooth® wireless technology as some 
countries may restrict the use of Bluetooth® devices.

Battery note: Keeping Bluetooth® setting “On” consumes battery power more rapidly. To 
conserve battery power, switch off Bluetooth® setting when not in use. Switch 
Bluetooth® on or off in Settings.

Bluetooth Select On or Off.

Visibility Choose Shown to all to allow other Bluetooth® devices to find your 
phone when searching, or select Hidden to keep other Bluetooth® 
devices from finding it during a search.

Visibility 
Timeout

Choose Disabled to keep Visibility setting as Shown to all, or scroll 
to select a time period after which your phone cannot be found by other 
Bluetooth® devices (Visibility setting changes to Hidden).

Phone’s name Use the default name or enter a name for your phone that other 
devices will see when they search for your phone.

My Transfer 
Speed

Choose Normal, Fast, or Very Fast.
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5. Press Options and select New paired device. If Bluetooth® setting is switched 
off, press Yes to switch on Bluetooth® setting. 

6. The phone begins searching for devices and notifies you when it finds the other 
device.

7. Press Select. Enter the passcode for the connecting device if needed and press 
OK. If the other device has not yet been paired, first decide on a passcode with the 
other person, then enter it when requested, press OK.

8. To connect with the device, open the device name and select Connect.

Send and Receive Data via Bluetooth®

You can send and receive Contacts cards as business cards, Calendar events, 
pictures, video and audio clips, bookmarks, configuration messages, and receive 
applications supported by the phone via Bluetooth®.

To send data via Bluetooth®:
1. Ensure that the device in which you want to pair is switched on, and its Bluetooth® 

setting is activated. On your phone, go to the menu item that contains the data you 
wish to send, for example, go to Contacts to send a business card.

2. Highlight the desired item to send.
3. Press Options and select Create > Via Bluetooth. If Bluetooth® setting is 

switched off, press Yes to switch on Bluetooth® setting.
4. The phone automatically searches for Bluetooth® devices nearby.

• Devices appear one-by-one. If device has already been paired,  icon 
appears with device name. Press Stop to stop search when intended device 
name pops up.

• If the other device has not yet been paired, first decide on a passcode with the 
other user, then enter it when requested, press OK. 

5. Scroll to the intended device and select. Connecting message appears, then after 
the other device accepts, a confirmation message displays when transfer is 
complete.
• If the other device does not accept the data, Bluetooth® connection cannot send 

the data. 

To receive data via Bluetooth®:
1. Press Show to accept the incoming message containing the data. (If phone is not 

in standby mode, Show does not appear.) The message is placed in the Inbox in 
Messages.

Note: The passcode may be stated in the connecting device user guide.

Note: The phone may not allow you to copy, modify, transfer, or forward some copyrighted 
images, ringtones and other content.
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2. Open the message, press Options and select Save to save data to phone 
memory or miniSD Card. You can rename the file.

Manage Paired Devices
From Settings menu: 
1. Open Connect..
2. Open Bluetooth.
3. Scroll  to Paired devices tab and scroll to desired device.
4. Press Options and select: 

Icons of paired devices:   

MODEM
You can link together your X701 phone as a modem to a computer or a PDA to access 
the Internet. 

Link your phone and computer to access the Internet
To use the X701 phone as a modem there are three options: connect using the 
infrared port, connect using Bluetooth®, or connect using the Panasonic USB Data 
Cable (EB-UCX71). See Accessories on page 133 for USB Data Cable information.

Prerequisites
• Set up a dial-up account with an Internet Service Provider (ISP).
• From your ISP, you need the installation CD or your account details (i.e. dial-up 

number, user name, password, DNS server addresses) to configure Dial Up 
Networking.

Note: Confirmation is required first if the paired device is not set as authorised.

New paired device Search for nearby Bluetooth® devices.

Assign short name Change name of paired device to an easily recognised name.

Set as authorised or 
Set as 
unauthorised

Allow automatic connection without manually accepting each 
time, shown by  icon. Unauthorised setting requires confirma-
tion each time the device attempts to connect to the phone.

Delete Delete the paired device from your list.

Delete all Delete all paired devices.

audio phone computer miscellaneous

Note: Multiple devices can be paired; however, only one active connection is possible at any 
given time.
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• When setting up your Internet account for the first time, select X701 as the 
connecting modem device. For more details, contact your ISP.  For help using 
Windows® Dial Up Networking, search Windows® Help files.

Install X701 as Modem on Computer
The following describes how to set up a computer to connect to your X701. The 
procedure described may differ for other software packages.

To install your phone as a modem on a computer, here is an example. On the 
computer, select Start > Settings > Control Panel > Modems > Add > Other > Don’t 
detect my modem > Standard 33600 bps modem > Communications Port > Virtual 
Com Port. For specific instructions on your computer’s operating system, refer to your 
computer’s on-line help.

Set Up Connection
From Settings menu:
1. Open Connect..
2. Open Modem. 
3. Align the infrared port of your phone with the infrared port of the computer.
4. Select Connect via infrared, which opens the infrared connection.

• To use Bluetooth®, you must start the Bluetooth® connection from the computer 
or device to which you are connecting. To prepare your phone to connect via 
Bluetooth®, see Set up Bluetooth® on page 119. 

• To use USB data cable, you must start the connection from the computer or 
device to which you are connecting.

5. The phone confirms when a connection is established.
• If Bluetooth® connection is successful, when you select Connect via infrared, 

the phone will state that the modem is already in use by Bluetooth®.

Make Connection to Internet
1. Now you can create a new GPRS connection. For example, on the computer, 

select Start > Programs > Accessories > Communications > Dial-Up Networking > 
Make New Connection. For specific instructions, see your computer’s on-line help.

Note: This info may be on CD-ROM.

Note: If connecting with a data cable, select Com 1 in the Communications Port field.

Note: To close the connection, press Disconn. softkey. If there is an on-going data call, the call 
is ended first.
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2. Enter X701 as the name you are dialling, and choose Standard 33600 bps Modem 
as the device, then select Next. Choose 115200 as the Maximum speed. In the 
telephone number field, enter *99# then click Finish.

3. You will now have an X701 connection icon in the computer’s connection screen. 
Double click the icon and select Connect to begin the connection. 

CONNECTION MANAGER
View status, speed, and amount of data transferred for all of your currently active 
GPRS and Data call network connections.

View Connection Details
From Settings menu:
1. Open Connect..
2. Open Conn Mgr..
3. A list of currently active network connections appears, sorted according to starting 

time of connection.
4. Scroll to desired connection, press Options and select Details to view name, 

bearer (GPRS, data call), status (creating connection, idle, active, on hold, closing 
connection or closed), received and sent data amount in bytes, duration, downlink 
and uplink transfer speed in kb/sec, dial-up number (data call only), GPRS access 
point name (GPRS only), sharing.

End Connections
From Settings menu:
1. Open Connect..
2. Open Conn Mgr.
3. A list of currently active network connections appears, sorted according to starting 

time of connection.
4. To end one connection, scroll to desired connection, press Options and select 

Disconnect.
To end all active connections, press Options and select Disconnect all.
• If you are ending all connections, the Data call connections are closed first, then 

the GPRS connections close in the same order as established.

SYNCHRONISATION
Set up profiles and synchronise your Contacts and Calendar entries with your other 
networked devices.
Create a New Sync Profile
From Settings menu:

Note: GPRS connection cannot be closed if it is currently suspended due to circuit-switched 
activity.
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1. Open Connect..
2. Open SyncML.
3. If there are no profiles, select Yes to create a new profile. Or, press Options and 

select New sync profile, press Yes.
4. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 

have an entry. 

5. Scroll  to move to Content tab.
6. For each field, press Options and select Change, select Yes.
7. Open Remote database and enter location on the network of each of the 

databases.
8. Open Synchronisation type and choose whether you want to synchronise in both 

directions (Normal), from server to phone (To server only), or from phone to 
server (To phone only) for each database.

Synchronise
If you are synchronising from the server to the phone, you will receive a message in 
the Messages Inbox. When you open the message, you are asked if you wish the 
server to begin the synchronisation process. If you accept, the process automatically 
begins.
To begin synchronising from the phone, from  Settings menu:
1. Open Connect..
2. Open SyncML.
3. Highlight desired profile, press Options and select Synchronise.

During synchronisation from either direction, you can follow the process on the phone. 
The phone confirms completion.

To cancel synchronisation, press Cancel.

If synchronisation fails, for example, the sync server is busy or the database cannot be 
opened, you are notified of the error type.

View or Edit Sync Profiles and Content
From Settings menu:

* Sync profile name Enter a name if not assigned.

Access point Select desired access point name.

* Host address Enter web address of sync server.

Port Enter port number of sync server.

User name Type your user name for the server.

Password Type in password.
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1. Open Connect..
2. Open SyncML.
3. Highlight desired profile, press Options and select Edit sync profile.
4. Scroll to desired fields to view and open to edit.

If a profile has been synchronised, press Options and select View log to view profile 
name, remote server name, date, time, and status of last synchronisation, and details 
of content transfer.

To view or edit the Content settings, scroll  to view the Content tab and continue with 
step 6 in Create a New Sync Profile on page 123.

DEVICE MANAGER
Your network, Internet, email service providers can help you configure and manage 
your connection settings. These settings can be sent to your phone over the air. 
Device Manager menu allows service providers to configure and update these settings 
from their servers on your behalf. Settings may include network access points, 
multimedia, email, and synchronisation connections.

Configuration Session
A configuration session can be started either from the Device Manager menu in the 
phone, or from the service provider's server.

If your service provider intends to start a session, your phone will show a server alert 
message. Before the session can begin, your phone asks to activate the server 
connection and the profile if they are off. Then the phone asks you to accept that the 
server is ready to configure. If you don’t want the session to run, press Reject or 
Cancel.

Once the configuration session begins, the phone displays status notes advising the 
session stage: connecting to the server, receiving data from the server, processing 
data, and disconnection.
To start a configuration session yourself (if server profile is set up), from Settings 
menu:
1. Open Connect..
2. Open Dev Mgr..
3. Scroll to desired server profile in which you wish to start configuration session.
4. Press Options and select Start.

Note: If you set the server profile to accept configuration sessions without verification, then the 
session will begin in the background. View the process by opening Device Manager 
menu.
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Create a New Server Profile
The server profile is the settings needed to connect your phone to a service provider’s 
device management server, which handles the configuration session procedure.
From Settings menu:
1. Open Connect..
2. Open Dev Mgr..
3. If there are no profiles, select Yes to create a new profile. Or, press Options and 

select New server profile.
4. Enter information in fields. Fields marked in the phone with a red asterisk (*) must 

have an entry. 

View or Edit Server Profiles
From Settings menu:
1. Open Connect..
2. Open Dev Mgr..
3. Scroll to desired server profile, press Options and select Edit profile, or Delete.

View Session Log
To view the results of a selected server’s last configuration session, from Settings 
menu:
1. Open Connect..
2. Open Dev Mgr..
3. Scroll to desired profile, press Options and select View log.

* Server name Use suggested name or enter your own. 

* Server ID Server’s unique ID identifies the remote server.

Server password Server password supplied by service provider so your phone can 
verify server.

Access point Select desired access point.

* Host address Server’s web address.

Port Server’s port number.

* User name Type in your user name for the server.

Password Device Manager password supplied by service provider so the 
server can verify your phone.

Allow configuration Select Yes to allow device management to be done by this 
server.

Accepted Select Yes to allow device management to be done by this server 
without Accept command.
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The log shows name of server configured, results of configuration, date and time, and 
errors if any occurred during configuration.

Shortcut to stop configuration sessions
There may be times in which you do not want configuration sessions to run. Instead of 
going to each server profile to set Active to not allow device management to be done 
by the server, you can set the phone so that device management cannot be done by 
any server.

The default setting is to allow device management to be done (Enable configurations).

From Settings menu:
1. Open Connect..
2. Open Dev Mgr..
3. Press Options and select Disable config..

• All server profiles are disabled and no configurations can be done.
To allow configurations to be done again, press Options and select Enable config..

USB
Connect to PC Software Suite over your USB cable using USB menu item.

Connect to PC Software Suite
1. Plug USB cable into the phone.
2. From the Connect. menu, open USB.
3. USB icon appears, indicating that USB connectivity has started.
4. On your computer, begin desired task such as backup or sync.

Connect to Modem
1. Plug in USB cable into the phone.
2. From the Connect. menu, open Modem.
3. Select Connect via USB.
4. USB icon appears indicating that USB connectivity has started.
5. On your computer, start a connection using the phone as a modem.  

miniSD CARD (MEMORY CARD)
Backup your phone memory onto the miniSD memory card. MiniSD Cards can be 
installed into the standard size memory card socket of other devices using the miniSD 
Card adapter (see Using miniSD Card and miniSD Adapter on page 129). Data file 
size of miniSD Card may vary with current availability. 
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REMOVE miniSD CARD
1. Press , scroll to Eject miniSD Card and press OK. Wait for file saving or 

copying process to finish before removing miniSD Card.

2. Continue with Removing miniSD Card on page 9.

FORMAT, VIEW DETAILS OF miniSD CARD

BACKUP FILES

From Settings menu:
1. Open miniSD. A list indicating name, storage capacity, storage used, and storage 

free displays.
2. Press Options and select:

 

Warning:  Do not format a miniSD Card that contains important software as this destroys all 
data on the miniSD Card.

Remove miniSD Card Saves data and closes menus and applications before ejecting 
miniSD Card.

Backup phone mem. Backup the phone contents to the miniSD Card.

Restore from card Restore earlier backed up miniSD Card data to the phone 
memory.

Format miniSD Card Format other brand miniSD Cards if needed before first use.

miniSD Card name Write a name or title for the miniSD Card.

Memory details View number of bytes stored in separate menu items such as 
Calendar, Messages, My folders. Also view total memory in use 
and free memory.
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Password in some miniSD Cards
Some brands of miniSD Cards can be locked from unapproved use by entering a 
password. If you insert a miniSD Card with locking capability into your phone, the 
following option items will appear.

From Settings menu:
1. Open miniSD. 
2. Press Options and select:

USING miniSD CARD AND miniSD ADAPTER
By inserting the miniSD Card into the miniSD adapter, you can use the miniSD Card in 
an SD memory card compatible personal computer. Back up data and print pictures 
using a printer.

To insert the miniSD Card into the miniSD adapter:
1. On miniSD adapter, move lock tab into unlocked 

position.
2. Slide miniSD Card in with notched corner entering 

the left side of the miniSD adapter first into the 
pocket until it clicks.

3. Follow manufacturer’s instructions for inserting 
an SD card in the compatible personal 
computer and accessing the data.

Write-protect miniSD Card
• To protect important data, move write-protect switch to Lock position. The miniSD Card is 

write-protected and you cannot write, save, or delete data or format the card.
• To write data to the miniSD Card, move write-protect switch to unlocked position.

VOICE COMMANDS SETTINGS
Voice Commands allows you to press and hold , say ‘Voice Dial’, then say a name 
in your Contacts list and the phone will dial the number, or you can open menu items in 
a similar way. To learn how to use Voice Commands, see page 98. Change the 
settings of Voice Commands here. 
1. Press and hold . 

Set password Enter a password to use to lock the miniSD Card. Thereafter, the 
password must be entered to use the miniSD Card in any device.

Remove password Removing the password unlocks the miniSD Card, and it can be 
used in another device without a password.

Change password Change locking password for this miniSD Card.

Unlock miniSD Enter the password to unlock the miniSD Card.

MiniSD Adapter with 
miniSD Card inserted

Lock

Write-protect 
switch

MiniSD Card

MiniSD Adapter
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2. After the prompt to “Say a command”, press Settings and select from:

Digit Dialling If the phone cannot consistently recognise numbers that you are say-
ing, select Adapt Digits to make recordings to teach the system your 
voice. Select Reset Digits to restore the original recognition software.

Sensitivity If the phone cannot recognise most of your commands, change sensi-
tivity toward Reject Less. If the phone recognises too many mis-
matches, change sensitivity toward Reject More.
Select Commands or Names. Then scroll up or down to change the 
setting.

Choice Lists Choose whether the phone presents choices when the phone does not 
recognise your command.

Sound Switch on or off the playback of prompts, names and digits. Select 
Name Settings to change the speed or volume of name playback.

Language Choose from the list of languages that the software will use for audio 
prompts, text screens, and your voice recognition.

Application 
Launcher

Check to select menu items from the list to open using Open Applica-
tions.

Contacts 
Update

Each time Voice Commands is opened, it checks your Contacts list for 
name additions or edits, and if so, automatically reloads the list. If the 
list is large, the reload requires more time. Select Configure to choose 
Automatic or Manual reloading. 

About Copyright information about the voice recognition software.
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PRINTBOY SETUP
PrintBoy Setup works with your Quickoffice menu to print your Quickoffice documents 
wirelessly from your phone to supported printers.

From Settings menu:
1. Open PB Setup.
2. On the Drvrs tab is a list of supported printer drivers. Scroll to desired printer.
3. Press Options and select Configure. Select from: 

4. After the printer is configured, scroll , press Options and select:  

ABOUT
View copyright information about the phone and software used on the phone.

From Settings menu:
1. Open About.

Communications Select the method to send data to the printer.

Paper Size Choose a paper size.

Left Margin Choose desired left margin measurement.

Test Print Send a test print.

Bluetooth® > Select Find Printer to pair with the printer.

Set as Default From the Drvrs tab, set the highlighted printer as default.
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GAMES
Your phone is supplied with preloaded games. Contact Vodafone for game details. 

To play a game:
From Games menu:
1. Open game icon.
2. Follow the screen prompts.

MORE GAMES
To download more games from the Games menu:
1. Click on More Games.
2. The phone will begin connecting to the Vodafone live! Games section.

Also see Download Files from Vodafone live! on page 77. For customer support of 
downloaded content, visit the respective supplier's website. 

Note: Panasonic is not responsible for the performance of downloaded content or possible 
corruption of phone software.
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ACCESSORIES
Many accessories are available for your Panasonic phone. Using non-Panasonic 
accessories or accessories not recommended by Vodafone may result in poor 
performance of your phone, or even cause an electrical hazard.

BATTERY LITHIUM-ION  780 mAh
(EB-BSX700)
Carry a spare battery.

TRAVEL CHARGER
(EB-CAX70AU) (EB-CAX70CN) (EB-CAX70EU)
(EB-CAX70UK) (EB-CAX70US)
Recharge the battery using any electrical outlet. Plugs for use in many 
countries are available.

miniSD CARD
MiniSD (secure data) memory card stores audio, video, picture, and 
voice files. Card memory size varies.

miniSD CARD ADAPTER
This adapter allows you to use your miniSD Card in a standard SD 
socket. See Using miniSD Card and miniSD Adapter on page 129.

CAR CHARGER (DC ADAPTER)
(EB-CDX70)
Recharge the battery using your vehicle’s cigarette lighter socket.

CAR HOLDER
(EB-KAX700)
Mounted in your vehicle to store your phone. Use with personal 
handsfree headset for handsfree operation.

CARRY CASE
(EB-YKX700)
Clip your case to your clothing or purse to keep your phone close.

Warning: When you use a miniSD Card with an SD Memory Card application device, please
insert the card in the miniSD adapter which is included in the package. When you
use the card with an SD Memory Card application device, please insert and remove
the card with the adapter at the same time and never leave the adapter in the device.



134      

PERSONAL HANDSFREE HEADSET
(EB-EMD87)
Plug into your phone and talk without holding the phone to your ear. 

PRODUCT CD
Transfer data between your phone and your PC, using Bluetooth®, 
Infrared, or USB data cable.

USB DATA CABLE WITH CHARGING CAPABILITY
(EB-UCX700)
Use this to connect your phone to a PC to transfer data between them. 
Use in conjunction with the software provided on the CD-ROM.

BLUETOOTH® HEADSET
(EB-BHX70)
Talk handsfree and without wires. Place the headset on your ear and the 
phone in your pocket, with no wires connecting the two.

BLUETOOTH® CAR KIT
Parrot model CK3000 or Parrot model DriveBlue
Made by Parrot, these Bluetooth® enabled handsfree car kits allow you to 
use your phone handsfree in your car. Model CK3000 requires 
installation; model DriveBlue plugs into your car cigarette lighter.

How to identify a genuine Panasonic accessory
Panasonic produces some of the most advanced mobile phones available. So, as 
you'd expect from this class leader, the range of accessories are second to none. Most 
genuine Panasonic accessories will have a label showing an "EB-XXXXX" model 
number.
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TROUBLESHOOTING
Problem Remedy

Phone does not switch 
on

• Check that the battery is properly installed and charged.
• Press and hold  for at least two seconds.

Short battery life for a 
new battery

Battery life is reduced when:
• playing games
• leaving Bluetooth® switched on
• taking pictures with Camera
• recording video clips with Video recorder
• recording sound clips with Recorder
• using the PhotoLight often
• browsing the Internet
• downloading data
• leaving Cell Broadcast switched on
• phone is in a weak service area, requiring more battery power

Battery charging 
indicator does not 
appear, and phone 
cannot be switched on 
when starting battery 
charge session

Allow phone to charge for a few minutes before switching on. Battery 
may have been fully discharged.

Battery fails to charge Do not connect the Travel Charger until after the battery has been 
installed.

Display looks faded Check the Brightness setting (see Display Settings on page 107).

Emergency calls 
cannot be made

Check that the antenna symbol  is displayed - move to a coverage 
area and operate your phone when the antenna symbol appears. 

Calls cannot be made 
or received

• Check to make sure the phone is switched on.
• If keypad is locked, press Unlock softkey, then press .
• If phone is locked, enter lock code.
• Check that the network signal strength indicator  displays at least 

one bar. Move to a stronger coverage area.
• If no network name appears, the phone may not be registered to a 

network. Move to another area and watch for the phone to register 
to a network.

• Check Call barring, Fixed dialling, Closed user group, and Call 
divert settings in Settings menu.
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Error Messages
These are some of the important error messages which may be displayed.

Note: The quality of display pictures may vary depending on the object or environment.
Display pictures may distort when shooting moving objects, especially in a fast moving 
environment. 

Error Message Meaning

Unable to install Unable to install game, ringing tone, application, etc., for various 
reasons such as not enough memory, or downloading failed.

No access points 
defined. Define now?

You need to set up an access point for your phone to access the 
service you are requesting, such as Multimedia messaging, email, or 
browsing the Internet.

Memory full Phone memory is full. Delete some files before new files can be 
stored. See Shared Phone memory on page 28.

No network coverage There is no network service in your current location.

Network busy
Connection error

Network is overloaded with calls or there was an error trying to 
connect to the network.

Unable to send 
message. Maximum 
message size is xxx.

File size of object attached to message is too large to send. The xxx 
will be replaced by a file size. You may be able to send the file by 
infrared, Bluetooth®, or transfer by PC Software Suite.

Unable to connect. No 
network coverage. Cannot connect to server you are requesting.

Secure connection not 
available Network cannot establish a secure connection.

SIM card registration 
failed The network cannot register your SIM card. Contact Vodafone.

PIN code blocked. 
Enter PUK code:

PIN code was entered incorrectly 3 times, therefore the SIM card is 
locked. Enter the PUK code, supplied by Vodafone.

PIN2 code blocked. 
Enter PUK2 code:

PIN2 code was entered incorrectly 3 times, therefore the SIM card is 
locked. Enter the PUK2 code, supplied by Vodafone. 

SIM card rejected The phone is set to accept only certain SIM cards. It will not accept 
the currently inserted SIM card.
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SPECIFICATIONS

Size 
- Length x width x thickness: 97 mm x 49 mm x 23.9 mm

- Weight: 107g

Network bands supported 
- Standard: GSM900 Class 4   GSM1800 Class 1   GSM1900 Class 1

- Data bearer: GPRS Class 10; CSD

Battery 
- Standard: 780 mAh Lithium Ion

- Talk time: 2 to 6 hours

- Standby time: 100 to 250 hours

- Charging time: approximately 90 to 120 minutes

Displays 
- Main display: 176 x 208 pixels TFT LCD; 65k colours

- External display: 64 x 96 pixels CSTN LCD; 56k colours

Camera 
- Type: VGA CMOS

- Photolight: Range 1-2 m

- Video: H.263 Encode and Decode; MPEG4 Decode; 3GPP OMA compliant streaming

- Other features: “Superbright” Photolight; up to 4X Zoom; Frames; Crop

Connectivity 
- Bluetooth®: Serial port, Dial-up networking, Object push, File transfer, Headset, and Handsfree 

profiles (v1.1)

- Infrared: SIR (slow infrared)

- USB: v1.1

Note: Talk and Standby time are dependent upon network conditions, battery condition, and 
use of certain features such as data calls, games, Bluetooth®, camera.
Charging time is dependent on usage and battery conditions.
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Software features 
- Operating System: Symbian v7.0s, Series 60 v2.0

- Browser: WAP 2.0 (WML, XHTML MP, WCSS, cHTML, other)

- Java: MIDP2.0, CLDC1.0, JSR 82, 118, 120, 135

- Digital Rights Management security: Forward lock DRM + additional content protection

- Messaging: MMS 2.0, SMS, Smart messaging

- E-mail: SMTP, IMAP4, POP3, MIME2

- Personal Information Management: Contacts; Calendar; Scheduler; Clocks (NITZ [Network 
Informed Time Zone], analog, digital); Alarm; Calculator; Converter

- SyncML: v1.1.1, Device Management and Data Synchronisation

- OMA Client Provisioning

- Document Viewer: view/edit native Microsoft® Word, Excel, and PowerPoint® documents

- Image Editing: Crop, slide show, panorama, frames

- Predictive text: Tegic T9 predictive text input

- Voice Recognition: Speaker independent name, continuous digit dial, command and control

Content and file formats supported 
- Still Imaging: JPEG, TIFF, WMF, GIF, BMP, WBMP, PNG, EXIF, MBM, SMS OTA, ICO

- Video playback: 3GPP, MPEG4, RealVideo7 and RealVideo8

- Video record: 3GPP

- Audio: RealAudio Voice, RealAudio7, and RealAudio8, AMR-NB, AMR-WB, WAV, WVE, MIDI, 
GSM 6.10, RAW, RMF, XMF, SMAF
Bluetooth® audio devices are limited to voice calls

- Text: Text/plain

- Ringtones: 40+ polyphonic, OTA ringtones

- Application installation package: Symbian .sis file

- Java: JAD and JAR files

- Digital certificates: Yes - can download

- vCard: Send/receive business cards (Contacts cards)

- vCalendar: Send/receive calendar event
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COPYRIGHTS
© 2004 Panasonic Mobile Communications Co., Ltd. All rights reserved.
Information in this document is subject to change without notice. No part of these 
instructions may be reproduced or transmitted in any form or by any means without 
obtaining express permission from Panasonic Mobile Communications Co., Ltd.

CP8 Patent

Copyright © Arcsoft 2004. All rights reserved.

Powered by Mascot Capsule®/Micro3D Edition™ Mascot Capsule® a registered 
trademark of HI K.K.

Panasonic X701 with Bluetooth® Technology
This software is based in part of the work of the FreeType Team. This product is 
covered by one or more of the following patents: United States Patent 5,155,805, 
United States Patent 5,325,479, United States Patent 5,159,668, United Kingdom 
Patent 2232861 and France Patent 90 05712. 

miniSD™ Memory Card

Java and all Java based trademarks and logos are trademarks or registered 
trademarks of Sun Microsystems, Inc. in the U.S. and other countries.

This Product Includes Software Licensed from Symbian Ltd. © 1998-2004; this product 
is based on Symbian OS.
This software is based in part of the work of the FreeType Team. This product is 
covered by one or more of the following patents: United States Patent 5,155,805, 
United States Patent 5,325,479, United States Patent 5,159,668, United Kingdom 
Patent 2232861 and France Patent 90 05712. 

T9 Text Input is licensed under one or more of the following: U.S. Pat. Nos. 5,818,437, 
5,953,541, 5,187,480, 5,945,928, and 6,011,554; Australian Pat. No. 727539; 
Canadian No. 1,331,057; United Kingdom Pat. No. 2238414B; Hong Kong Standard 
Pat. No. HK0940329; Republic of Singapore Pat. No. 51383; Euro. Pat. No. 0 842 463 
(96927260.8) DE/DK, FI, FR, IT, NL, PT.ES, SE, GB; Republic of Korea Pat. Nos. 
KR201211B1 and KR226206B1; and additional patents are pending worldwide. 
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PC Suite Synchronisation includes synchronisation software that is copyright © 1996 - 
2004 Time Information Services Limited. All rights reserved.

VoiceSignal Technologies

This product contains software licensed from Nokia Corporation. Copyright © 2004 
Nokia Corporation. All rights reserved.

This product is licensed under the MPEG-4 patent portfolio license for the personal 
and non-commercial use of a consumer to (i) encode video in compliance with the 
MPEG-4 Visual Standard (“MPEG-4 Video”) and/or (ii) decode MPEG-4 Video that was 
encoded by a consumer engaged in a personal and non-commercial activity and/or 
was obtained from a licensed video provider.
No license is granted or implied for any other use.
Additional information may be obtained from ‘MPEG LA, LLC’

© 2003-2004 Mobility Electronics, Inc.
IMPORTANT-READ CAREFULLY:
MOBILITY TEXAS, INC. ("LICENSOR") IS WILLING TO LICENSE THIS SOFTWARE TO YOU ONLY IF YOU 
ACCEPT ALL THE TERMS OF THIS END USER LICENSE AGREEMENT ("EULA"). PLEASE READ THE 
TERMS CAREFULLY BEFORE YOU INSTALL THIS SOFWARE BECAUSE BY EXERCISING YOUR 
RIGHTS TO USE THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS EULA. 
IF YOU DO NOT AGREE TO THESE TERMS, LICENSOR WILL NOT LICENSE THIS SOFTWARE TO YOU, 
AND IN THAT CASE YOU SHOULD REMOVE ALL FILES FROM YOUR PHONE, HANDHELD DEVICE, 
AND/OR PERSONAL COMPUTER.

Ownership of the Software This Quickoffice™ software program and other software product(s) included 
("Software") and the accompanying written materials, including all intellectual property and confidential 
information relating to it, are owned or licensed by Licensor and are protected by United States copyright laws, 
by laws of other nations, and by international treaties.
Grant Of License Licensor grants to you the non-exclusive right to use one copy of the Software on a single 
computer or handheld device ("Device"). You may load one copy into storage memory of one Device and may 
use that copy, only on that same Device.

Restrictions on Use and Transfer If this Software package contains multiple media types, then you may use 
only the type of media appropriate for your Device. You may not use the other size media on another Device or 
computer, or loan, rent, transfer, or assign them to another user except as part of the permanent transfer of the 
Software and all written materials (as provided for below). You may not copy the Software, except that (1) you 
may make one copy solely for backup or archival purposes, and (2) you may transfer the Software to a single 
hard disk provided you keep the original solely for backup or archival purposes. You may not copy the written 
materials. You may permanently transfer the Software and accompanying written materials (including the most 
recent update and all prior versions) if you retain no copies and the transferee agrees to be bound by the terms 
of this EULA. Such a transfer terminates your license. You may not rent, lease, allow multiple users, time 
sharing, use the Software in a service bureau or otherwise transfer or assign the right to use the Software, or 
any adaptation or part thereof, except as stated in this paragraph. You may not reverse engineer, decompile, 
or disassemble the Software.
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Limited Warranty, Disclaimer, and Damages Limitation
Licensor warrants that the Software will perform substantially in accordance with the accompanying written 
materials for a period of 30 days from your purchase date of the Software. LICENSOR DISCLAIMS ALL 
OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-
INFRINGEMENT, WITH RESPECT TO THE SOFTWARE AND THE ACCOMPANYING WRITTEN 
MATERIALS. LICENSOR DOES NOT WARRANT ERROR-FREE OR UNINTERRUPTED USE OF THE 
SOFTWARE. This limited warranty gives you specific legal rights. You may have others, which vary from one 
state, country, or region to another. Some laws prohibit the foregoing limitations, so they may not apply to you. 
LICENSOR'S ENTIRE LIABILITY AND YOUR EXCLUSIVE REMEDY FOR SOFTWARE THAT DOES NOT 
MEET THIS LIMITED WARRANTY SHALL BE, AT LICENSOR'S CHOICE, EITHER TO (A) REFUND THE 
PRICE PAID OR (B) REPLACE THE SOFTWARE IF RETURNED TO LICENSOR WITH A COPY OF YOUR 
RECEIPT. Any replacement Software will be warranted for the remainder of the original warranty period or 30 
days, whichever is longer. This Limited Warranty is void if failure of the Software has resulted from 
modification, accident, abuse, or misapplication. IN NO EVENT WILL LICENSOR BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR OTHER INDIRECT, INCIDENTAL, 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE SOFTWARE. 
Because some states, countries, or regions do not allow the exclusion or limitation of liability for consequential 
or incidental damages, the above limitation may not apply to you. This EULA is governed by the laws of the 
State of Texas, and may be enforced by Mobility's licensors, including without limitation, Schema Software, 
Inc. If you have any questions concerning this EULA or wish to contact Licensor for any reason, please write: 
Mobility Texas, Inc. 5508 W. Plano Parkway, Suite E, Plano, TX  75220; email: support@quickoffice.com, 
www.quickoffice.com phone: 1 + 214-956-9806 (English only).

U.S. Government Restricted Rights. The Software and documentation are provided with Restricted Rights. 
Use, duplication, or disclosure by the Government is subject to restrictions set forth in subparagraph (c)(1) of 
The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs 
(c)(1)(ii) and (2) of Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. 
Supplier is Mobility Texas, Inc. 5508 W. Plano Parkway, Suite E, Plano, TX  75093; phone: 1 + 214-956-9806.
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END-USER SOFTWARE LICENSE AGREEMENT
By use of this Panasonic cellular phone, including any embedded software features or programs ("Embedded
Software"), you agree to the terms and conditions of this End-User Software License Agreement ("EULA").   
1. END-USER RIGHTS:  You are granted a limited end-user right to use the Embedded Software only as part of and
together with this Panasonic cellular phone.  You agree to use the Embedded Software in a manner that complies with
all applicable laws, including laws related to copyright and other intellectual property rights.   All other uses are
prohibited.
2. LIMITATIONS ON END-USER RIGHTS:
(a) You may not reproduce, copy, or transfer the Embedded Software to any other device;
(b) You may not create derivative works of any type based on the Embedded Software (unless and except as expressly
permitted as part of a feature application);
(c) You may not reverse engineer, reverse compile, disassemble, or otherwise attempt to discover the source code of
the Embedded Software;
(d) You may not transfer this Panasonic cellular phone other than to a transferee end-user who undertakes to observe
the same obligations as those set out in this EULA;
(e) You may not remove any proprietary notices, such as copyright, trademark, or otherwise, from the Embedded
Software.
3. INTELLECTUAL PROPERTY RIGHTS:  The Embedded Software is protected by copyright, trademark, patent and/or
other intellectual property rights and is owned by Panasonic Mobile Communications Co., Ltd. ("PMC") and/or is under
license from PMC's licensors.
4. TERMINATION:  Your right to use the Embedded Software may be terminated for failure to comply with any of the
terms of this EULA.
5. LIMITATION OF LIABILITY/DISCLAIMER OF WARRANTIES:  TO THE MAXIUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL PMC, ITS AFFILIATES, AND THEIR LICENSORS BE LIABLE FOR
INCIDENTAL, INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, ARISING OUT OF OR IN CONNECTION WITH THE USE
OR PERFORMANCE OF THE EMBEDDED SOFTWARE.  EXCEPT AS EXPRESSLY STATED IN THE RELEVANT
WARRANTY CARD, PMC, ITS AFFILIATES, AND THEIR LICENSORS DISCLAIM ALL WARRANTIES, EXPRESS
AND IMPLIED, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE REMEDIES PROVIDED TO THE END-USER IN THE RELEVANT
WARRANTY CARD ARE EXCLUSIVE.
6. ADDITIONAL THIRD PARTY TERMS:  The Embedded Software may contain third party software subject to separate
third party license terms and conditions set forth in the user manual or associated product documentation and/or
displayed on the LCD of this Panasonic cellular phone.  You acknowledge and agree that such third party software is
governed by the third party license terms, as applicable, and that such terms are solely between you and the applicable
licensor.
7. EXPORT REGULATIONS/RESTRICTED RIGHTS:  The Embedded Software is subject to U.S. export control laws,
including the U.S. Export Administration Act and its associated regulations, and may be subject to export or import
regulations in other countries.  You agree to comply strictly with all such regulations.  You confirm that with respect to
the Embedded Software, you will not export or re-export it, directly or indirectly, to any countries that are subject to U.S.
export restrictions.  Use, duplication or disclosure by the U.S. government is subject to the restrictions as set forth in the
Rights in Technical Data and Computer Software Clauses in DFARS 252.227-7013(c)(1)(ii) and FAR 52.227-19(c)(2) as
applicable.
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PANASONIC GSM MOBILE TELEPHONE

WARRANTY TERMS

1. This warranty is in addition to and does not in any way affect any statutory or other

rights of consumer purchasers. This warranty applies to the United Kingdom, Isle of

Man & Channel Islands only, for users in Eire, please contact your retailer or supplier.

The warranty period is 12 months from date of purchase and is applicable to the

original purchaser only.

2. The product is approved for use on GSM mobile telephone system and should only be

used for normal purposes and in accordance with the standard operating instructions.

3. The warranty covers breakdowns due to manufacturing or design faults; it does not

apply to damage, however caused, wear and tear, neglect, incorrect adjustment or

repair, or to any items of a limited natural life.

4. In the event of failure, please take the following action:

� Refer to the instruction book in order to identify and possibly correct the problem.

� If the problem is due to coverage, reception or billing, please contact your air time

retailer or service provider whose number can be found from your monthly invoice.

� If you cannot resolve the problem, contact the Panasonic Helpline on 08705 159159.

Before you telephone have the following information to hand:

� The model and serial number of your telephone, and its phone number

� Your full address and post code

� A copy of your original invoice, receipt or bill of sale for the purchase of the

telephone.

5. If the problem cannot be resolved over the telephone, arrangements will be made to

repair the telephone. Remove the SIM from the telephone and store it in a safe place.

Please pack the telephone suitable for transit. Including in the packing:

� The mobile telephone

� The rechargeable battery

� AC Adaptor

� A copy of your invoice, receipt or bill of sale. (Note; it is the customers responsibility

to provide proof of warranty)

6. Panasonic will use reasonable endeavours to ensure your telephone is returned to you

within a maximum of 5 working days from reporting the fault to the Helpline. Please

note that delays in transit may be encountered for Channel Islands, Northern Ireland,

Isle of Man, Scottish Islands and other islands.

7. Your sole and exclusive remedy under this guarantee against us is for the repair, or at

our option the replacement, of the product, or any defective part or parts. No other

remedy, including, but not limited to, incidental or consequential damage or loss of

whatsoever nature shall be available to the purchaser.

8. Rechargeable batteries have a limited natural life, in order to prolong their life they

should only be used and charged as shown in the instruction book. Replacement

batteries may be purchased either from your retailer or the Helpline number shown

overleaf.

G4MDS-050I
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EU/EEA – WIDE GUARANTEE IS APPLICABLE IN THE EU/EEA 
AND SWITZERLAND.
Panasonic GSM European Service Guarantee Conditions

Dear Customer,
Thank you for buying this Panasonic digital cellular telephone. The Panasonic GSM European Service 
Guarantee only applies while travelling in countries other than where the product was purchased. Your 
local guarantee is applicable in all other cases. If your Panasonic GSM telephone requires service while 
abroad, please contact the local service company shown on this document.
The Guarantee
The applicable period of the European wide guarantee for GSM is generally 12 months for the main body 
and 3 months for the rechargeable battery. With respect to a product used in a country other than a 
country of purchase, notwithstanding what is stated in the conditions below, the customer will benefit, in 
that country of use, from these guarantee periods of, respectively, 12 and 3 months, if these conditions 
are more favourable to him than the local guarantee conditions applicable in such country of use.
Conditions of Guarantee
When requesting guarantee service the purchaser should present the warranty card together with proof 
of purchase, to an authorised service centre.
The guarantee covers breakdowns due to manufacturing or design faults; it does not apply to other 
events such as accidental damage, however caused, wear and tear, negligence, adjustment, modification 
or repair not authorised by us.
Your sole and exclusive remedy under this guarantee against us is the repair, or at our option the 
replacement, of the product, or any defective part or parts. No other remedy, including, but not limited to, 
incidental or consequential damage or loss of whatsoever nature shall be available to the purchaser.
This is in addition to and does not in any way affect any statutory or other rights of consumer purchasers. 
This guarantee applies in countries shown on this document at the authorised service centres detailed for 
that country.
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EU WARRANTY

Service Centres in England
Tel. +44 8705 159159

Service Centres in Ireland
Tel. +353 1 2898333

EU/EEA – Wide Guarantee: Conditions applicable in any country other than the country of original 
purchase.
When the purchaser finds the appliance to be defective, he should promptly contact the proper sales 
company or national distributor in the EU/EEA country where this guarantee is claimed, as indicated 
in the “Product Service Guide” or the nearest authorised dealer together with this guarantee and proof 
of date of purchase. The purchaser will then be informed whether:
(i)    the sales company or national distributor will handle the repair service; or
(ii)   the sales company or national distributor will arrange for trans-shipment of the appliance to the 
EU/EEA country where the appliance was originally marketed; or 
(iii)  the purchaser may himself send the appliance to the sales company or national distributor in the 
EU/EEA country where the appliance was originally marketed.
If the appliance is a product model which is normally supplied by the sales company or national 
distributor in the country where it is used by the purchaser, then the appliance, together with this 
guarantee card and proof of date of purchase, should be returned at the purchaser’s risk and expense 
to such sales company or distributor, which will handle the repair service. In some countries, the 
affiliated sales company or national distributor will designate dealers or certain service centres to 
execute the repairs involved.
If the appliance is a product model which is not normally supplied in the country where used, or if the 
appliance’s internal or external product characteristics are different from those of the equivalent model 
in the country where used, the sales company or national distributor may be able to have the guarantee 
repair service executed by obtaining spare parts from the country where the appliance was originally 
marketed, or it may be necessary to have the guarantee repair service executed the sales company or 
national distributor in the country where the appliance was originally marketed.
In either case, the purchaser must furnish this guarantee card and proof of date of purchase. Any 
necessary transportation, both of the appliance and of any spare parts, will be at the purchaser’s risk 
and expense, and there may be a consequent delay in the repair service.
Where the consumer sends the appliance for repair to the sales company or national distributor in the 
country of use of the appliance, the service will be provided on the same local terms and conditions 
(including the period of guarantee coverage) as prevail for the same model appliance in the country of 
use, and not the country of initial sale in the EU/EEA. Where the consumer sends the appliance for 
repair to the sales company or national distributor in the EU/EEA country where the appliance was 
originally marketed, the repair service will be provided on the local terms and conditions prevailing in 
the country of initial sale in the EU/EEA.
Some product models require adjustment or adaptation for proper performance and safe use in 
different EU/EEA countries, in accordance with local voltage requirements and safety or other technical 
standards imposed or recommended by applicable regulations. For certain product models, the cost 
of such adjustment or adaptation may be substantial and it may be difficult to satisfy local voltage 
requirements and safety or other technical standards. It is strongly recommended that the purchaser 
investigates these local technical and safety factors before using the appliance in another EU/EEA 
country.

United Kingdom

Ireland
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This guarantee shall not cover the cost of any adjustments or adaptations to meet local voltage 
requirements and safety or other technical standards. The sales company or national distributor may 
be in a position to make the necessary adjustments or adaptations to certain product models at the 
cost of the purchaser. However, for technical reasons it is not possible to adjust or adapt all product 
models to comply with local voltage requirements and safety or other technical standards. Moreover, 
where adaptations or adjustments are carried out the performance of the appliance may be affected.
If in the opinion of the sales company or national distributor in the country where the appliance is used 
the purchaser has the necessary adjustments or adaptations to local voltage requirements and 
technical or safety standards properly made, any subsequent guarantee repair service will be provided 
as above indicated, provided the purchaser discloses the nature of the adjustment or adaptation if 
relevant to the repair. (It is recommended that the purchaser should not send adapted or adjusted 
equipment for repair to the sales company or national distributor in the country where the appliance 
was originally marketed if the repair relates in any way to the adaptation or adjustment.)
This guarantee shall only be valid in territories subject to the laws of the European Union and the EEA.
Please keep this guarantee with your receipt.

The declaration of conformity for product EB-X701 was not 
available at the time of printing this manual. It may be 

obtained from the Panasonic website at 
http://www.panasonicmobile.co.uk/panasonicmobile/doc.html
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